**Typographic Conventions**

<table>
<thead>
<tr>
<th>Type Style</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><em>Example Text</em></td>
<td>Words or characters quoted from the screen. These include field names, screen titles, pushbuttons labels, menu names, menu paths, and menu options. Cross-references to other documentation</td>
</tr>
<tr>
<td><em>Example text</em></td>
<td>Emphasized words or phrases in body text, graphic titles, and table titles</td>
</tr>
<tr>
<td><em>EXAMPLE TEXT</em></td>
<td>Technical names of system objects. These include report names, program names, transaction codes, table names, and key concepts of a programming language when they are surrounded by body text, for example, SELECT and INCLUDE.</td>
</tr>
<tr>
<td>Example text</td>
<td>Output on the screen. This includes file and directory names and their paths, messages, names of variables and parameters, source text, and names of installation, upgrade and database tools.</td>
</tr>
<tr>
<td>Example text</td>
<td>Exact user entry. These are words or characters that you enter in the system exactly as they appear in the documentation.</td>
</tr>
<tr>
<td><code>&lt;Example text&gt;</code></td>
<td>Variable user entry. Angle brackets indicate that you replace these words and characters with appropriate entries to make entries in the system.</td>
</tr>
</tbody>
</table>

**Icons**

<table>
<thead>
<tr>
<th>Icon</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="caution.png" alt="Caution" /></td>
<td>Caution</td>
</tr>
<tr>
<td><img src="example.png" alt="Example" /></td>
<td>Example</td>
</tr>
<tr>
<td><img src="note.png" alt="Note" /></td>
<td>Note</td>
</tr>
<tr>
<td><img src="recommendation.png" alt="Recommendation" /></td>
<td>Recommendation</td>
</tr>
<tr>
<td><img src="syntax.png" alt="Syntax" /></td>
<td>Syntax</td>
</tr>
</tbody>
</table>

Additional icons are used in SAP Library documentation to help you identify different types of information at a glance. For more information, see *Help on Help → General Information Classes and Information Classes for Business Information Warehouse* on the first page of any version of SAP Library.
Contents

Upgrade to SAP BW 3.5: Windows ..................................................8
  1 Introduction .......................................................................................10
    1.1 Naming Conventions for the SAP BW Upgrade................................. 11
    1.2 How to Use this Documentation ......................................................... 13
    1.3 New Features in the SAP BW Upgrade............................................... 15
  2 Upgrade - Step by Step.....................................................................19
  3 SAP Notes for the SAP BW Upgrade...............................................30
  4 Product-Specific Information for the SAP BW Upgrade ...............36
    4.1 SAP BW: Upgrade Planning............................................................37
    4.1.1 Upgrade Strategy Planning..........................................................37
    4.1.2 Database Backup ........................................................................38
    4.1.3 Upgrade Schedule Planning ..........................................................38
    4.1.4 Runtime for the Import of the Substitution Set .........................39
    4.1.5 Checking the Hardware Requirements........................................39
    4.1.6 Checking the Source Release of the SAP System .......................40
    4.1.7 Upgrade of the Operating System and Database System: Overview 41
    4.2 SAP BW: Upgrade Preparations ......................................................... 46
    4.2.1 Making the Consistency Check for Web Templates..........................46
    4.2.2 Converting Data Classes of InfoCubes...........................................46
    4.2.3 Checking Inconsistent InfoObjects ................................................47
    4.2.4 ALPHA Converter ........................................................................48
    4.2.5 Creating the Upgrade Directory .....................................................49
    4.2.6 Making Entries for the Parameter Input Module.............................49
    4.2.7 Making Entries for the Extension Module .......................................51
    4.2.8 Making Entries for the Installation Module ....................................52
    4.2.9 Converting Inconsistent Characteristic Values with a Conversion Routine 53
    4.3 SAP BW: The Upgrade ................................................................. 54
    4.3.1 Phase LOCKEU_PRE .................................................................54
    4.3.2 EU_IMPORT Phases .....................................................................54
    4.3.3 Phase REPACHK2 ........................................................................55
    4.4 SAP BW: Post-Upgrade Activities ................................................... 56
    4.4.1 Activating the Internet Communication Manager (ICM).....................56
    4.4.2 Converting the Web Objects from SAP BW 2.x to 3.x ...................57
    4.4.3 Converting Chart Settings ............................................................61
    4.4.4 Switching Over to New Standard Template for Ad-Hoc Analysis .......63
    4.4.5 MS SQL Server: Specific Actions ................................................63
    4.4.6 Installing the J2EE Engine ............................................................63
    4.4.7 Performing Post-Upgrade Activities for the Applications .........64
    4.4.8 Importing Support Packages After the Upgrade .........................64
    4.4.9 SAP Retail: Converting Terminology ............................................64
  5 General Upgrade Information .......................................................65
    5.1 Upgrade Planning............................................................................66
    5.1.1 Time Frame for Upgrading the Front-End Software .......................68
    5.1.2 System Switch Upgrade .............................................................68
    5.1.3 Upgrade Strategy Planning ..........................................................71
5.1.4 Database Backup ........................................................................................................ 74
5.1.5 Database-Specific Aspects ........................................................................................ 75
5.1.6 Upgrades in an MCOD System Landscape .............................................................. 78
5.1.7 Data Management Planning .................................................................................... 79
5.1.8 Incremental Table Conversion .............................................................................. 80
5.1.9 Upgrade Schedule Planning .................................................................................... 82
5.1.10 Runtime for the Import of the Substitution Set ...................................................... 85
5.1.11 Upgrade in an SAP System Group ....................................................................... 85
5.1.12 Modification Adjustment Planning ...................................................................... 86
5.1.13 Checking the Structural Requirements ............................................................... 88
5.1.14 Checking the Hardware Requirements .............................................................. 89
5.1.15 Checking the Software Requirements ................................................................... 89
Checking the Source Release of the SAP System .......................................................... 89
Meeting the Requirements for the Upgrade Assistant ...................................................... 90
Upgrade of the Operating System and Database System: Overview ................................ 90
5.1.16 Accessing Documentation Before and During the Upgrade ................................. 91
5.1.17 Meeting the Requirements for the SAP Internet Solution ..................................... 91
5.1.18 Importing Additional Languages ........................................................................... 93
5.1.19 Making Entries for the MSCS Configuration ...................................................... 125
5.1.20 Making Entries for the Installation Module ......................................................... 124
5.1.21 Making Entries for the Extension Module ............................................................ 115
5.1.22 Making Entries for the Import Module ................................................................... 114
5.1.23 Making the First Entries for PREPARE ............................................................... 106
5.1.24 Importing Software After Starting PREPARE ..................................................... 106
5.1.25 Making the First Entries for PREPARE ............................................................... 106
5.1.26 Starting PREPARE for the First Time .................................................................. 102
5.1.27 Starting the Upgrade Assistant Server .................................................................. 103
5.1.28 Starting the Upgrade Assistant GUI ..................................................................... 103
5.1.29 Starting the Upgrade Assistant ............................................................................ 104
5.1.30 Restarting PREPARE ........................................................................................... 105
5.1.31 Importing Software After Starting PREPARE ..................................................... 106
5.1.32 Making the First Entries for PREPARE ............................................................... 106
5.1.33 Importing Software After Starting PREPARE ..................................................... 106
5.1.34 Making the First Entries for PREPARE ............................................................... 106
5.1.35 Making the First Entries for PREPARE ............................................................... 106
5.1.36 Making the First Entries for PREPARE ............................................................... 106
5.1.37 Making the First Entries for PREPARE ............................................................... 106
5.1.38 Making the First Entries for PREPARE ............................................................... 106
5.1.39 Making the First Entries for PREPARE ............................................................... 106
5.1.40 Making the First Entries for PREPARE ............................................................... 106
5.1.41 Making the First Entries for PREPARE ............................................................... 106
5.1.42 Making the First Entries for PREPARE ............................................................... 106
5.1.43 Making the First Entries for PREPARE ............................................................... 106
5.1.44 Making the First Entries for PREPARE ............................................................... 106
5.1.45 Making the First Entries for PREPARE ............................................................... 106
5.1.46 Making the First Entries for PREPARE ............................................................... 106
5.1.47 Making the First Entries for PREPARE ............................................................... 106
5.1.48 Making the First Entries for PREPARE ............................................................... 106
5.1.49 Making the First Entries for PREPARE ............................................................... 106
5.1.50 Making the First Entries for PREPARE ............................................................... 106
5.1.51 Making the First Entries for PREPARE ............................................................... 106
5.1.52 Making the First Entries for PREPARE ............................................................... 106
5.1.53 Making the First Entries for PREPARE ............................................................... 106
5.1.54 Making the First Entries for PREPARE ............................................................... 106
5.1.55 Making the First Entries for PREPARE ............................................................... 106
5.1.56 Making the First Entries for PREPARE ............................................................... 106
5.1.57 Making the First Entries for PREPARE ............................................................... 106
5.1.58 Making the First Entries for PREPARE ............................................................... 106
5.1.59 Making the First Entries for PREPARE ............................................................... 106
5.1.60 Making the First Entries for PREPARE ............................................................... 106
5.1.61 Making the First Entries for PREPARE ............................................................... 106
5.1.62 Making the First Entries for PREPARE ............................................................... 106
5.1.63 Making the First Entries for PREPARE ............................................................... 106
5.1.64 Making the First Entries for PREPARE ............................................................... 106
5.1.65 Making the First Entries for PREPARE ............................................................... 106
5.1.66 Making the First Entries for PREPARE ............................................................... 106
5.1.67 Making the First Entries for PREPARE ............................................................... 106
5.1.68 Making the First Entries for PREPARE ............................................................... 106
5.1.69 Making the First Entries for PREPARE ............................................................... 106
5.1.70 Making the First Entries for PREPARE ............................................................... 106
5.1.71 Making the First Entries for PREPARE ............................................................... 106
5.1.72 Making the First Entries for PREPARE ............................................................... 106
5.1.73 Making the First Entries for PREPARE ............................................................... 106
5.1.74 Making the First Entries for PREPARE ............................................................... 106
5.1.75 Making the First Entries for PREPARE ............................................................... 106
5.1.76 Making the First Entries for PREPARE ............................................................... 106
5.1.77 Making the First Entries for PREPARE ............................................................... 106
5.1.78 Making the First Entries for PREPARE ............................................................... 106
5.1.79 Making the First Entries for PREPARE ............................................................... 106
5.1.80 Making the First Entries for PREPARE ............................................................... 106
5.1.81 Making the First Entries for PREPARE ............................................................... 106
5.1.82 Making the First Entries for PREPARE ............................................................... 106
5.1.83 Making the First Entries for PREPARE ............................................................... 106
5.1.84 Making the First Entries for PREPARE ............................................................... 106
5.1.85 Making the First Entries for PREPARE ............................................................... 106
5.1.86 Making the First Entries for PREPARE ............................................................... 106
5.1.87 Making the First Entries for PREPARE ............................................................... 106
5.1.88 Making the First Entries for PREPARE ............................................................... 106
5.1.89 Making the First Entries for PREPARE ............................................................... 106
5.1.90 Making the First Entries for PREPARE ............................................................... 106
5.1.91 Making the First Entries for PREPARE ............................................................... 106
5.1.92 Making the First Entries for PREPARE ............................................................... 106
5.1.93 Making the First Entries for PREPARE ............................................................... 106
5.1.94 Making the First Entries for PREPARE ............................................................... 106
5.1.95 Making the First Entries for PREPARE ............................................................... 106
5.1.96 Making the First Entries for PREPARE ............................................................... 106
5.1.97 Making the First Entries for PREPARE ............................................................... 106
5.1.98 Making the First Entries for PREPARE ............................................................... 106
5.1.99 Making the First Entries for PREPARE ............................................................... 106
5.2 Upgrade Preparations ............................................................................................... 94
5.2.1 Determining the Host for the Upgrade Preparations .............................................. 96
5.2.2 Creating the Upgrade Directory ............................................................................ 96
5.2.3 Checking the Database-Specific Requirements for PREPARE ......................... 97
5.2.4 Importing the Latest SPAM Update (Source Release 4.x and Higher) ................. 100
5.2.5 Windows NT 4.0: Checking the Consistency of the Host Name ....................... 100
5.2.6 Starting PREPARE for the First Time ................................................................ 102
5.2.7 Starting the Upgrade Assistant Server ................................................................ 103
5.2.8 Starting the Upgrade Assistant GUI .................................................................. 103
5.2.9 Starting the Upgrade Assistant ........................................................................... 104
5.2.10 Restarting PREPARE ......................................................................................... 105
5.2.11 Resetting PREPARE ......................................................................................... 105
5.2.12 Importing Software After Starting PREPARE .................................................... 106
5.2.13 Making the First Entries for PREPARE ............................................................. 106
5.2.14 Making Entries for the Parameter Input Module .............................................. 107
5.2.15 Making Entries for the Initialization Module .................................................... 112
5.2.16 Making Entries for the Import Module ................................................................ 114
5.2.17 Making Entries for the Extension Module ....................................................... 115
5.2.18 Making Entries for the Installation Module ....................................................... 124
5.2.19 Making Entries for the MSCS Configuration ................................................... 125
5.2.20 Evaluating the Results of PREPARE .............................................................. 126
5.2.21 Making Preparations at the Operating System Level ....................................... 130
5.2.22 Making Preparations at the Database Level ..................................................... 131
5.2.23 Making Preparations at the SAP System Level ............................................... 134
Deleting the AUTOSTART Parameter ........................................................................... 134
Checking the User for the Upgrade .............................................................................. 134
Checking the Requirements for the Modification Adjustment .................................... 135
Setting the Operation Mode for the Upgrade .............................................................. 135
Processing Batch Input Sessions (Source Release 3.1I) .............................................. 136
Converting the Translation Proposal Pool (Source Release 3.1I) ............................ 136
Processing Direct Input Error Data (Source Release 3.1I) ...................................... 137
5.3 The Upgrade ........................................................................................................ 138
5.3.1 Upgrading with Microsoft Cluster Server ......................................................... 140
5.3.2 Starting the Upgrade ......................................................................................... 140
5.3.3 Stopping the Upgrade ....................................................................................... 141
5.3.4 Restarting the Upgrade ..................................................................................... 141
5.3.5 Monitoring the Upgrade .......................................................................................... 143
Upgrade Logs .................................................................................................................. 143
Alert Function .................................................................................................................. 145
5.3.6 Phase INITPUT........................................................................................................ 146
5.3.7 Phase PATCH_CHK ............................................................................................... 146
5.3.8 Phase KEY_CHK .................................................................................................... 147
5.3.9 Phase INITSUBST ................................................................................................. 147
5.3.10 Phase CONFCHK_X ............................................................................................ 149
5.3.11 Phase VIEWCHK1 ............................................................................................... 150
5.3.12 Phase REPACHK1 .............................................................................................. 150
5.3.13 Phase JOB_RSVBCHCK2 .................................................................................. 150
5.3.14 Phase FREECHK_X ............................................................................................ 151
5.3.15 Phase LOCKEU_PRE .......................................................................................... 151
5.3.16 EU_IMPORT Phases ............................................................................................. 152
5.3.17 Phase REPACHK2 .............................................................................................. 153
5.3.18 Phase CNV_CHK_X ............................................................................................. 153
5.3.19 Phase ADJUSTCHK ............................................................................................ 154
5.3.20 Phase ACT_<Rel> .............................................................................................. 154
5.3.21 Phase VIEWCHK2 .............................................................................................. 156
5.3.22 Phase MODPROF_TRANS.................................................................................. 156
5.3.23 Phases JOB_RSVBCHCK_R and JOB_RSVBCHCK_D ........................................... 157
5.3.24 Continuation of the Upgrade After the MODPROF_UPG Phase ....................... 158
5.3.25 Phase CHK_POSTUP .......................................................................................... 158

5.4 Post-Upgrade Activities ............................................................................................ 159
5.4.1 DB2 UDB for UNIX and Windows: Performing Specific Actions ....................... 161
5.4.2 DB2 UDB for z/OS: Performing Specific Actions ................................................ 163
5.4.3 Informix: Performing Specific Actions .................................................................. 165
5.4.4 MaxDB: Backing Up the Database ........................................................................ 166
5.4.5 MS SQL Server: Performing Specific Actions ....................................................... 167
5.4.6 Oracle: Performing Specific Actions ...................................................................... 167
5.4.7 Post-Upgrade Activities for the Microsoft Cluster Server ................................... 169
5.4.8 Upgrading the Application Servers ....................................................................... 169
5.4.9 Performing Post-Upgrade Activities for the SAP Kernel ..................................... 171
5.4.10 Renaming the Local System Log (Source Release 3.1I) ....................................... 171
5.4.11 Checking the Profile Parameters with Transaction RZ10 .................................... 172
5.4.12 Installing the J2EE Engine .................................................................................. 172
5.4.13 Reimporting Additional Programs ....................................................................... 174
5.4.14 Adjusting Repository Objects .............................................................................. 174
5.4.15 Performing Post-Upgrade Activities for the Applications .................................. 175
5.4.16 Secure Single Sign-On with Microsoft NT LAN Manager SSP ........................... 176
5.4.17 Adjusting Start and Stop Procedures (Source Release Lower than 4.6A) ............ 181
5.4.18 Rescheduling Background Jobs ............................................................................ 181
5.4.19 Rescheduling DB13 Jobs (Source Release 3.1I) .................................................. 182
5.4.20 Migrating Matchcodes in Search Help Objects (Source Release 3.1I) ................. 182
5.4.21 Informix: Updating Statistics .............................................................................. 183
5.4.22 Oracle: Performing Actions for the Cost-Based Optimizer .................................. 183
5.4.23 MaxDB: Updating Optimizer Statistics ............................................................... 185
5.4.24 Generating ABAP Loads .................................................................................... 185
5.4.25 Generating BSP Applications .............................................................................. 186
5.4.26 Performing Actions for the SAP Online Documentation ...................................... 187
5.4.27 Performing Post-Upgrade Activities in the Authorizations Area ....................... 187
5.4.28 Processing Table Clusters After the Upgrade (Source Release 3.1I) ..................... 188
5.4.29 Installing More Dialog Instances ....................................................................... 189
5.4.30 Importing Support Packages After the Upgrade ................................................ 190
5.4.31 Transport Management System: Distributing the Configuration ....................... 190
5.4.32 Performing Post-Upgrade Activities for the Language Transport ..................... 191
Upgrade to SAP BW 3.5: Windows

5.4.33 Oracle: Deleting Tablespaces................................................................. 191
5.4.34 Converting Batch Input Logs ................................................................. 192
5.4.35 Saving Files for Follow-Up Upgrades .................................................. 193
5.4.36 Evaluating the Upgrade Runtime.......................................................... 193

6 Additional Information.................................................................................. 195

6.1 Troubleshooting......................................................................................... 196
6.1.1 Evaluating the ELG Log Files ................................................................. 197
6.1.2 Correcting Errors in the RFCCHK Phase .............................................. 198
6.1.3 Correcting Entries Made in the INITPUT and INITSUBST Phases .......... 199
6.1.4 Correcting Errors in the DBCHK Phase................................................ 200
6.1.5 Correcting Errors in the BATCHCHK Phase......................................... 201
6.1.6 Correcting Errors in the INTPCH and INTPCH_SW Phases............... 202
6.1.7 Correcting Errors in the SPACECHK_ALL Phase............................... 202
6.1.8 Correcting Errors in the JOB Phases.................................................... 203
6.1.9 Cleaning Up Terminated Conversions in the DB Conversion Phases .... 203
6.1.10 Correcting Errors in the TRBATCHK_XT Phase................................... 206
6.1.11 Correcting Errors in the ACT Phase.................................................... 206
6.1.12 Correcting Conversion Errors in the PARCONV Phase....................... 207
6.1.13 Correcting Errors in the XPRAS Phase................................................. 208
6.1.14 Preparing the Restart of the Upgrade After a System Failure................. 210
6.1.15 Resetting the Upgrade.......................................................................... 210
6.1.16 Correcting Problems when Processing ABAP Steps......................... 213
6.1.17 Correcting Problems when Starting the SAP System......................... 214
6.1.18 Correcting Problems when Copying SAP Programs........................... 215
6.1.19 Providing SAP Support with Information............................................ 215

6.2 Upgrade Administration ............................................................................. 217
6.2.1 Determining Versions.............................................................................. 217
6.2.2 Setting the Environment of the SAP Kernel.......................................... 218
6.2.3 Creating Shares and Directories and Checking Authorizations............. 219
6.2.4 Changing the Virtual Memory/Paging File Size..................................... 219
6.2.5 Isolating the Central Instance............................................................... 220
6.2.6 Extending Free Space in the Database.................................................. 221
6.2.7 Changing the Database Recovery Mode............................................... 224
6.2.8 Using a Different Upgrade Directory.................................................... 226
6.2.9 Releasing and Confirming Open Repairs and Requests....................... 226
6.2.10 Sending a Message when User Action Is Required.............................. 228
6.2.11 Using the Phase List for the Upgrade.................................................. 228

6.3 Upgrade Tools .......................................................................................... 230
6.3.1 PREPARE............................................................................................. 230
6.3.2 R3up..................................................................................................... 232
6.3.3 Upgrade Assistant.................................................................................. 233
   Using the Upgrade Assistant................................................................. 235
6.3.4 Upgrade Monitor................................................................................... 236
   Starting the Upgrade Monitor ............................................................... 237
   Understanding the Upgrade Monitor Display....................................... 237
Upgrade to SAP BW 3.5: Windows

Purpose
This documentation describes the upgrade to SAP Business Information Warehouse (SAP BW) Release 3.5 (based on SAP Web Application Server 6.40). It also contains additional useful information about the upgrade. The information in this documentation is intended for SAP system administrators with operating system, database, and SAP Web Application Server knowledge.

The Upgrade – Step by Step [page 19] section is a list of all actions that you must perform to upgrade your system successfully. The actions are placed in chronological order, so that you can work through them just like a checklist.

The following two parts of this documentation explain the upgrade procedure in detail:

- Product-Specific Information for the SAP BW Upgrade [page 36]
- General Upgrade Information [page 65]

The last part of this documentation, Additional Information [page 195], gives you information on troubleshooting, the administration tasks you need to perform before and after the upgrade, and the tools that you use to upgrade the system.

Integration
If you want to upgrade the component SAP BW to SAP BW 3.5 in the context of the upgrade of a mySAP Business Suite solution or one of its business scenarios, it is essential that you familiarize yourself with the contents of the corresponding Upgrade Master Guide before starting to upgrade.

The Upgrade Master Guide is the central document for the upgrade of mySAP Business Suite solutions a business scenarios. It lists the components and third-party applications required by each business scenario of a mySAP Business Suite solution, and refers to the required installation and upgrade guides. It also defines the upgrade sequence of the business scenarios of the corresponding mySAP Business Suite solution.

To find the latest version of this documentation and the Upgrade Master Guide, see SAP Service Marketplace at the Internet address service.sap.com/instguides.

In addition to this documentation, you also require other information, such as the Release Notes for the applications that you implement, the SAP Implementation Guide (IMG), the SAP Notes that are specific to this upgrade [page 30], and any other documentation referred to in this documentation.

Constraints
This documentation only applies if you are upgrading your SAP system on Windows.

If an SAP SEM add-on is or has ever been installed on your SAP BW system, you can only upgrade your SAP BW system if you upgrade the SAP SEM add-on at the same time. For details about the availability of SAP SEM 4.0,
see the SAP Service Marketplace at service.sap.com/sem → 
1 Introduction

This section of the documentation contains general information on

- Naming conventions [page 11]
  This section explains the terminology and abbreviations used in this documentation.

- How to use this documentation [page 13]
  In SAP Web Application Server 6.10 the structure of the upgrade documentation has been changed from a process flow description with additional information to an information pool.

- New features in the SAP BW upgrade [page 15]
  The upgrade procedure is continually being enhanced. This section contains the most important changes to the procedure, for both current and previous releases.
1 Introduction

1.1 Naming Conventions for the SAP BW Upgrade

Usage of Release Names
In the product-specific part of this documentation, the releases of SAP BW are used for the release descriptions. The general section of this documentation uses the Basis Release or the release of the SAP Web Application Server (SAP Web AS). See the following table for the interdependencies between releases.

<table>
<thead>
<tr>
<th>Basis/SAP Web Application Server</th>
<th>SAP BW</th>
</tr>
</thead>
<tbody>
<tr>
<td>4.6C</td>
<td>2.0B</td>
</tr>
<tr>
<td>4.6D</td>
<td>2.1C</td>
</tr>
<tr>
<td>6.10</td>
<td>3.0A</td>
</tr>
<tr>
<td>6.20</td>
<td>3.0B</td>
</tr>
<tr>
<td>6.20</td>
<td>3.1 Content</td>
</tr>
<tr>
<td>6.40</td>
<td>3.5</td>
</tr>
</tbody>
</table>

For information about which BW Release is based on which SAP Web Application Server, see also SAP Note 309461.

SAP Business Information Warehouse
In this guide, SAP Business Information Warehouse has been abbreviated to SAP BW.

SAP BW System and SAP System
In this documentation, the term SAP system is the same as BW system. SAP is also used as a synonym for BW in terms such as SAP start profile or SAP system language.

SAP System ID
In this documentation the SAP system ID is abbreviated as SAPSID or sapsid. If <sapsid> is used, your SAP system ID must be in lowercase letters, for example “prd”. If <SAPSID> is used, you must write in uppercase letters, for example “PRD”.

Always enter the user name <sapsid>adm in lowercase for the standalone database server.

SAP Basis and SAP Web Application Server
Release 6.10 renames the SAP Basis Component as the SAP Web Application Server. In this documentation, the term SAP Basis (or the abbreviation Basis) is used when referring to Release 4.6D and lower, and the term SAP Web Application Server (or the abbreviation SAP Web AS) when referring to Release 6.10 and higher.

ID for the SAP Web Application Server Release
In this documentation, <rel> stands for the relevant SAP Web Application Server release, without a decimal point, such as 640.
IBM DB2 Universal Database for UNIX and Windows and Short Forms

In this documentation and in the upgrade dialogs, the short form *DB2 UDB for UNIX and Windows* is used for the database *IBM DB2 Universal Database for UNIX and Windows*, and, in certain cases, the SAP ID *DB6* is used as well. In previous versions of this documentation, *IBM DB2 Universal Database for UNIX and Windows* was referred to as DB2 Universal Database for UNIX, Windows.

IBM DB2 Universal Database for z/OS and Short Forms

In this documentation and in the upgrade dialogs, the short form *DB2 UDB for z/OS* is used for the database *IBM DB2 Universal Database for z/OS*, and in certain cases, the SAP ID *DB2* is used as well. In previous versions of this documentation, *IBM DB2 Universal Database for z/OS* was referred to as *IBM DB2 Universal Database for OS/390 or IBM DB2 Universal Database for OS/390 and z/OS*.

SAP DB and MaxDB by MySQL

As of version 7.5, the SAP DB database will be renamed to *MaxDB by MySQL*. In this documentation, the short form MaxDB is used for the database. For more information, see [www.mysql.com](http://www.mysql.com) → *MaxDB by MySQL*. 
1.2 How to Use this Documentation

The documentation on upgrading the SAP system contains a large amount of information. Its aim is to give you both the information you need immediately at your fingertips, as well as providing additional background information when required. Treat the documentation as a pool of information.

If you have a lot of experience in upgrading the SAP system, you will probably only need the parts Upgrade - Step by Step [page 19], Product-Specific Information [page 36] and SAP Notes [page 30].

Structure of the Documentation

The documentation consists of the following parts:

- **Introduction**

  The first sections of this documentation are as follows:
  - New Features in the SAP BW Upgrade [page 15]
  - Naming Conventions for the SAP BW Upgrade [page 11]

  They contain information on new features in the upgrade for the last few releases, and on the naming conventions used in the documentation.

- **Upgrade – Step by Step [page 19]**

  This section is the core of the documentation. It is a list of all actions that you must perform to upgrade your system successfully. The short descriptions of the individual actions contain the following:
  - Important information, such as user entries
1 Introduction

- Links to a detailed description of the action
- Links to any product-specific information about the action

The upgrade actions are listed chronologically. Use the Upgrade – Step by Step section as a checklist for upgrading the system. This ensures that you do not miss important information.
Use the links to the general descriptions of the actions and to any additional product-specific information to help you perform the actions.

- SAP Notes for the SAP BW Upgrade [page 30]
  This section contains a list of SAP Notes relevant for the upgrade.

- Product-Specific Information for the SAP BW Upgrade [page 36]
  This part of the documentation contains additional information or restrictions on the descriptions in General Upgrade Information, which only affect this specific SAP product.
  The headings of the sections are the same as the corresponding sections in General Upgrade Information. Each product-specific text contains a link to the general description of the action.

  The information in the product-specific part takes priority over the information in the general part of the documentation.

- General Upgrade Information [page 65]
  This part of the documentation is a general description of the upgrade of an SAP system. It contains procedures and background information about the upgrade process flow and the individual actions. However, it does not contain all the information you need for the upgrade of your specific SAP product. For information on any extra details about the upgrade of your product see the Product-Specific Information [page 36].

- Additional Information [page 195]
  This part of the documentation contains three sections:
  - Troubleshooting [page 196]
  - Upgrade Administration [page 217]
  - Upgrade Tools [page 230]

  These sections contain information on troubleshooting, the administration tasks you need to perform for the upgrade, and the tools that you use to upgrade the system.

  Use the links from section Upgrade – Step by Step [page 19] to the general descriptions of the actions and to any additional product-specific information to help you perform the actions.
1.3 New Features in the SAP BW Upgrade

New Features in the Upgrade to Release 3.5 (Based on SAP Web Application Server 6.40)

- Delivery on DVD

As of SAP NetWeaver ´04, the data and tools needed for the upgrade are delivered partly on CD and partly on DVD, which reduces the size of the package. One DVD comprises several of the former CDs. The DVD subdirectories correspond to the former CDs. Instead of asking for directories, R3up, however, still asks you to mount CDs. Therefore, Making Entries for the Parameter Input Module [page 49] now includes a table that maps the former CDs to the new DVD directories.

New Features in the Upgrade to Release 3.1 Content (Based on SAP Web Application Server 6.20)

- Oracle: Early creation of secondary indexes

With strategy *downtime-minimized*, some of the secondary indexes will already be created during uptime. This applies to secondary indexes that are new in the target release and whose fields already exist in the source release. The background job that creates the indexes will not lock the tables concerned.

- Phase list for the upgrade in HTML format

The phase list [page 228] is no longer part of the upgrade documentation. Instead, it is contained in the *htdoc* subdirectory of the upgrade directory in the form of HTML files. You can also create the phase list yourself by using the *htmlphl* option to call R3up.

New Features in Release 3.0B (Based on SAP Web Application Server 6.20)

- New procedure for dealing with add-ons

In the IS_SELECT phase, you can also include SAINT packages in the upgrade that you put in the transport directory before the upgrade.

- Calculating an add-on queue

If you made a decision for all add-ons in the IS_SELECT phase, a new queue calculation is triggered. This calculation checks whether the import prerequisites can be met for the add-ons, and determines the sequence in which the corresponding requests are imported.

- New functions for including Support Packages

To import Support Packages in the BIND PATCH phase, the following Support Package levels are determined and taken into consideration for each component:

  a. Minimum required Support Package level

     Support Package level that the included add-ons of the target release require as an import prerequisite. The add-on queue calculation determines the minimum required Support Package level.

     You are not allowed to select a Support Package level that is lower than the minimum level.
Introduction

b. Equivalence Support Package level

You can define attributes for the Support Packages of the source release that determine which Support Package in a higher release corresponds to the one in the source release. This Support Package must be included so that no data is lost in the upgrade. PREPARE determines this equivalence Support Package level in the PATCHK_EQUI phase.

The minimum and the equivalence Support Package level for each component are displayed on the dialog box (wizard).

- Including a SPAM update
  
  In the BIND_PATCH phase you can include a SPAM update for the target release.

- Conflict check
  
  To check whether the add-on requests and CRTs are complete, PREPARE triggers a conflict check. You are then prompted to include the corresponding CRTs for the included add-ons, if necessary.

- Modifications
  
  The procedure for copying modifications to the standard SAP system has changed. Modified objects, that belong to software components whose release does not change during the upgrade are copied automatically and therefore do not need to be adjusted again. Modified objects, that belong to software components that are being upgraded, are no longer copied automatically. Instead, all of these modifications are offered for adjustment, including modifications to objects that are deleted by the upgrade and that are not shipped by SAP in a more up-to-date version.

  This new procedure may cause more objects to be offered in the modification adjustment than was previously the case. Customer objects are not affected by this change and are retained as usual.

New Features in Release 3.0A (Based on SAP Web Application Server 6.10)

- Changed structure of the upgrade documentation
  
  To make it easier to access important information, the structure of the upgrade documentation has been changed in many places. Instead of describing the process flow of the upgrade, the documentation is now structured as an information pool. The description of the upgrade procedure as been split into two areas, a product-specific section and a general description. The section Upgrade – Step by Step [page 19] is your central guide and summary of the upgrade.

  ! The information in the product-specific part takes priority over the information in the general part of the documentation.

  For more information, see How to Use this Documentation [page 13].

- New upgrade procedure
  
  The new System Switch Upgrade installs an instance of the target release, the shadow system, in parallel with the current source release system in the same database. This parallel system contains all the software of the target release and is used to integrate Support Packages that are included in the upgrade, add-ons, and customer modifications into the target release.
In the production database, the tables of the target release that contain both the descriptions of the ABAP Dictionary and the ABAP programs are imported as shadow tables under an alternative name. The shadow system enables you to access these tables. Depending on the upgrade strategy you choose, you can perform upgrade actions before downtime starts that previously had to be performed during downtime.

You can choose between two upgrade strategies in the System Switch Upgrade. The **downtime-minimized** strategy enables you to run the production system and shadow system in parallel. This requires extra system resources, but reduces downtime. The **resource-minimized** strategy only enables you to run either the production system or the shadow system. This strategy requires no extra system resources, however the downtime is longer, since you can only run the shadow instance during downtime.

In the new procedure, the archiving strategy for the database is no longer coupled with the upgrade strategy. However, you should use the recommended archiving strategies except in certain cases.

- **Load generation transaction SGEN completely revised**
  
  Transaction SGEN is used to generate ABAP loads for programs, function groups, classes, or Business Server Pages applications (BSP applications). You can select clearly defined generation tasks. The progress display enables you to monitor the generation and see its forecast duration. The new parallel procedure used by the new transaction shortens the duration of the generation significantly.

  For a detailed description of the transaction, use the information button on its screens.

**Important Changes Before Release 3.0 (Before SAP Web Application Server 6.10)**

- **New procedure for including Support Packages in the upgrade**
  
  You no longer have to use the report RSSPDASS to confirm the Support Packages. Instead you can search for them and include them directly from the BIND_PATCH phase.
  
  In the BIND_PATCH phase, you now enter all Support Package types on one wizard screen.
  
  You can now also reduce the number of Support Packages that you want to include without having to reset PREPARE.

- **Queue calculation function when including Support Packages**
  
  The sequence in which you import Support Packages is now determined by the queue calculation function in the Support Package Manager (SPAM). This also makes sure that Add-On Patches (AOPs) and Conflict Resolution Transports (CRTs) are imported consistently.

- **Mass activation of ABAP Dictionary objects**
  
  The mass activation of ABAP Dictionary objects is performed in parallel. The dependencies among the ABAP Dictionary objects do not allow multiple activation programs to be started as background jobs in parallel, unlike other tools (such as the conversion program). The objects are sorted by their dependencies and split into different levels. These levels are then activated in sequence, with each of the levels being made parallel with asynchronous RFC.

  The number of parallel processes is controlled by the work process resources and the estimated capacity needed to activate the objects in one level.

  The minimum number of dialog processes needed to start mass activation of Dictionary objects in parallel is six. The upgrade tools automatically make this resource available if at least three background processes are permitted for the upgrade.
• Language transport

The technical basis of the language transport has been changed completely. Languages are now imported with the transport programs R3trans and tp as part of the table import phases. This makes the separate language import phases obsolete. For information on the language transport, see the SAP Library under Help → SAP NetWeaver Library → SAP NetWeaver → Solution Lifecycle Management → Software Change Management → Change and Transport System → Language Transport.

• Shadow import

To minimize the longer downtimes caused by including transport requests, shadow imports are used as of Release 4.6B when upgrading the SAP system. For the A_switch and A_on strategies (corresponds to the downtime-minimized strategy as of Release 6.10), the transport requests for Support Packages, Industry Solutions, and the modification adjustment are now imported into the SAP system during production operation. The import (ABAP Dictionary and main import) is not made into the original Repository (source release). Instead it occurs in the shadow repository (new Repository of the target release), which is loaded into the SAP system during the EU_IMPORT phase. This shadow import is performed in the SHADOW_IMPORT_ALL upgrade phase.

New technology implemented in R3trans allows you to use the shadow import and include the transport requests during production operation. This technology will also be used in other cases to minimize upgrade downtime as much as possible.
2 Upgrade - Step by Step

Purpose

This section is a checklist and contains all the actions you need to perform:

- Find SAP Notes [page 30]
- Plan the upgrade (SAP BW-specific [page 37] / general [page 66])
- Prepare the upgrade (SAP BW-specific [page 46] / general [page 94])
- Perform the upgrade (SAP BW-specific [page 54] / general [page 138])
- Perform post-upgrade activities (SAP BW-specific [page 56] and general [page 159])

The actions are placed in chronological order, so that you can work through them just like a checklist. For more information, follow the links to the general descriptions of the actions and to any additional product-specific information to help you perform the actions.

The last part of this documentation, Additional Information [page 195], contains three sections with information on how to proceed with errors, perform administration tasks, and use the upgrade tools:

- Troubleshooting [page 196]
- Upgrade Administration [page 217]
- Upgrade Tools [page 230]

Process Flow

SAP Notes for the Upgrade

This upgrade documentation is enhanced and updated by SAP Notes in SAPNet – R/3 Frontend. These SAP Notes are an important source of information when you plan and prepare your upgrade, and also help you perform the upgrade itself.

<table>
<thead>
<tr>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>You request the current SAP Notes for the upgrade [page 30]. You require at least the following SAP Notes:</td>
</tr>
<tr>
<td>- BW-specific Upgrade Note 658992</td>
</tr>
<tr>
<td>- The relevant database-specific SAP Note:</td>
</tr>
<tr>
<td>- 662191 / 679581 (DB2 UDB for UNIX and Windows)</td>
</tr>
<tr>
<td>- 661252 (DB2 UDB for z/OS)</td>
</tr>
<tr>
<td>- 647130 (Informix)</td>
</tr>
<tr>
<td>- 669656 (MaxDB)</td>
</tr>
<tr>
<td>- 669236 / 669237 (MS SQL Server)</td>
</tr>
<tr>
<td>- 662219 (Oracle)</td>
</tr>
</tbody>
</table>
Upgrade Planning

Before you start the actual upgrade, you must plan it carefully so that downtime is reduced to a minimum, and the upgrade runs as smoothly as possible.

The Planning the Upgrade part of the documentation contains SAP BW-specific [page 37] / general [page 66] information on planning.

<table>
<thead>
<tr>
<th>✓ Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>You can upgrade the front-end software [page 68] as soon as you receive the software package, since the software is downward-compatible.</td>
</tr>
<tr>
<td>You familiarize yourself with the features of the System Switch Upgrade [page 68] and its effect on the way you upgrade the system.</td>
</tr>
<tr>
<td>You decide on an upgrade strategy, taking into account your operating system and database upgrade (SAP BW-specific [page 37] / general [page 71]).</td>
</tr>
<tr>
<td>You define an archiving strategy [page 74] for your database.</td>
</tr>
<tr>
<td>Before you start the upgrade, you check the database-specific aspects [page 75] and include them in your upgrade schedule, if necessary.</td>
</tr>
<tr>
<td>You check whether your system is an MCOD system [page 78].</td>
</tr>
<tr>
<td>You plan data management measures [page 79] to reduce the amount of data, if necessary.</td>
</tr>
<tr>
<td>You plan the incremental table conversion [page 80], if necessary.</td>
</tr>
<tr>
<td>You draw up an upgrade schedule (SAP BW-specific [page 38] / general [page 82]).</td>
</tr>
<tr>
<td>Depending on your chosen upgrade strategy, you plan the runtime for the import of the substitution set (SAP BW-specific [page 39] / general [page 85]).</td>
</tr>
<tr>
<td>You decide on the sequence of upgrades in your SAP system group [page 85].</td>
</tr>
<tr>
<td>You plan the modification adjustment [page 86], if necessary.</td>
</tr>
<tr>
<td>You check the structural requirements [page 88].</td>
</tr>
<tr>
<td>You check the hardware requirements (SAP BW-specific [page 39] / general [page 89]).</td>
</tr>
<tr>
<td>• CPU, main memory, and page file – see SAP Service Marketplace at service.sap.com/quicksizing</td>
</tr>
<tr>
<td>• Space requirements in the database:</td>
</tr>
<tr>
<td>o DB2 UDB for UNIX and Windows: 17 GB</td>
</tr>
<tr>
<td>o DB2 UDB for z/OS: See SAP Note 661253</td>
</tr>
<tr>
<td>o Informix: 18 GB</td>
</tr>
<tr>
<td>o MaxDB: 7 GB</td>
</tr>
<tr>
<td>o MS SQL Server: 9 GB</td>
</tr>
<tr>
<td>The option Automatically grow file is set for the SAP database during the upgrade. This makes the database adjust its size to the requirements of the upgrade.</td>
</tr>
<tr>
<td>o Oracle: 17 GB</td>
</tr>
</tbody>
</table>
You check the software requirements [page 89].

- Source release of the SAP system (SAP BW-specific [page 40] / general [page 89]):
  For all databases: 2.0B, 2.1C, 3.0B; 3.1 Content
- Upgrade Assistant [page 90]: Java Virtual Machine (at least Version 1.3x)

You plan or perform the upgrade of the operating system and database system, if necessary (SAP BW-specific [page 41] and general [page 90]).

- Operating system version
  The SAP BW Server 3.5 is supported under Windows 2000 and Windows Server 2003 with the current Service Pack.
  You must upgrade the operating system to Windows 2000 or Windows Server 2003 before the upgrade.
  If you have installed additional SAP software components under Windows NT 4.0 on the server containing the central instance that have not been released for Windows 2000, you must perform the upgrade under Windows NT 4.0. Read the detailed information under Upgrade of the Operating System and Database System: Overview [page 41].
  For the operating system requirements, see the SAP Service Marketplace under service.sap.com/platforms.

- Database version:
  - DB2 UDB for UNIX and Windows
    At least Version 8, FixPak 3; migrate before PREPARE
  - DB2 UDB for z/OS:
    At least version 8.1.5 (New Function mode); migrate before PREPARE
  - Informix
    See SAP Note 647130
  - MaxDB
    At least Version 7.5.00; migrate before PREPARE
  - MS SQL Server
    At least version 2000 with the current Service Pack; migrate before PREPARE
  - Oracle
    At least version 9.2.0; migrate before PREPARE

You meet the requirements for installing the online documentation [page 91] as described in the documentation Installing the SAP Library.

You meet the requirements for the SAP Internet Transaction Server and the SAP@Web Studio [page 91] as described in the SAP@Web Installation Guide, if necessary.

You meet the requirements for importing additional languages [page 93], if necessary.
## Upgrade Preparations

You can prepare for the upgrade while the system is in production operation. The `PREPARE` program supports you here by making most of the necessary checks automatically. Start `PREPARE` as soon as possible before the upgrade so that you can initiate or perform the necessary preparations in time.

The *Upgrade Preparations* part of this documentation contains SAP BW-specific / general information.

### Preparations for PREPARE

<table>
<thead>
<tr>
<th>✓ Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>You choose the <a href="#">host</a> for <code>PREPARE</code> and the Upgrade Assistant.</td>
</tr>
<tr>
<td>You make <a href="#">consistency checks for the Web templates</a>.</td>
</tr>
<tr>
<td>You convert the <a href="#">data classes of InfoCubes</a>.</td>
</tr>
<tr>
<td>You check <a href="#">inconsistent InfoObjects</a>.</td>
</tr>
<tr>
<td>You perform the actions for the <a href="#">ALPHA converter</a>.</td>
</tr>
</tbody>
</table>

You create an empty upgrade directory on the host with the central instance ([SAP BW-specific](#) and [general](#)):  
- With a total of 1 GB free disk space
- Include approximately 20% extra space in the file system if you have made a lot of your own developments. Also do this if you want to include Support Packages and add-ons.
- If you want to import languages other than English and German, provide an extra 75 MB of memory for each language.

You check the [database-specific requirements](#) for `PREPARE`. The following free space must be available.  
- DB2 UDB for UNIX and Windows / DB2 UDB for z/OS / MS SQL / Oracle: 500 MB
- Informix: At least 200 MB
- MaxDB: 800 MB (corresponds to 100,000 pages)

You convert [inconsistent characteristic values with a conversion routine](#).

You import the [latest SPAM update](#).
**Actions for Starting PREPARE**

<table>
<thead>
<tr>
<th>✓</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>When you start PREPARE for the first time, you must start it from the DVD [page 102].</td>
</tr>
<tr>
<td></td>
<td>1. You insert the Upgrade Master DVD.</td>
</tr>
<tr>
<td></td>
<td>2. You log on to the host with the central instance as user &lt;SAPSID&gt;ADM.</td>
</tr>
<tr>
<td></td>
<td>3. In the Windows NT Explorer, change to subdirectory \NT\I386\ (Windows Server 2003 for 64 bit: \NT\IA64) on the DVD drive and start PREPARE.EXE.</td>
</tr>
<tr>
<td></td>
<td>4. You exit PREPARE with EXIT.</td>
</tr>
<tr>
<td></td>
<td>5. You start the Upgrade Assistant server [page 103].</td>
</tr>
<tr>
<td></td>
<td>6. You start the GUI of the Upgrade Assistant [page 103].</td>
</tr>
<tr>
<td></td>
<td>7. You start the Upgrade Assistant [page 104].</td>
</tr>
</tbody>
</table>

If you want to restart PREPARE [page 105], for example, if the results from its first run make you want to repeat some checks, enter the command PREPARE.EXE REPEAT.

You can reset PREPARE [page 105] at any time, for example, if you want to use it for another system.

If you need extra software after starting PREPARE, you import it now [page 106].

PREPARE needs certain information from you so that it can run the modules. If possible, default values appear that you can confirm or change. For a complete list of all PREPARE modules and phases, see Using the Phase List for the Upgrade [page 228].

**User Actions During PREPARE**

<table>
<thead>
<tr>
<th>✓</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>You make the first entries [page 106] for PREPARE.</td>
</tr>
<tr>
<td></td>
<td>You make the entries for the Parameter Input module (SAP BW-specific [page 49] and general [page 107]). This includes entering DVD and CD mount directories.</td>
</tr>
<tr>
<td></td>
<td>You make the entries for the Initialization module [page 112]:</td>
</tr>
<tr>
<td></td>
<td>• You check the version of SAP kernel, tp and R3trans</td>
</tr>
<tr>
<td></td>
<td>• You check the SAP Notes for the add-ons, if necessary</td>
</tr>
<tr>
<td></td>
<td>• DB2 UDB for z/OS: Among other things you create or extend stogroups, if necessary.</td>
</tr>
<tr>
<td></td>
<td>You make entries for the Import Module [page 113].</td>
</tr>
<tr>
<td></td>
<td>You make entries for the Extension module (SAP BW-specific [page 51] and general [page 114]), such as including Support Packages.</td>
</tr>
<tr>
<td></td>
<td>You make the entries for the Installation module (SAP BW-specific [page 52]/general [page 124], such as the instance number for the shadow system.</td>
</tr>
<tr>
<td></td>
<td>MaxDB: If necessary, you change the database parameters MAXUSERTASKS and MAXLOCKS.</td>
</tr>
<tr>
<td></td>
<td>Microsoft Cluster Server (MSCS)</td>
</tr>
<tr>
<td></td>
<td>You make the entries for the MSCS Configuration [page 125].</td>
</tr>
<tr>
<td></td>
<td>End of Microsoft Cluster Server (MSCS)</td>
</tr>
</tbody>
</table>
Manual Checks

☑ Action

You evaluate the results of PREPARE [page 126] in the log file CHECKS.LOG.

You make sure that the page file [page 219] is large enough.

You make preparations at the operating system level [page 130].
  - You make a backup copy of the old SAP kernel.

You make preparations at the database level [page 131].
  - You make sure that you can recover the database to the state it had before the upgrade.
  - You make the database-specific preparations.

You make preparations at the SAP system level [page 134].
  - You delete the AUTOSTART parameter.
  - You make sure that the requirements for user DDIC [page 134] have been met.
  - You make sure that the requirements for the modification adjustment [page 135] have been met.
  - You call transaction RZ04 to set the operation mode [page 135] for the upgrade.
  - You import the new front-end software [page 68], if necessary.

The Upgrade

This part of the documentation contains SAP BW-specific [page 54] and general [page 138] information on upgrading the system. For a complete list of all the upgrade phases, see Using the Phase list for the Upgrade [page 228].

☑ Action

You check the BW-specific upgrade Note and your database-specific upgrade Note for new information and changes [page 30].

You choose the host [page 96] for the upgrade.

You mount the following DVD [page 49], if you have not already done so:
SAP NetWeaver ’04 – Upgrade Export/Languages

You start R3up [page 140] from the central instance.
You can stop [page 141] and restart [page 141] the upgrade if errors occur.

Phase INITPUT [page 146]:
You enter the system-specific parameters.

Phase PATCH_CHK [page 146]:
You confirm any unconfirmed Support Packages.

Phase KEY_CHK [page 147]:
You enter the key word from the current Upgrade Note 658992.
### Phase INITSUBST [page 147]:
- You choose your upgrade strategy. If you choose *downtime-minimized*, you determine the runtime for the import of the substitution set (around 12 hours).
- If you choose the strategy *resource-minimized*, you determine the number of parallel processes for importing the substitution set.
- You choose the time when you want database archiving to be switched off.
- DB2 UDB for z/OS: Logging is always activated.
- You determine the number of parallel background processes.
- DB2 UDB for z/OS: You enter the number of parallel *tp* processes in the **PARCONV_UPG** phases, and define a threshold quantity for indexes to be created with DEFER YES.

### Phase CONFCHECK [page 149]:
You update your operating system or database to the required version now at the latest, or you import any software you still need.

### Phase VIEWCHK1: [page 150]
You can begin to remove conflicts between customer tables and new views by deleting the customer tables in this phase.

### Phase REPACHK1 [page 150]:
You release the locked objects and confirm repairs. You must do this in the **REPACHK2** phase at the latest.

### Phase JOB_RSVBCHCK2 [page 150]:
You clean up outstanding updates. You must do this in the **JOB_RSVBCHCK_R** or **JOB_RSVBCHCK_D** phase at the latest.

### Phase FREECHK_X [page 151]:
You make sure that you can recover the old kernel if this becomes necessary.

### Phase LOCKEU_PRE (SAP BW-specific [page 54] / general [page 151]):
For *downtime-minimized*: You lock the ABAP Workbench and the Administrator Workbench. You must do this in the **REPACHK2** phase at the latest.

### Phase EU_IMPORT1 [page 152]:
For *resource-minimized*: You isolate the central instance, stop the application server and change the database recovery mode, if necessary.

All **EU_IMPORT** phases (SAP BW specific [page 54] / general [page 152]):
If the relevant DVD with the CD contents is not in one of the specified mount points, you are prompted to change the CD.

### Phase REPACHK2 (SAP BW-specific [page 55] and general [page 153])
- You release and confirm all open repairs in this phase at the latest.
- For *downtime-minimized*: You lock the ABAP Workbench and the Administrator Workbench in this phase at the latest.

### Phase CNV_CHK_XT [page 153]:
You process any uncompleted conversion requests and restart logs.

### Phase ADJUSTCHK [page 154]:
Modifications: You confirm the request, if necessary.
<table>
<thead>
<tr>
<th>Phase</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>START_SHDI_FIRST</strong></td>
<td>As of this phase you can only log on with the new front-end software [page 68].</td>
</tr>
<tr>
<td><strong>ACT &lt;rel&gt;</strong> [page 154]:</td>
<td>Modifications: You adjust modified SAP objects with the SAP standard versions.</td>
</tr>
<tr>
<td><strong>VIEWCHK2</strong> [page 156]:</td>
<td>You remove conflicts between customer tables and new views by deleting the customer tables in this phase at the latest.</td>
</tr>
<tr>
<td><strong>MODPROF_TRANS</strong> [page 156]:</td>
<td>For downtime-minimized: You isolate the central instance, stop the application server and change the database recovery mode, if necessary. Also make sure that you can recover the database to its current state. You back up the upgrade directory. You check the percentage of tables converted in transaction ICNV, if necessary.</td>
</tr>
<tr>
<td><strong>JOB_RSVBCHCK_R and JOB_RSVBCHCK_D</strong> [page 157]:</td>
<td>You clean up outstanding updates in this phase at the latest.</td>
</tr>
<tr>
<td><strong>MODPROFP_UPG</strong> [page 158]:</td>
<td>In the phases MODPROFP_UPG, STARTR3_PUPG, and CHK_POSTUP You back up the database. You determine P errors You change the database recovery mode You start the secondary application servers.</td>
</tr>
<tr>
<td><strong>CHK_POSTUP</strong> [page 158]:</td>
<td>You remove the P errors before you restart production operation of the system.</td>
</tr>
</tbody>
</table>
Post-Upgrade Activities

This part of the documentation contains SAP BW-specific [page 56] and general [page 159] information.

R3up stops at the latest in the MODPROFF_UPG phase and prompts you to start the post-upgrade activities. R3up then executes the last phases and completes the upgrade. At the same time you can perform the post-upgrade activities specified by R3up.

Activities Before Starting Production Operation

<table>
<thead>
<tr>
<th>✓</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>You activate the Internet Communication Manager [page 56].</td>
</tr>
<tr>
<td></td>
<td>You convert the Web objects from SAP BW 2.x to 3.0 [page 57].</td>
</tr>
<tr>
<td></td>
<td>You convert the chart settings [page 61].</td>
</tr>
<tr>
<td></td>
<td>You switch over to the new standard template for ad hoc analysis [page 63].</td>
</tr>
<tr>
<td></td>
<td>You perform the database-specific actions:</td>
</tr>
<tr>
<td></td>
<td>• <strong>DB2 UDB for UNIX and Windows [page 161]:</strong> You install or update the DB2 administration tools, switch on log archiving, back up the database, delete substitution tables, update statistics, and schedule update statistics jobs.</td>
</tr>
<tr>
<td></td>
<td>• <strong>DB2 UDB for z/OS [page 163]:</strong> You back up and reorganize the database, schedule an update statistics job, import correction transports, tune new tables, remove database objects that you no longer need, and install saposcol and rfcoscol.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Informix [page 165]:</strong> You delete the empty dbspaces for the substitution tables and back up the database.</td>
</tr>
<tr>
<td></td>
<td>• <strong>MaxDB [page 166]:</strong> You set the database parameters to their pre-upgrade state and restore the ability of the database to be recovered.</td>
</tr>
<tr>
<td></td>
<td>• <strong>MS SQL Server (SAP BW-specific [page 63] / general [page 167]):</strong> You back up the database. Start the SQL Server Agent, if it is not running.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Oracle [page 167]:</strong> You create or update the SAPDBA role, check the environment variables for the BR*Tools and back up the database.</td>
</tr>
</tbody>
</table>

**Microsoft Cluster Server (MSCS)**

You perform the post-upgrade activities [page 169]. See SAP Note 544988.

**End of Microsoft Cluster Server (MSCS)**

You perform the post-upgrade activities for the SAP kernel [page 171].

You upgrade the application servers [page 169].

You call transaction RZ10 to check the profile parameters [page 172] and reset them to their default values, if necessary.

You install the J2EE Engine, if necessary (SAP BW-specific [page 63] / general [page 172]).

You reimport additional programs [page 174] such as RFC-SDK or CPIC-SDK from the DVD SAP NetWeaver ’04 – Presentation, if necessary.
You call transaction SPAU to adjust modifications to Repository objects [page 174], if necessary.

You perform post-upgrade activities for the applications (SAP BW-specific [page 64] / general [page 175]).

Configure Single Sign-On with the NT LAN Manager SSP [page 176], if necessary.

You can perform the following post-upgrade activities during limited production operation [page 159] of the system.

### Actions After Rebooting Limited Production Operation

<table>
<thead>
<tr>
<th>✓ Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>You reschedule background jobs [page 181] that were locked when you isolated the central instance.</td>
</tr>
<tr>
<td>You perform database-specific actions:</td>
</tr>
<tr>
<td>• Informix [page 183]: You update statistics.</td>
</tr>
<tr>
<td>• MaxDB [page 185]: You update the optimizer statistics.</td>
</tr>
<tr>
<td>• Oracle [page 183]: You perform actions for the Cost-Based Optimizer.</td>
</tr>
<tr>
<td>You call transaction SGEN to generate ABAP loads [page 185].</td>
</tr>
<tr>
<td>You call transaction SGEN to generate the BSP applications [page 186], if necessary.</td>
</tr>
<tr>
<td>You perform actions for the online documentation [page 187] as described in the documentation Installing the SAP Library.</td>
</tr>
<tr>
<td>You install the SAP Internet Transaction Server [page 91] as described in the documentation SAP@Web Installation, if necessary.</td>
</tr>
<tr>
<td>You perform post-upgrade activities in the authorizations area [page 187].</td>
</tr>
<tr>
<td>• You adjust the assignments between check flags and transactions.</td>
</tr>
<tr>
<td>• Upward compatibility for authorization checks: You adjust SAP_NEW.</td>
</tr>
<tr>
<td>• You handle problems with user buffers.</td>
</tr>
<tr>
<td>Use SAPinst to install more dialog instances [page 189], if necessary.</td>
</tr>
</tbody>
</table>
You can perform the following post-upgrade activities during normal production operation of the system.

**Actions After Starting Production Operation**

<table>
<thead>
<tr>
<th>✓</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>You import Support Packages, if necessary ([SAP BW-specific](page 64) and [general](page 190)). If you want to install additional languages, you import them before you import the Support Packages as described in the <em>Language Transport</em> documentation.</td>
<td></td>
</tr>
<tr>
<td>SAP Retail: Convert the [terminology](page 64).</td>
<td></td>
</tr>
<tr>
<td><strong>Transport Management System (TMS)</strong> ([page 190]): You distribute the configuration to all systems in the transport domain.</td>
<td></td>
</tr>
<tr>
<td><strong>Language transport</strong> ([page 191]): You copy glossary and terminology data from container tables to database tables.</td>
<td></td>
</tr>
<tr>
<td>You perform database-specific actions for <strong>Oracle</strong> ([page 191]): You delete old tablespaces.</td>
<td></td>
</tr>
<tr>
<td>You convert old [batch input logs](page 192) to the new procedure in all clients, if necessary.</td>
<td></td>
</tr>
<tr>
<td>You make a backup of the subdirectory containing the [shadow instance profiles](page 193), if necessary.</td>
<td></td>
</tr>
</tbody>
</table>

There are some post-upgrade activities that you do not need to perform directly after the upgrade. You can leave these activities until later.

**Evaluating the Upgrade Runtime**

<table>
<thead>
<tr>
<th>✓</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>You send the evaluation of the [runtime of the upgrade](page 193) to SAP.</td>
<td></td>
</tr>
</tbody>
</table>
3  SAP Notes for the SAP BW Upgrade

Definition

To prepare and perform the upgrade of your SAP system, you require additional information, not included in the documentation. This information is in a range of SAP Notes in SAPNet - R/3 Frontend some of which you must read before you prepare the upgrade. The BW-specific upgrade note contains current cross-database information on preparing the upgrade. There are separate SAP Notes for the database-specific sections. When you actually upgrade the SAP system you need information from some additional SAP Notes. These SAP Notes are named at the appropriate places in this documentation.

SAP Notes for Preparing the Upgrade

You must request the specific BW Note, and the Note for your database from SAPNet – R/3 Frontend before you start your upgrade. Since these SAP Notes are updated regularly, make sure you always use the newest version. The following list contains the SAP Notes you need to read to prepare for the upgrade:

<table>
<thead>
<tr>
<th>SAP Note Number</th>
<th>Topic</th>
<th>SAP Note Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>658992</td>
<td>Additional Information for the Upgrade to BW 3.5</td>
<td>BW-specific / specific to this upgrade</td>
</tr>
<tr>
<td>662191</td>
<td>DB2 UDB for UNIX and Windows</td>
<td>DB2 UDB for UNIX and Windows-specific / specific to this upgrade</td>
</tr>
<tr>
<td>679581</td>
<td>DB2 UDB for UNIX and Windows</td>
<td>DB2 UDB for UNIX and Windows-specific / BW-specific</td>
</tr>
<tr>
<td>661252</td>
<td>DB2 UDB for z/OS</td>
<td>DB2 UDB for z/OS-specific / specific to this upgrade</td>
</tr>
<tr>
<td>657130</td>
<td>Informix</td>
<td>Informix-specific / specific to this upgrade</td>
</tr>
<tr>
<td>669656</td>
<td>MaxDB</td>
<td>MaxDB-specific / specific to this upgrade</td>
</tr>
<tr>
<td>669236</td>
<td>MS SQL Server</td>
<td>MS SQL Server-specific / specific to this upgrade</td>
</tr>
<tr>
<td>669237</td>
<td>MS SQL Server</td>
<td>MS SQL Server-specific / BW-specific</td>
</tr>
<tr>
<td>662219</td>
<td>Oracle</td>
<td>Oracle-specific / specific to this upgrade</td>
</tr>
</tbody>
</table>

Keyword for the Upgrade

When you start the upgrade, you are asked to enter a keyword, which you can get from the current general Upgrade Note 658992. You cannot start the upgrade until you have entered the keyword.

Other SAP Notes

As well as the SAP Notes you need for preparing the upgrade, this documentation also refers you to other SAP Notes that contain additional information. The following list contains these SAP Notes, organized by database:
## SAP Notes for All Databases

<table>
<thead>
<tr>
<th>SAP Note Number</th>
<th>Topic</th>
<th>SAP Note Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>659000</td>
<td>Importing Support Packages in BW 3.5</td>
<td>BW-specific</td>
</tr>
<tr>
<td>634214</td>
<td>Installation and Upgrade to BI_CONT 3.51</td>
<td>Add-on</td>
</tr>
<tr>
<td>26417</td>
<td>SAP GUI resources: Hardware and Software</td>
<td>Front end / SAP GUI</td>
</tr>
<tr>
<td>161993</td>
<td>SAP GUI resources (BW): Hardware and Software</td>
<td>Front end / SAP GUI</td>
</tr>
<tr>
<td>83458</td>
<td>Downloading Support Packages from the SAP Service Marketplace</td>
<td>SAP Support Packages</td>
</tr>
<tr>
<td>125971</td>
<td>Service Connection Upgrade Assistant in SAPNet - R/3 Frontend</td>
<td>Remote support for upgrade</td>
</tr>
<tr>
<td>133402</td>
<td>Using the Upgrade Assistant with SAProuter</td>
<td>Upgrade Assistant</td>
</tr>
<tr>
<td>62519</td>
<td>Correction locks do not belong to system</td>
<td>Workbench Organizer</td>
</tr>
<tr>
<td>51046</td>
<td>Copying the modification adjustment without a central transport directory</td>
<td>Change and Transport System</td>
</tr>
<tr>
<td>96905</td>
<td>Error message TG063 in the upgrade phase JOB_RADDRCHK</td>
<td>ABAP Dictionary</td>
</tr>
<tr>
<td>525988</td>
<td>Upgrade problems in the fact table views</td>
<td>Database interface</td>
</tr>
<tr>
<td>24864</td>
<td>No conversion of table BSEG</td>
<td>ABAP Dictionary / phase PARCONV_UPG</td>
</tr>
<tr>
<td>10187</td>
<td>User buffer too small</td>
<td>User administration</td>
</tr>
<tr>
<td>197746</td>
<td>Maintenance Strategy: Internet Transaction Server (ITS)</td>
<td>SAP@Web</td>
</tr>
<tr>
<td>399578</td>
<td>Publishing IAC objects on the ITS after the upgrade</td>
<td>SAP@Web</td>
</tr>
<tr>
<td>86627</td>
<td>Transaction types: Customizing for release upgrades</td>
<td>Customizing</td>
</tr>
<tr>
<td>676714</td>
<td>Current Note on the 6.40 language import</td>
<td>Language transport</td>
</tr>
<tr>
<td>352941</td>
<td>Language import and Support Packages</td>
<td>Language transport</td>
</tr>
<tr>
<td>322982</td>
<td>Install languages during upgrade</td>
<td>Language transport</td>
</tr>
<tr>
<td>485741</td>
<td>Dealing with customer translations in the upgrade</td>
<td>Language transport</td>
</tr>
<tr>
<td>663240</td>
<td>Repairs for Upgrade to SAP Web AS 6.40</td>
<td>General upgrade</td>
</tr>
<tr>
<td>663258</td>
<td>Corrections for R3up version 640</td>
<td>General upgrade</td>
</tr>
<tr>
<td>177680</td>
<td>Correcting conversion problems in the PARCONV_UPG phase</td>
<td>General upgrade</td>
</tr>
<tr>
<td>Note Number</td>
<td>Note Description</td>
<td>Release Type</td>
</tr>
<tr>
<td>-------------</td>
<td>--------------------------------------------------------</td>
<td>----------------</td>
</tr>
<tr>
<td>417670</td>
<td>Additional Information About Resetting the Upgrade</td>
<td>General upgrade</td>
</tr>
<tr>
<td>186066</td>
<td>Increased freespace requirements during the upgrade</td>
<td>General upgrade</td>
</tr>
<tr>
<td>175596</td>
<td>Switch to a new batch input log</td>
<td>General upgrade</td>
</tr>
<tr>
<td>122597</td>
<td>Ignore errors in XPRAS_UPG phase</td>
<td>General upgrade</td>
</tr>
<tr>
<td>430318</td>
<td>Shadow instance on another operating system</td>
<td>General upgrade</td>
</tr>
<tr>
<td>94998</td>
<td>Requesting a license key for a system</td>
<td>General upgrade</td>
</tr>
<tr>
<td>48550</td>
<td>CD problems in phase PREPARE and LANG_REQ</td>
<td>General upgrade</td>
</tr>
<tr>
<td>309461</td>
<td>Kernel, Basis and BW Releases</td>
<td>BW-specific</td>
</tr>
<tr>
<td>493387</td>
<td>Potential effects of changes to tables/structures</td>
<td>Activation</td>
</tr>
<tr>
<td>490788</td>
<td>ICNV in the upgrade to SAP Web AS 6.20</td>
<td>ICNV</td>
</tr>
<tr>
<td>367676</td>
<td>Upgrade from 4.6 to 6.10 for customer programs</td>
<td>Adjusting customer developments</td>
</tr>
<tr>
<td>452229</td>
<td>Upgrade from 6.10 to 6.20 for customer programs</td>
<td>Adjusting customer developments</td>
</tr>
<tr>
<td>689951</td>
<td>Upgrade from 6.20 to 6.40 for customer programs</td>
<td>Adjusting customer developments</td>
</tr>
<tr>
<td>318846</td>
<td>Installation of a 4.6D kernel</td>
<td>SAP kernel</td>
</tr>
<tr>
<td>94998</td>
<td>Requesting a license key for a system</td>
<td>General upgrade</td>
</tr>
<tr>
<td>502999</td>
<td>Installing SAP kernel 6.20 into a system using SAP Web AS 6.10</td>
<td>SAP kernel</td>
</tr>
<tr>
<td>664679</td>
<td>Installing SAP kernel 6.40 into a system using SAP Web AS 6.20</td>
<td>SAP kernel</td>
</tr>
<tr>
<td>211077</td>
<td>Exchanging the target release kernel during the upgrade</td>
<td>SAP kernel</td>
</tr>
<tr>
<td>19466</td>
<td>Downloading SAP kernel patches</td>
<td>SAP kernel</td>
</tr>
</tbody>
</table>
### SAP Notes for DB2 UDB for UNIX and Windows

<table>
<thead>
<tr>
<th>SAP Note Number</th>
<th>Topic</th>
<th>SAP Note Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>553963</td>
<td>DB6: Migration to DB2 UDB Version 8</td>
<td>DB2 UDB for UNIX and Windows</td>
</tr>
<tr>
<td>101809</td>
<td>DB6 Supported Fixpaks for DB2 UDB for UNIX and Windows</td>
<td>DB2 UDB for UNIX and Windows</td>
</tr>
<tr>
<td>546262</td>
<td>DB6: Administration &amp; Performance on SAP BW, SAP SCM, SAP SEM</td>
<td>DB2 UDB for UNIX and Windows-specific</td>
</tr>
<tr>
<td>455506</td>
<td>DB6: Installation of latest admin tools 6NN DB2</td>
<td>DB2 UDB for UNIX and Windows-specific</td>
</tr>
</tbody>
</table>

### SAP Notes for DB2 UDB for z/OS

<table>
<thead>
<tr>
<th>SAP Note Number</th>
<th>Topic</th>
<th>SAP Note Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>81737</td>
<td>DB2/390: APAR list</td>
<td>DB2 UDB for z/OS-specific</td>
</tr>
<tr>
<td>183311</td>
<td>DB2/390: Automatic PTF Check</td>
<td>DB2 UDB for z/OS-specific</td>
</tr>
<tr>
<td>103135</td>
<td>DB2/390: Manual saposcol installation</td>
<td>DB2 UDB for z/OS-specific</td>
</tr>
<tr>
<td>122599</td>
<td>DB2/390: Performance of the update</td>
<td>DB2 UDB for z/OS-specific</td>
</tr>
<tr>
<td>731937</td>
<td>DB2-z/OS: Customized DB2 Connect for Web AS 6.20 and DB2 V8</td>
<td>DB2 UDB for z/OS-specific</td>
</tr>
<tr>
<td>434946</td>
<td>DB2/390: R3szchk &amp; R3ldclt for upgrade to &gt;= 6.10</td>
<td>DB2 UDB for z/OS-specific</td>
</tr>
<tr>
<td>184399</td>
<td>DB2/390: DDIC corrections (4.6A, 4.6B, 4.6C, 4.6D)</td>
<td>DB2 UDB for z/OS-specific</td>
</tr>
<tr>
<td>407663</td>
<td>DB2/390: DDIC corrections (6.10, 6.20)</td>
<td>DB2 UDB for z/OS-specific</td>
</tr>
<tr>
<td>686905</td>
<td>DB2-z/OS: DDIC corrections (6.40)</td>
<td>DB2 UDB for z/OS-specific</td>
</tr>
<tr>
<td>661253</td>
<td>DB2-z/OS: Upgrade to Web AS 6.40 – free space</td>
<td>DB2 UDB for z/OS-specific</td>
</tr>
<tr>
<td>661260</td>
<td>DB2-z/OS: Transports for 6.40 and Support Packages for 6.40</td>
<td>DB2 UDB for z/OS-specific</td>
</tr>
<tr>
<td>326949</td>
<td>Shared Memory Management S/390 Application Server</td>
<td>DB2 UDB for z/OS-specific</td>
</tr>
</tbody>
</table>

### SAP Notes for Informix

<table>
<thead>
<tr>
<th>SAP Note Number</th>
<th>Topic</th>
<th>SAP Note Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>50157</td>
<td>Using recommended versions of Informix</td>
<td>Informix-specific</td>
</tr>
<tr>
<td>22941</td>
<td>Reorganization of tables and dbspaces</td>
<td>Informix-specific</td>
</tr>
<tr>
<td>115619</td>
<td>Informix Client versions</td>
<td>Informix-specific</td>
</tr>
</tbody>
</table>
### SAP Notes for MaxDB

<table>
<thead>
<tr>
<th>SAP Note Number</th>
<th>Topic</th>
<th>SAP Note Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>528433</td>
<td>SAP DB Version Upgrade to 7.3.00 Build 024, 027 and 028</td>
<td>MaxDB-specific</td>
</tr>
<tr>
<td>34690</td>
<td>Add Devspace under SAP DB (ADABAS for R/3)</td>
<td>MaxDB-specific</td>
</tr>
<tr>
<td>46430</td>
<td>SAP DB load with parallel R3LOADS</td>
<td>MaxDB-specific</td>
</tr>
<tr>
<td>201388</td>
<td>Changing a database parameter in SAP DB Release 7.2 and 7.3</td>
<td>MaxDB-specific</td>
</tr>
<tr>
<td>201390</td>
<td>Back up the database SAP DB</td>
<td>MaxDB-specific</td>
</tr>
<tr>
<td>352081</td>
<td>Additional functions relevant to services for SAP DB</td>
<td>MaxDB-specific</td>
</tr>
<tr>
<td>362542</td>
<td>Analysis of table sizes and growth</td>
<td>MaxDB-specific</td>
</tr>
</tbody>
</table>

### SAP Notes for MS SQL Server

<table>
<thead>
<tr>
<th>SAP Note Number</th>
<th>Topic</th>
<th>SAP Note Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>62988</td>
<td>Service Packs for MS SQL Server</td>
<td>MS SQL Server-specific</td>
</tr>
<tr>
<td>139945</td>
<td>SAP Database Monitor for MS SQL Server</td>
<td>MS SQL Server-specific</td>
</tr>
<tr>
<td>209596</td>
<td>Microsoft SQL Server 2000</td>
<td>For database release MS SQL Server 2000</td>
</tr>
<tr>
<td>327494</td>
<td>Configuration parameters for MS SQL Server 2000</td>
<td>For database release MS SQL Server 2000</td>
</tr>
<tr>
<td>417089</td>
<td>Service Pack installation on MS SQL Server 2000</td>
<td>For database release MS SQL Server 2000</td>
</tr>
<tr>
<td>544988</td>
<td>Post-upgrade activities for MSCS using SAPinst</td>
<td>MSCS-specific</td>
</tr>
</tbody>
</table>

### SAP Notes for Oracle

<table>
<thead>
<tr>
<th>SAP Note Number</th>
<th>Topic</th>
<th>SAP Note Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>11777</td>
<td>Changing the storage parameters \text{NEXT} and \text{MAX EXTENTS}</td>
<td>Oracle-specific</td>
</tr>
<tr>
<td>16951</td>
<td>Oracle - Problems with Rollback segments</td>
<td>Oracle-specific</td>
</tr>
<tr>
<td>94801</td>
<td>Environment variables for Windows NT</td>
<td>Oracle-specific</td>
</tr>
<tr>
<td>493143</td>
<td>Oracle upgrade to 9.2.0: Windows</td>
<td>Oracle-specific</td>
</tr>
</tbody>
</table>
### Optional SAP Notes for Windows

<table>
<thead>
<tr>
<th>SAP Note Number</th>
<th>Topic</th>
<th>SAP Note Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>169468</td>
<td>Windows 2000 support</td>
<td>Windows 2000-specific</td>
</tr>
<tr>
<td>430992</td>
<td>Shadow instance on another host: Windows</td>
<td>Remote operation of shadow instance</td>
</tr>
<tr>
<td>65761</td>
<td>Determining configuration problems under Windows NT</td>
<td>System configuration</td>
</tr>
<tr>
<td>33772</td>
<td>Configuring Dr. Watson Correctly</td>
<td>System administration</td>
</tr>
<tr>
<td>28781</td>
<td>Central transport directory NT/UNIX</td>
<td>Mixed systems</td>
</tr>
<tr>
<td>138498</td>
<td>Single Sign-On Solutions</td>
<td>Single Sign-On</td>
</tr>
<tr>
<td>165485</td>
<td>Server Security under Windows NT</td>
<td>Single Sign-On</td>
</tr>
</tbody>
</table>
4 Product-Specific Information for the SAP BW Upgrade

This part of the documentation describes the information and restrictions specific to an upgrade of the BW System.

This includes, for example BW upgrade-specific directory sizes, database and operating system versions, as well as restrictions on and additions to the general upgrade procedure.

⚠️ The information in the product-specific part takes priority over the information in the general part of the documentation.

💡 This part of the documentation has a similar structure to the General Upgrade Information [page 65] section. The same section headings contain comments, additional information or restrictions on the upgrade. Each product-specific text contains a link to the description of the procedure in the general part of the documentation.

The following parts of the documentation contain additional information:

- [SAP BW: Upgrade Planning [page 37]]
- [SAP BW: Upgrade Preparations [page 46]]
- [SAP BW: The Upgrade [page 54]]
- [SAP BW: Post-Upgrade Activities [page 56]]

General Information About this Release

The following applies when you upgrade an SAP BW System:

- **Source Release**
  
  The lowest source release for upgrading the SAP BW System is 2.0B (Basis Release 4.6C). All sections in the general part of this documentation that apply to Basis Releases lower than 4.6C are not relevant for the upgrade of the SAP BW System.

- **MCOD**
  
  In the source releases for SAP BW, an MCOD configuration is NOT supported. You can therefore ignore all the MCOD-specific parts of this documentation.

### MS SQL Server

- **Archiving mode**
  
  For the SAP BW upgrade, you can select the recovery model **FULL** and the recovery model **BULK LOGGED** for the MS SQL Server database.

End of MS SQL Server
4.1 SAP BW: Upgrade Planning

This section of the documentation gives you BW-specific information on planning the upgrade of your system. The following sections include additional information, or restrictions placed on the general procedures:

- Planning the Upgrade Strategy [page 37]
- Database Backup [page 38]
- Upgrade Schedule Planning [page 38]
- Runtime for the Import of the Substitution Set [page 85]
- Checking the Hardware Requirements [page 39]
- Checking the Source Release of the SAP System [page 40]
- Upgrading the Operating System and Database System: Overview [page 41]

Start planning your upgrade at least two to three weeks before you want to start the upgrade.

When you plan your SAP BW Server upgrade, first read the corresponding section of the Upgrade Master Guide. This will provide you with scenario-specific upgrade information that may be relevant to your SAP BW Server upgrade.

See also
Planning the Upgrade (General Information) [page 66]

4.1.1 Upgrade Strategy Planning

The downtime depends on the selected upgrade strategy and the amount of time required to create the database archives.

In the following table, the minimum requirements for the archives created for the different upgrade strategies, archiving strategies, and databases are specified. These sizes are based on sample data.

The archives can be made larger by importing additional languages, or a large amount of Support Packages or add-ons.

### Comparison of the Archives in GB

<table>
<thead>
<tr>
<th>Database Type</th>
<th>Up to phase MODPROF_TRANS</th>
<th>Up to the end of the upgrade</th>
</tr>
</thead>
<tbody>
<tr>
<td>DB2 UDB for UNIX and Windows</td>
<td>6,0</td>
<td>8,0</td>
</tr>
<tr>
<td>Informix</td>
<td>8,0</td>
<td>10,0</td>
</tr>
<tr>
<td>MS SQL Server</td>
<td>7,0</td>
<td>8,5</td>
</tr>
<tr>
<td>Oracle</td>
<td>9,5</td>
<td>10,5</td>
</tr>
<tr>
<td>MaxDB</td>
<td>5,0</td>
<td>6,0</td>
</tr>
</tbody>
</table>

See also:
Upgrade Strategy Planning (General Information) [page 71]
4.1.2 Database Backup

**MS SQL Server**

For the SAP BW upgrade, you can select the recovery model **FULL** and the recovery model **BULK LOGGED** for the MS SQL Server database.

**End of MS SQL Server**

See also:

*Database Backup (General Information) [page 74]*

4.1.3 Upgrade Schedule Planning

When planning your upgrade schedule, you must consider the following:

- **Upgrade preparations** (see step 1 in the [general description](#) [page 82])
  
  Start your preparations for the upgrade **at the latest** one week before you upgrade your system.

- **Starting the upgrade** (see step 2 in the [general description](#) [page 82])
  
  If you decide to use the upgrade strategy **resource-minimized**, start the upgrade on the last day of production operation of the old release. In the evening of this day you can start the import of the substitution set.

  If you decide to use the upgrade strategy **downtime-minimized**, start the upgrade in good time before the scheduled start of downtime. This ensures that all activities that can be performed during production operation are completed in time.

  **⚠️**

  If you did not enter any mount directories during **PREPARE**, you are prompted at the beginning of some of the **EU IMPORT** phases to change the CD. If you miss this prompt, your time schedule could be seriously disrupted.

  The minimum runtime of the import in the **SHADOW IMPORT ALL** phase increases with every Support Package, add-on, and language that is included. Each language that you import increases the minimum duration of the import by about 30 minutes.

See also:

*Upgrade Schedule Planning (General Information) [page 82]*
4.1.4 Runtime for the Import of the Substitution Set

The import of the substitution set takes about 1.5 to 3 hours, depending on your hardware. Upgrade strategy **downtime-minimized** prompts you to specify a total runtime for the import of the substitution set. Set the time required for the import so that it ends at least 5 hours before the planned shutdown of production operation. Depending on the start time of the upgrade, specify total runtimes of about 10 hours.

See also:
Runtime for the Import of the Substitution Set (General Information) [page 85]

4.1.5 Checking the Hardware Requirements

Checking CPU, Main Memory, and Page Files

For information about the minimum hardware requirements, see SAP Service Marketplace at service.sap.com/platforms.

Space Requirements in the File System

Make sure that you have at least 1 GB of temporary disk space in the file system for the upgrade. You need this free space to create the upgrade directory ([product-specific](product-specific) [page 49] / [general](general) [page 96]).

Space Requirements in the Database

**DB2 UDB for UNIX and Windows**

The database is extended by 17 GB. You can free space after the upgrade by deleting the substitution tablespaces of the source release.

**DB2 UDB for z/OS**

For information about extending the database, see SAP Note 661253. You can free space after the upgrade by removing superfluous database objects with report RSDB2CLN.

**Informix**

The database is extended by at least 18 GB. You can recover the difference between the maximum disk space requirements and the permanent disk space requirements by deleting the old substitution dbspaces.

**MaxDB**

You require 7 GB of space in the database for the upgrade. The space requirements could be higher depending on how much data you have. The difference between the maximum disk space requirements and the permanent disk space requirements is available as free space in the database as soon as the upgrade is complete.
MS SQL Server

The database requires 9 GB of free disk space for the upgrade. During MS SQL Server 2000 runtime, the option *Automatically grow file* is set. This makes the database adjust its size to the requirements during the upgrade if enough disk space is available.

Oracle

You require 17 GB of space in the database for the upgrade. The space requirements could be higher, depending on how much data you have.

You can recover the difference between the minimum disk space requirements and the permanent disk space requirements by deleting the old substitution tablespaces.

End of the database-specific explanations

The `PREPARE` program also gives you information on how much free space is needed in the database.

See also:

*Checking the Hardware Requirements (General Information)* [page 89]

### 4.1.6 Checking the Source Release of the SAP System

Before the upgrade, your SAP system must have one of the following source releases with the necessary Support Package level, which have been released for this upgrade:

<table>
<thead>
<tr>
<th>Source Release</th>
<th>Minimum required Support Package level</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>SAP_BW</td>
</tr>
<tr>
<td>BW 2.0B</td>
<td>SP26</td>
</tr>
<tr>
<td>BW 2.1C</td>
<td>SP18</td>
</tr>
<tr>
<td>BW 3.0B</td>
<td>SP03</td>
</tr>
<tr>
<td>BW 3.1 Content with BI_CONT 3.10 – 3.30, and at least PI_BASIS 2002_2_620.</td>
<td>SP01</td>
</tr>
</tbody>
</table>

For information about which BW release corresponds to which Basis release or SAP Web Application Server Release (SAP Web AS), see *SAP Note 309461*.

See also:

*Checking the Source Release of the SAP System (General Information)* [page 89]
4.1.7 Upgrade of the Operating System and Database System: Overview

Purpose
When you upgrade an SAP system, you may have to update your operating system and database to a new version.

For detailed information on which versions are currently supported, see SAP Service Marketplace at service.sap.com/platforms.

For SAP BW Server 3.5 you require the operating system Windows 2000 or Windows Server 2003 with the current Service Pack.

The sequence of the operating system upgrade and the SAP system upgrade depends on the software that is installed on the server that contains the central instance.

SAP recommends that you install a central instance on one server exclusively. However, there may be cases where additional SAP software components were installed on the server containing the central instance.

Note the following:
- Central instance isolated on one server
  In this case, the operating system upgrade to Windows 2000 occurs before the SAP upgrade.
- Central instance on the same server as other SAP software components
  Check whether all additional SAP software components have been released for Windows 2000.
    - In this case, the operating system upgrade to Windows 2000 occurs before the SAP upgrade.
    - If one of the additional SAP software components has not been released for Windows 2000, then you must perform the upgrade of all SAP components under Windows NT 4.0.
    In this case, the upgrade of the SAP system is supported under Windows NT 4.0. Production operation of the system is possible as specified in the appropriate upgrade strategy. Production operation is also possible until the upgrade of the operating system after the SAP upgrade.

⚠️ We strongly recommend that you upgrade to Windows 2000 as soon as possible after the SAP upgrade.

When using the SAP system under Windows NT 4.0, the following restrictions apply:
- The debugging support for kernel problems was changed for Windows 2000. SAP Support is therefore unable to analyze program terminations that occur, if the SAP system is running under Windows NT 4.0.
- Each time the SAP system is restarted, the user who logs on first in each case receives a SICK message and the session is terminated.

Before upgrading to Windows 2000, always make sure that your hardware is compatible with Windows 2000. Check this by using one of the following resources:
- If you have an installation CD for Windows 2000, open a command prompt and enter the following command:
<CD_D>:\I386\winnt32.exe /checkupgradeonly

The program stores the compatibility status in the file winnt32.loc, which is located in the current Windows directory.

- The hardware has the required SAP hardware certification and is listed under www.addon.de/fcert.
- The hardware is listed in the Microsoft Hardware Compatibility List (www.microsoft.com/hcl) or the hardware is listed on the Web site of the manufacturer as being Windows 2000-compatible.

If you need to upgrade an operating system or database, or migrate a database, then the timing and the sequence of the individual upgrades is of great importance. The procedure differs according to the database you use. We have described the process flows specifically for each database in this section.

**Process Flow**

The upgrade is performed in several steps:

1. **MSCS Cluster**
   In an MSCS cluster configuration, all the steps, except the SAP upgrade and Kernel upgrade, need to be performed on each node of the cluster.

1. Operating system upgrade
2. Database migration or database upgrade
3. **PREPARE**
4. SAP upgrade

You must also perform different steps to prepare for running the **PREPARE** program or the upgrade. For more information, see Upgrade Preparations (SAP BW-specific [page 46] and general [page 94]).

**DB2 UDB for UNIX and Windows**

Proceed as follows:

1. Migrate the database to at least Version 8, FixPak 3 if you have not already done so.
   The migration guide is a PDF document on the data carrier that contains Version 8 of the database.
2. Start **PREPARE** and analyze the results.
3. Upgrade the system with your choice of upgrade strategy. Both strategies (downtime-minimized and resource-minimized) are supported.

**DB2 UDB for z/OS**

Make sure that you meet the following requirements before you start **PREPARE** for the first time:

- Database version: At least DB2 version 8.1.5 (New Function mode).
  Ensure that all DB2 system parameters are set as described in the SAP Database Administration Guide: IBM DB2 UDB for z/OS.
• **Buffer pools**
  Make sure that all required buffer pools (BP40, BP8K0, and BP16K0 in particular) are activated as described in the *SAP Database Administration Guide: IBM DB2 UDB for z/OS*.

• **Stored Procedures:**
  The stored procedures of DB2 (DSNUTIL, DSNACCOR) and DB2 Control Center have to be set up. The prerequisites and preparations are described in the SAP documentation *SAP Database Administration Guide: IBM DB2 UDB for z/OS*.

• **Operating system of the database server:** z/OS Version 1.4 or higher

• **PTFs and APARs:**
  *SAP Note 81737* (APAR list) contains information on the PTFs that you need to import before the upgrade. A PTF check tool is available for all source releases. This tool is described in *SAP Note 183311*. Any missing PTFs can lengthen the runtime of the upgrade significantly.

• **DB2 Connect**
  With SAP Web AS Release 6.40, the database connectivity switches from ICLI-based to DB2 Connect.

  If the source release is **SAP BW 2.1 C or lower**, you need to setup DB2 Connect and perform the following administrative tasks:
  a. Install and start DB2 Connect (FixPak version 6 or higher)
  b. Provide a DB2 Connect user on the database host (preferably without TSO segment and expiration date)
  c. Enable the DB2 Connect Gateway mode
     
     \[\text{db2set DB2CONNECT\_IN\_APP\_PROCESS=NO}\]
  d. Disable DB2 Connect Connection Pooling
     
     \[\text{db2 update dbm cfg using NUM\_POOLAGENTS 0}\]

  For more information, see the documentation *SAP Database Administration Guide: IBM DB2 UDB for z/OS*, section “DB2 Connect Installation and Customization”. There is no need to execute the bind of DB2 Connect or catalog the Remote Database. These steps are automatically performed by the upgrade tools.

  If the source release is **SAP BW 3.0B or higher**, you have to apply the 6.40 downward compatible kernel after migrating to DB2 version 8.1.5. The procedure is described in *SAP Note 731937*.

• **RACF or other security products**
  During the upgrade, a shadow system is created with its own schema name. This name consists of the schema name of the outbound system, and has an "S" appended to it (SAPR3 becomes SAPR3S or SAPPRO becomes SAPPROS, for example). If you use RACF, you therefore have to do the following for this additional schema:
  o Define a secondary authorization ID.
  o Create an RACF group with the same name.
  o Enter the user IDs that communicate with the database (\(<\text{SAPSID}\>\text{ADM or DB2 connect user}\)) as members of this RACF group.

  For more information about the general procedure, see the documentation *Planning Guide: z/OS Configuration for SAP on IBM DB2 UDB for z/OS*. 
If you use a different security product, perform the relevant steps according to the product documentation.

- Required ABAP Dictionary corrections in source release

Make sure that all necessary transports or Basis Support Packages were imported correctly into your system. The transports are listed in one of the following SAP Notes, depending on your source release:

<table>
<thead>
<tr>
<th>Source Release</th>
<th>SAP Note Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>2.0B (Basis 4.6C)</td>
<td>184399</td>
</tr>
<tr>
<td>2.1C (Basis 4.6D)</td>
<td>184399</td>
</tr>
<tr>
<td>3.0B (Web AS 6.20)</td>
<td>407663</td>
</tr>
<tr>
<td>3.1 Content (Web AS 6.20)</td>
<td>407663</td>
</tr>
</tbody>
</table>

- Source Release SAP BW 2.x: You require the latest versions of the executables R3ldctl and R3szchk. Copy them into the \usr\sap\<SAPSID>\SYS\exe\run directory.

When you meet all requirements stated above, proceed as follows:

1. Start PREPARE and analyze the results.
2. Upgrade the SAP system with your choice of upgrade strategy.
   Both strategies (downtime-minimized and resource-minimized) are supported.

**Informix**

For information on which version of the Informix Dynamic Server you need for this release, see SAP Note 647130.

Proceed as follows:

2. Start PREPARE and analyze the results.
3. If you have not already done so, upgrade the database as described in the documentation Installing Version 9.40 of the Informix Dynamic Server: Windows.
4. Upgrade the system with your choice of upgrade strategy. Both strategies (downtime-minimized and resource-minimized) are supported.

**MaxDB**

You require at least Version 7.5.00.

If the database server and the central instance are not identical, install the latest DB client software on the central instance. For information about the procedure, see the documentation Upgrade to MaxDB Version 7.5: Windows on the SAP Service Marketplace at service.sap.com/instguides → Database Upgrades → MaxDB.

Proceed as follows:

1. If you have not already done so, upgrade the database to at least the minimum required version. The procedure, is described in the documentation Upgrade to MaxDB 7.5: Windows.
2. Start PREPARE and analyze the results.
3. If necessary, upgrade the operating system to Windows 2000 or Windows Server 2003.
   Repeat the PREPARE module General checks to run through the CONFCHK phase once
   more and complete the module successfully.

4. Upgrade the system with your choice of upgrade strategy. Both strategies (downtime-
   minimized and resource-minimized) are supported.

**MS SQL Server**

1. Make sure that you meet the following requirements before you start PREPARE for the
   first time:
   
   a. The required database version MS SQL Server 2000 is installed.
      
      **SAP Note 209596** describes the upgrade from MS SQL Server 7.0 to MS SQL
      Server 2000. Also read the supplementary **SAP Note 139945**.
      
      If the source release of your system is released for MS SQL Server 7.0 only,
      then you must upgrade your database to MS SQL Server 2000 before the SAP
      upgrade. For more information, see **SAP Note 399341**.
      
      **SAP Note 417089** describes the procedure for installing the service packs on
      MS SQL Server 2000.
      
      Make sure that you have installed all the required service packs for MS SQL
      Server. For a list of the MS SQL Server service packs required by SAP, see
      **SAP Note 62988**.
      
   b. The set startup parameter –p must not be set. (standard MS SQL 2000 works
      with a maximum precision of 38 characters).

2. Start PREPARE and analyze the results.

3. Upgrade the system with your choice of upgrade strategy. Both strategies (downtime-
   minimized and resource-minimized) are supported.

**Oracle**

You require at least Version 9.2.0. Production operation of the system is supported in the first
half of the upgrade. Proceed as follows:

1. Meet the requirements for starting PREPARE.
   
   o Operating system: Windows 2000, or Windows Server 2003
   o Database: Oracle Version 9.2.0
      
      If you have not already done so, migrate the Oracle database as described in
      the documentation **Migrating/Upgrading to Oracle Version 9.x:Windows** (see
      also the corresponding **SAP Note 493143**).

2. Start PREPARE and analyze the results.

3. Upgrade the system with your choice of upgrade strategy.
   
   Both strategies (downtime-minimized and resource-minimized) are supported.

End of the database-specific explanations

See also:

Upgrading the Operating System and Database System: Overview (General Information)
[page 90]
4.2 SAP BW: Upgrade Preparations

This part of the documentation gives you BW-specific information for preparing your system. The following sections include additional information, or restrictions placed on the general procedures:

- Making the Consistency Check for Web Templates [page 46]
- Checking Inconsistent InfoObjects [page 47]
- Converting Data Classes of InfoCubes [page 46]
- ALPHA Converter [page 48]
- Creating the Upgrade Directory [page 49]
- Making Entries for the Parameter Input Module [page 49]
- Making Entries for the Extension Module [page 51]
- Making Entries for the Installation Module [page 52]
- Converting Inconsistent Characteristic Values with a Conversion Routine [page 53]

See also:
Upgrade Preparations (General Information) [page 94]

4.2.1 Making the Consistency Check for Web Templates

Before you upgrade your BW system, make the consistency check for the BW Web templates as described in SAP Note 484519. This consistency check informs you of inconsistencies in Web objects that already exist in your BW 2.x system. It also ensures that any inconsistencies in the Web objects are removed from your BW system before the upgrade. You can also ensure that only those errors are displayed that were caused by the conversion of Web objects. This makes error analysis easier when you convert the Web objects. The check program is available as of SAP BW 2.0 (SP 21), or SAP BW 2.1 (SP 13). You can execute it in transaction RSRV (select tab page Miscellaneous).

⚠️ Reporting Agent settings for precalculating BW Web templates are not converted. For more information please refer to SAP Note 597050.

4.2.2 Converting Data Classes of InfoCubes

Use

DDART data classes were set up in the customer system, that do not correspond to the naming conventions that are described in SAP Note 46272. These data classes were assigned to InfoCubes in the maintenance transaction RSDCUBE.

These data classes are lost during the upgrade. Only data classes that use the naming convention are saved. This means that the tables that are generated for an InfoCube cannot
be activated correctly. This produces the error message *unknown data class* in the technical settings.

You can use the RSDG_DATCLS_ASSIGN report to solve this problem. This report assigns InfoCubes to other, correct data classes. This report enables you to convert groups of InfoCubes from an old (invalid) data class into new data classes.

The report must run **before** the upgrade.

**Procedure**

1. Set up a new data class as described in **SAP Note 46272**. Pay attention to the naming convention.
2. Execute the RSDG_DATCLS_ASSIGN report.

**Result**

All processed InfoCubes that were previously assigned to the invalid data class are now assigned to the new data class, including their metadata and the generated database tables. Problems connected with data classes no longer occur during the upgrade.

4.2.3 Checking Inconsistent InfoObjects

**Use**

Before the **PREPARE** run, you have to check the InfoObjects and repair them if necessary.

**Procedure**

1. Log on to the SAP system.
2. Call transaction RSD1.
3. Choose **Extras → Repair InfoObjects** (F8).
4. Choose **Execute Repair**.
5. Choose **Expert Mode → Select Objects**.
6. On the following screen, activate the checkboxes **Check Generated Objects**, **Activate Inconsistent InfoObjects**, **Delete DDIC Objects**, and **Display Log**.
7. Execute the program.

The program repairs the inconsistent InfoObjects as far as possible. After the InfoObjects have been repaired, check them again, and manually correct any remaining inconsistencies.
4.2.4 ALPHA Converter

Use

In the tool import during PREPARE, the conversion of the inconsistent characteristic values causes the following problems (see also the previous section Converting Inconsistent Characteristic Values with a Conversion Routine). These problems are also described in SAP Note 447341.

- The version of the conversion program corresponds to BW 2.0B Support Package 19 (or BW 2.1C Support Package 11). The program still contains errors, which means that the conversion cannot be performed with this code version.
- Parts of the code are not compatible with Support Package level 22 or higher for Release BW 2.0B, or 14 or higher for Release BW 2.1C. This means that no queries can be executed for these Support Package levels until the upgrade has been completed (or until a solution has been applied as described in SAP Note 537462).
- During the tool import, the conversion status of the system is lost. This means that in the General Checks phase of PREPARE, an error message that prompts you to convert the characteristic values by using transaction RSMDCNVEXIT still occurs even if the conversion has already been performed successfully.

Prerequisites

The source release of your SAP BW system is 2.0B, 2.1C or 3.0B. You do not have to perform this activity when your system is already on a higher release.

Procedure

1. Directly before you start PREPARE, create a transport request for copies of the objects in the RSMD_ALPHA piece list.
   Proceed as follows:
   - Call transaction SE09.
   - Choose Transport Copies.
   - Choose Include Objects.
   - For the Object List of Request, select RSMD_ALPHA.
   - Release the request that you created.
2. Execute PREPARE up to and including the tool import. Stop here.
3. Use UMODE 1 and 2 to import the transport of copies.
   You can ignore the following error message, which appears during generation:
   
   Program CL_RSMD_SEM===================CP,
   Include CL_RSMD_SEM===================CI: Syntax error row 000024
   The implementation of the RENAME_IOBJ method is missing.

   Subsequently, the errors mentioned above do not occur when queries are executed. This means that you can use your system again, or complete PREPARE. When the conversion status is checked in the General Checks phase of PREPARE, the program recognizes that your system has been converted. If no other errors were found, you can start the actual upgrade. If you have to repeat the tool import, start at point 3.
4.2.5 Creating the Upgrade Directory

Note the following when you create the upgrade directory:

- The disk space required by the upgrade directory is distributed among several subdirectories. The following table shows the sizes of these subdirectories. The sizes may vary by up to 25%, depending on your database and source release.

If you can access all data carriers simultaneously (because you can enter mount directories), you require much less free space in the exchange subdirectory of the upgrade directory.

<table>
<thead>
<tr>
<th>data</th>
<th>exe</th>
<th>log</th>
<th>Remaining</th>
<th>Total</th>
</tr>
</thead>
<tbody>
<tr>
<td>300 MB</td>
<td>300 MB</td>
<td>200 MB</td>
<td>200 MB</td>
<td>1 GB</td>
</tr>
</tbody>
</table>

- You also require an additional 120 MB in the upgrade directory for each language other than English or German.

See also:
Creating the Upgrade Directory (General Information) [page 96]

4.2.6 Making Entries for the Parameter Input Module

When you make entries for the Parameter Input module, you will be prompted to enter mount directories for all the data carriers required during the upgrade. As of Release 3.50, the data formerly contained on several CDs is now grouped on DVDs to reduce the amount of data carriers. In the following, you will find tables that explain on which DVD you can find the contents of the former CD.

The numbers in the DVD directory names indicate the following:
- For the Upgrade Master (UM<x>): Each number represents a different set of operating systems.
- For the ABAP kernel (K<x>): Each number represents a different set of operating systems.
- For the ABAP upgrade data (UPG<x>): The number corresponds to the former CDs. You need the data of all subdirectories.
- For the ABAP language data (LANG<x>): Each number represents a different set of languages.
## CDs Required by PREPARE

<table>
<thead>
<tr>
<th>CD Title</th>
<th>DVD Title</th>
<th>Directory on DVD</th>
<th>Contents</th>
</tr>
</thead>
<tbody>
<tr>
<td>Upgrade Master CD</td>
<td></td>
<td>UM&lt;x&gt;</td>
<td>Upgrade tools</td>
</tr>
<tr>
<td>SAP NetWeaver ´04 Upgrade Master / &lt;database&gt;</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>SAP NetWeaver ´04 Upgrade Master UNICODE / &lt;database&gt;</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>SAP Kernel</td>
<td></td>
<td>K&lt;x&gt;</td>
<td>Programs and configuration files for the upgrade</td>
</tr>
<tr>
<td>SAP NetWeaver ´04 SAP Kernel / &lt;database&gt;</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>SAP NetWeaver ´04 SAP Kernel UNICODE / &lt;database&gt;</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Upgrade Data CD1</td>
<td>SAP NetWeaver ´04 * Upgrade Export * Languages</td>
<td>UPG1</td>
<td>Transport requests imported during the upgrade</td>
</tr>
<tr>
<td>Language Disc</td>
<td>SAP NetWeaver ´04 * Upgrade Export * Languages</td>
<td>LANG1</td>
<td>Standard languages English and German</td>
</tr>
</tbody>
</table>

## CDs Required by R3up

<table>
<thead>
<tr>
<th>CD Title</th>
<th>DVD Title</th>
<th>Directory on DVD</th>
<th>Contents</th>
</tr>
</thead>
<tbody>
<tr>
<td>Upgrade CD1</td>
<td>SAP NetWeaver ´04 * Upgrade Export * Languages</td>
<td>UPG1</td>
<td>Transport requests imported during the upgrade</td>
</tr>
<tr>
<td>Upgrade CD2</td>
<td>SAP NetWeaver ´04 * Upgrade Export * Languages</td>
<td>UPG2</td>
<td>Transport requests imported during the upgrade</td>
</tr>
<tr>
<td>Upgrade CD3</td>
<td>SAP NetWeaver ´04 * Upgrade Export * Languages</td>
<td>UPG3</td>
<td>Transport requests imported during the upgrade</td>
</tr>
<tr>
<td>Language Disc</td>
<td>SAP NetWeaver ´04 * Upgrade Export * Languages</td>
<td>LANG1</td>
<td>Standard languages English and German</td>
</tr>
</tbody>
</table>
Optional CDs for the Upgrade

<table>
<thead>
<tr>
<th>CD Title</th>
<th>DVD Title</th>
<th>Directory on DVD</th>
<th>Contents</th>
</tr>
</thead>
<tbody>
<tr>
<td>Language Disc(s) for the languages you want to install</td>
<td>SAP NetWeaver '04 * Upgrade Export * Languages</td>
<td>LANG&lt;x&gt;</td>
<td>Languages other than English and German For the exact contents, see the README file on the DVD.</td>
</tr>
<tr>
<td>Installation &lt;Add-On&gt;</td>
<td>---</td>
<td>---</td>
<td>Add-ons</td>
</tr>
<tr>
<td>Upgrade &lt;Add-On&gt;</td>
<td>---</td>
<td>---</td>
<td>Add-ons</td>
</tr>
<tr>
<td>Presentation</td>
<td>SAP NetWeaver '04 * Presentation * Server Components * Content Server</td>
<td>PRES_&lt;compilation&gt;</td>
<td>SAP GUI</td>
</tr>
</tbody>
</table>

See also:
Making Entries for the Parameter Input Module (General Information) [page 107]

4.2.7 Making Entries for the Extension Module

Phase IS_SELECT
In phase IS_SELECT you are prompted to update the Add-On BI_CONT. This prompt also appears if the Add-On is not installed in your system, which is the case if your source release is 3.0B or lower. You must choose to update BI_CONT during the upgrade. The Add-On is mandatory and will be installed in your system. The CD which contains the SAINT package is included in the upgrade package. For more information, see SAP Note 634214.

See also:
Making Entries for the Extension Module (General Information) [page 114]
4.2.8 Making Entries for the Installation Module

When you make entries for the Installation module, you must consider the following:

**Phase SHDINST_SDB_CHK**

PREPARE makes database-specific checks in this phase.

**MaxDB**

PREPARE checks the MaxDB database parameters. If the parameters do not match the specified values, the upgrade might terminate due to insufficient database resources.

The database parameter `MAXLOCKS` must be greater than 350000. So that the shadow system can log on to the database, the MaxDB database parameter `MAXUSERTASKS` must be set so that another 15 database users can log on. PREPARE informs you of the minimum additional USERTASKS.

If at least one of your application servers was stopped when the check was made, you must include the number of stopped `disp+work` processes when you set the `MAXUSERTASKS` parameter.

⚠️ Changes made to the MaxDB database parameter are only activated after the database has been stopped and restarted.

PREPARE also checks if there are bad indexes in the database. You can reactivate (recreate) the relevant indexes using the Database Manager GUI:

1. To display the bad indexes, choose Recovery → Index → Select.
   
   In SQL Studio, you can determine this information as follows: select * from info_bad_indexes.

2. In the index display of the Database Manager GUI, select the relevant indexes.
   
   You can use the button Select all.

3. Choose Recreate.

💡 You should create the indexes at times of minimal system workloads.

See also:

Making Entries for the Installation Module (General Information) [page 124]
4.2.9 Converting Inconsistent Characteristic Values with a Conversion Routine

Many customers have inconsistent data for characteristics with the ALPHA, NUMCV, and GJAHR conversion routines.

You must solve this problem by using transaction RSMDCNVEXIT before the upgrade.

**Calling Transaction RSMDCNVEXIT**

⚠️ When you call the transaction, you have to decide for each inconsistent characteristic whether to convert the data, or whether to remove the conversion routine. System administrators cannot make this decision alone. SAP recommends that you ask BW users so that you can decide on one of the alternatives. A wrong decision could cause multiple characteristic values to be grouped together although they describe different objects. This could cause production operation to no longer run smoothly.

For a detailed description of transaction RSMDCNVEXIT, see the help documentation (click the Help button once you have called the transaction), or SAP Note 447341.

**Timeframe for the Conversion**

If you have already imported Support Package 26 (2.0B), 18 (2.1C), 10 (3.0A), or 3 (BW 3.0B), you can freely determine when to call the transaction (on a weekend before the upgrade, for example). This enables you to execute time-consuming programs at a more convenient time.

If your system has a lower Support Package level, read SAP Note 447341.
4.3 SAP BW: The Upgrade

This part of the documentation gives you BW-specific information on upgrading your system. The following sections include additional information, or restrictions placed on the general procedures:

- Phase LOCKEU_PRE [page 54]
- EU_IMPORT Phases [page 54]
- Phase REPACHK2 [page 55]

See also:
The Upgrade (General Information) [page 138]

4.3.1 Phase LOCKEU_PRE

In this phase you must also note the following:

Activities

If you decided to use upgrade strategy *downtime-minimized*, you must lock the Administrator Workbench. Use transaction SE01 to do this.

See also:
Phase LOCKEU_PRE (General Information) [page 151]

4.3.2 EU_IMPORT Phases

The following table contains a list of the import phases and how much of the total import duration they take up (percentage):

The differences in percentage of the total import duration depend on the database and hardware configuration.

### Duration of the Individual Phases (Percentage)

<table>
<thead>
<tr>
<th>Phase</th>
<th>Duration (percentage)</th>
</tr>
</thead>
<tbody>
<tr>
<td>EU_IMPORT1</td>
<td>1 - 5</td>
</tr>
<tr>
<td>EU_IMPORT2</td>
<td>1 - 5</td>
</tr>
<tr>
<td>EU_IMPORT3</td>
<td>10 - 20</td>
</tr>
<tr>
<td>EU_IMPORT4</td>
<td>10 - 20</td>
</tr>
<tr>
<td>EU_IMPORT5</td>
<td>60 - 70</td>
</tr>
</tbody>
</table>

You can use these percentages together with your chosen total duration to estimate when you next need to enter the mount directory.

See also:
EU_IMPORT Phases (General Information) [page 152]
4.3.3 Phase REPACHK2

When you execute the REPACHK2 phase, you must also note the following:

**Activities**

- **Upgrade strategy **downtime-minimized**: If you did not lock the Administrator Workbench in the LOCKEU_PRE phase, do this now. You cannot continue working in the Administrator Workbench.

> After you have locked the Administrator Workbench, no more transports can be made into or out of the SAP System.

See also:

*Phase REPACHK2 – General Information [page 153]*
4.4 SAP BW: Post-Upgrade Activities

This part of the documentation gives you BW-specific information about activities you need to perform after you have upgraded your system. The following section includes additional information, or restrictions placed on the general procedures:

Actions Needed Before Resuming Production Operation

- Activating the Internet Communication Manager [page 56]
- Converting the Web Objects from SAP BW 2.x to 3.x [page 57]
- Converting Chart Settings [page 61]
- Switching Over to New Standard Template for Ad Hoc Analysis [page 63]
- MS SQL Server: Specific Actions [page 63]
- Installing the J2EE Engine [page 63]
- Performing Post-Upgrade Activities for the Applications [page 64]

Actions During Productive Operation

- Importing Support Packages After the Upgrade [page 64]
- SAP Retail: Converting Terminology [page 64]

See also:
- Post-Upgrade Activities (General Information) [page 159]

4.4.1 Activating the Internet Communication Manager (ICM)

Use

SAP recommends that you activate the ICM so that you can use all the functions of the Web Application Designer.

Procedure

To activate the ICM do the following:

1. Set up the ICM Server Cache.
2. Customize the ICM.

Example of settings for the ICM in the profile <SAPSID>:

```
icm/server_port_0 = PROT=HTTP, PORT=1080
icm/server_port_1= PROT=HTTPS, PORT=1443
icm/HTTP/server_cache 0 = PREFIX=/,
CACHEDIR=${DIRDATA}/cache
```

For information about customizing the ICM, see the documentation *How to customize BW 3.0 after an Upgrade from 2.0B/2.1C* in the SAP Service Marketplace under...
4 Product-Specific Information for the SAP BW Upgrade

service.sap.com/BW → Services & Implementation → HOW TO … Guides → Guide List BW 30. The guide also applies to upgrades to BW 3.5.

For information about the procedure, choose Help → SAP NetWeaver Library → SAP NetWeaver → Application Platform (SAP Web Application Server) → Architecture of SAP Web AS → Internet Communication Manager → Parameterization of the ICM and the ICM Server Cache.

3. Perform these actions on all the application servers that you use for Web Reporting.

4.4.2 Converting the Web Objects from SAP BW 2.x to 3.x

Use

If you want to use the BEx Web in SAP BW 3.x, you have to convert the Web objects (Web templates, query views, Web items, and Web reports (URLs)) immediately after the upgrade.

The Web objects that are delivered for SAP BW 3.x with the BW Business Content are already delivered in the new structures. The new Business Content objects (Web templates, Web items, and query views) are installed during the normal content installation. In your system, only the active versions (A versions) of the content objects are converted.

⚠️ Even if you only want to work with workbooks of the BEx Analyzer in BW 3.x and do not want to use BEx Web Reporting, you still have to perform this conversion if you are using query views in your workbooks.

Prerequisites

- You have made the consistency check for the BW Web templates [page 46] in your BW 2.x system before you upgraded your BW system.
- Your source release is BW 2.x. For source releases higher than BW 2.x, this conversion is not required.
- You have installed the Internet Graphics Service (IGS) Version 6.20C2 or higher.

⚠️ Before you start the conversion, we recommend that you upgrade to the standalone version IGS 6.40 for Win32 platform including the Chart Migrator. This standalone IGS version is required for the conversion of the chart settings [page 61]. For more information, see Converting Chart Settings [page 61].

- You have activated the Internet Communication Manager [page 56].
- You have activated the services in the Internet Communication Framework (ICM) as described in SAP Note 517484.
- You have made sure that no users are currently working in the system who are creating new workbooks for the BEx Analyzer. These new objects would also be converted, which could lead to problems.
4 Product-Specific Information for the SAP BW Upgrade

Procedure
The conversion is performed by two ABAP programs:

- **RSZW_WEBOBJECTS_30_UPGRADE program**
  This program performs the actual conversion, which consists of three steps:
  - Conversion of Web objects that were directly linked to a workbook in SAP BW 2.x (Web templates, Web items, and query views). These objects are migrated into a new server buffer.
  - Conversion of SAP BW-specific HTML parts of the BEx Web reports and Web templates and adjustment to the new buffer and the new attributes.
  - Adjustment of the BEx Web reports that are saved in the roles and the favorites.
    All the URLs that are in the user favorites or in roles are converted. The URLs of the iViews (formerly known as MiniApps) are also converted.
    URLs that link to ITS-based Web templates or that explicitly contain the Web server or application server in the URL are not converted.

- **RSZW_OLD_BDS_ENTRIES_DELETE program**
  After objects have been converted successfully, you can use this program to delete the Web objects (Web templates, query views, and Web items) in the old storage structures.

⚠️ Perform this step only when you are sure that the conversion has been completed successfully.

We recommend that when you perform the conversion for the first time, do so completely and then repeat any steps, if necessary.

Proced as follows:

1. If you want to record the conversion in a transport request, make sure that the standard transport request for BEx objects is set up correctly in the Administrator Workbench.
   You can record the results of the conversion directly in the Change and Transport System (CTS). This triggers the generation of object directory entries in the same way as for other Business Explorer objects. It is then possible to transport the results of the conversion into another SAP BW system.

2. If you want to replace the ITS with SAP Web Application Server, include your stylesheets in the conversion. To do this, you must store the stylesheets that were previously stored on SAP ITS in the MIME Repository on the BW server now. For more information, see SAP Note 484390. During the conversion of the SAP BW-specific HTML parts of BEx Web reports and Web templates you have the option of including your MIME references in the HTML templates of the conversion.

   /sap/its/mimes/webrfc/bw/Stylesheets/myCSS.css becomes Mime/Customer/Stylesheets/myCSS.css, since you have now stored your customer-specific stylesheets in the MIME Repository of SAP Web Application Server under SAP-PUBLIC-BW-Customer-StyleSheets.
   /sap/its/mimes/webrfc/bw/Images/myImage.gif becomes Mime/Customer/Images/myImage.gif, since you have now stored your
4 Product-Specific Information for the SAP BW Upgrade

If you store your stylesheets or graphics in the named directories on SAP Web Application Server, this ensures that they are integrated into the BEx 3.x Web Application Designer. For more information, see SAP Note 484390.

The stylesheets that are delivered with SAP BW Release 2.x are converted automatically.

3. Execute the RSZW_WEBOBJECTS_30_UPGRADE program.

After each step, the results of the conversion are displayed in a log. You can interrupt the conversion after each step to make any necessary corrections. You can then restart the conversion at any stage. However, do this only if you are sure that the previous steps have been performed successfully.

4. Convert the Web objects that are linked to workbooks (Web templates, Web items, and query views).

5. Analyze the log file and correct any errors. If errors occur during the first conversion step, you are informed about the alternatives, since the next step can only be performed after all the workbooks have been converted successfully.

The application log is saved and can be analyzed at any time using transaction SLG1. Choose Application Log → Logs. For the object, select RSWWW, for the subobject select UPGRADE_30, and for the external identifier select UPGRADE_ALL_WORKBOOKS.

Inconsistent Web templates, Web items, or query views in the workbooks that contain errors, and that also contained errors for SAP BW Release 2.x, are the probable cause of any errors.

You can either delete these Web objects, or force the conversion of the workbooks.

   o To delete Web objects:

      i. Make sure that you no longer need the Web templates, Web items, and query views that contain errors.

      ii. Choose the workbooks that contain the Web templates, Web items, and query views that you want to delete completely.

      iii. Delete the Web templates, Web items, and query views that contain errors.

When you delete query views that contain errors, this can cause errors in the workbooks that use these query views as targets.

   o If you want to force a conversion, do so only for workbooks that contain no Web templates, Web items, or query views, or ones that you no longer need.

6. Start the conversion of the SAP BW-specific HTML parts of the BEx Web reports and Web templates. Specify whether you want to include the MIME references in the HTML template to convert the stylesheets. This is required if you want to use SAP Web Application Server instead of SAP ITS (see above).

7. Analyze the log and correct any errors.

The application log is saved and can be analyzed at any time using transaction SLG1. Choose Application Log → Logs. For the object, select RSWWW, for the subobject select UPGRADE_30, and for the external identifier select CONVERT_ALL_TEMPLATES.
Check whether the conversion of any Web templates failed and process them manually, if necessary.

To process them manually, proceed as follows:

a. Choose the new technical name of the Web template. This name is behind the old name of the Web template in the messages in the application log.

b. Call the program RS_TEMPLATE_MAINTAIN.

c. Enter the new technical Web template name in the entry field of the program.

d. Choose Execute.

e. You now see the HTML format of the Web template.

f. Choose Change.

g. Correct the Web template and save it.

⚠️ The sole purpose of the RS_TEMPLATE_MAINTAIN program is to correct and save a Web template during conversion. This program will not be developed further and does not contain complete functions.

After you have made the corrections to BW-specific HTML parts, you can continue the conversion.

8. Adjust the BEx Web reports that are saved in the roles and the favorites.

9. Analyze the log and correct any errors.

   After this step the application log contains an overview of the completed conversions. The application log is saved and can be analyzed at any time using transaction SLG1. Choose Application Log → Logs. For the object, select RSWWW, for the subobject select UPGRADE_30, and for the external identifier select CONVERT_ALL_URLS.

10. Make sure that you are satisfied with the conversion of the Web templates, the Web items, the query views, and the URLs (BEx Web reports).

11. Execute the program RSZW_OLD_BDS_ENTRIES_DELETE to delete the old Web templates, Web items, and query views that are attached to the workbook from the Business Document Service (BDS). They cannot be processed with the BW 3.x Business Explorer and are therefore no longer important.

⚠️ Once you have deleted the entries, you cannot perform the conversion again. Therefore make sure that you are satisfied with the conversion before you delete them.
4.4.3 Converting Chart Settings

Use
The conversion of chart settings is required if you used charts in BW Web applications in your source release. All chart settings of your systems are converted:
- Chart settings of chart items that are stored in a library for reuse purposes
- Local chart settings of BW Web applications
- Chart settings that are saved as bookmarks

Prerequisites
- You have used charts in BW Web applications in your source release.
- If your source release is BW 2.x, you must have completed the conversion of the Web objects [page 57] successfully.

⚠️ The conversion of the chart settings is based on the successful conversion of the Web objects. If you start the conversion of the chart settings although the Web objects conversion were not converted successfully you can no longer repeat the Web objects conversion; you would have to correct all open problems manually.

Procedure
1. Install SAP IGS 6.40 for Win32 platform.
   a. Uninstall your old IGS.
      To uninstall the IGS, choose Start → Settings → Control Panel → Add/Remove Programs.
   b. Install the latest IGS 6.40 included on the Server Components CD as described in the documentation Installation Guide – SAP Internet Graphics Service 6.40. This documentation is also included on the DVD SAP NetWeaver ´04 Presentation/Server Components/ Content Server (igsinst.pdf). Make sure that you choose the BW 3.5 option when you install the IGS.
2. To record the conversion in a transport request, make sure that the standard transport request for BEx objects is configured correctly in the Administrator Workbench.
3. To start the conversion of chart settings, execute the program RSZW_CHART_MIGRATION_35.
   If you start the conversion for the first time, perform a complete conversion of the chart settings.
4. Analyze the log file that is displayed. It contains information about which conversions have been successful and which failed.
   You can access this log file at any time using transaction SLG1. Choose Application Log → Logs and choose the following:
   - Object: RSWWW
   - Subobject: UPGRADE_35
   - External Identifier: CONVERT_ALL_CHART_SETTINGS
5. Depending on the results, proceed as follows:
4 Product-Specific Information for the SAP BW Upgrade

- If all traffic light icons are green, the conversion has been completed successfully. You can start using your BW 3.5 system.
- If there are some yellow traffic lights, then the new SAP IGS release contains some changes and extensions that could not be converted automatically. You must then edit the chart settings manually by using the Chart Designer in the BEx Web Application Designer.
- If there are red traffic lights, then a technical conversion error occurred in SAP IGS. Execute RSZW_CHART_MIGRATION_35 again and repeat the conversion of the chart settings for which a red light is displayed.

You do not have to repeat the whole conversion.

If the errors still occur, create an error message in SAPNet R/3 Frontend and assign it to component BW-BEX-ET-WEB-GRAPH.

6. Regarding the IGS, you have two options:

- You can keep your current IGS installation on the separate Windows host.
- You can uninstall the Windows IGS and install one IGS on every SAP Web Application Server. The IGS as well as the corresponding documentation is included on the SAP IGS product DVD SAP NetWeaver '04 – SAP Web AS Java/SAP NetWeaver Developer Studio/Adobe/IGS in subdirectory DOCU (igsupgr.pdf).

The IGS on the application servers provide the following advantages:

- All SAP Web Application Server platforms are supported
- Better load balancing due to one IGS for each application server
- Integrated start/stop abilities due to
  - Integration in startsap/stopsap scripts on Unix platforms
  - Integration in SAP MMC on Windows platforms

You have to install and update the new IGS on every application server manually using SAPinst.
4.4.4 Switching Over to New Standard Template for Ad-Hoc Analysis

Use
As of SAP BW 3.5 a new standard template is used for the ad hoc analysis. You can switch over to this new standard template by performing report RSZW_CONVERT_RSADMINC_35 or by changing customizing settings.

If you have specified a customer-specific standard template, this is not changed by the report RSZW_CONVERT_RSADMINC_35.

Procedure
To switch over to the new standard template, perform one of the following:

- Call transaction SE38 and run report RSZW_CONVERT_RSADMINC_35.
- Change the customizing settings for Standard Web Templates - Ad Hoc Analysis manually:
  a. Call transaction SPRO.

4.4.5 MS SQL Server: Specific Actions
In addition to the actions that are described in the general section, you also have to activate the logging mode again. Activate the recovery model Full. You can also choose to activate the recovery model Bulk Logged.

See also:
MS SQL Server: Specific Actions (General Information) [page 167]

4.4.6 Installing the J2EE Engine
The J2EE Engine installation is optional for SAP BW 3.5 if you have not previously installed J2EE Engine 6.20 or 6.30 on your BW 3.x system.
The following SAP BW 3.5 business scenarios require the J2EE Engine 6.40:

- Universal Data Connect (UDC) (part of UDI)
- BI Java SDK (part of UDI)
- BI Meta-Model Repository
- Web Services testing functionality

See also:
Installing the J2EE Engine (General Information) [page 172]
4.4.7 Performing Post-Upgrade Activities for the Applications

Adjusting Customizing Settings

Use the following paths to adjust the Customizing settings of your SAP BW system:

Basis Tools → Accelerated SAP → Customizing → Project Administration
Basis Tools → Accelerated SAP → Customizing → Project Processing

See also:
Performing Post-Upgrade Activities for the Application (General) [page 175]

4.4.8 Importing Support Packages After the Upgrade

⚠️ If you want to import Support Packages, read SAP Note 659000, which gives you information on the dependencies between Support Packages for the components SAP_BW, SAP_BASIS, and SAP_ABA.

See also:
Importing Support Packages After the Upgrade (General Information) [page 190]

4.4.9 SAP Retail: Converting Terminology

Prerequisites
You use SAP BW as part of the mySAP Retail solution.

Procedure
If you want to convert the user interface of your BW system to retail-specific terms, proceed as described in the documentation about retail content. You can find this documentation in the SAP Help Portal at help.sap.com → SAP NetWeaver → SAP Business Information Warehouse → BI Content → Industry Solutions → Retail → Retail Terminology.

Convert the short texts only after you have imported Support Packages [page 190], otherwise new texts overwrite texts that have already been converted.
5 General Upgrade Information

This part of the documentation does not contain all the information you need to upgrade your specific SAP product. You must also read the Product-Specific Information part. This part contains additional product-specific upgrade information under the same headings. The two parts are integrated in Upgrade – Step by Step. This checklist contains links to both the general descriptions of upgrade procedures, and to any additional product-specific information.

The following four parts of the documentation describe the accepted procedure for upgrading your SAP system:

- Upgrade Planning [page 66]
- Upgrade Preparations [page 94]
- The Upgrade [page 138]
- Post-Upgrade Activities [page 159]

In this documentation, the release names such as Release 3.x, Release 4.x, or Release 6.x refer to the Basis release or the SAP Web AS release of the SAP system. The releases in the product-specific part of this documentation refer to the product, if not stated otherwise.
5 General Upgrade Information

5.1 Upgrade Planning

General Information

This part of the documentation contains general information on planning your upgrade.

For any additional information, see the product-specific part of this documentation.

Before you begin the actual upgrade, you must first plan it carefully. This includes requesting all the SAP Notes you need. Careful planning is a prerequisite for a successful SAP system upgrade.

The following information helps you plan your upgrade so that downtime is reduced to a minimum, and the upgrade runs as efficiently as possible.

TeamSAP offers the free upgrade service SAP GoingLive Functional Upgrade Check. A team of experts checks the parameter settings of your system in one session before the upgrade, and gives you detailed recommendations on the configuration. After the upgrade, the parameters and the entire system status are checked again in a second session. For information on services, see SAP Service Marketplace at service.sap.com → Support → SAP Solution Management → Support Services → Safeguarding → SAP GoingLive Functional Upgrade Check. SAP Support is your contact for ordering this service.

When you plan your upgrade, note the following information in addition to the information in Upgrade – Step by Step:

- All the times specified in this documentation are based on hardware with medium performance levels.
- Do not perform any additional actions during the upgrade that could cause it to run less smoothly.
- Start planning your upgrade in good time.
- To make sure that all requirements are met, run the PREPARE [page 230] program as soon as possible. You can reset and repeat the program as often as you need before you start the actual upgrade. The successful execution of PREPARE is a prerequisite for starting the upgrade.
- If you are upgrading a modified system where changes have been made to the standard system, you must start by upgrading a development or quality assurance system that has the same SAP system release (including Support Package level), and contains the same modifications. The adjustments you perform manually for the new standard in this system can be automatically exported to the global transport directory and are integrated into the production system upgrade from there. This procedure eliminates the need for time-consuming adjustments to the production system.
- If it is technically possible, or unless otherwise specified, we recommend that you upgrade the operating and database system and your SAP system at different times.
- Before you start the upgrade, check the upgrade strategy of the add-on producer of the add-ons that exist for your source release. You must do this to make sure that the installed add-ons are compatible with your upgrade.
Actions

The following sections are important for planning the upgrade:

- Time Frame for Upgrading the Front-End Software [page 68]
- System Switch Upgrade [page 68]
- Upgrade Strategy Planning [page 71]
- Database Backup [page 74]
- Database-Specific Aspects [page 75]
- Upgrades in an MCOD System Landscape [page 78]
- Data Management Planning [page 79]
- Incremental Table Conversion [page 80]
- Upgrade Schedule Planning [page 82]
- Runtime for the Import of the Substitution Set [page 85]
- Upgrade in an SAP System Group [page 85]
- Modification Adjustment Planning [page 86]
- Checking the Structural Requirements [page 88]
- Checking the Hardware Requirements [page 89]
- Checking the Software Requirements [page 89]
  - Checking the Source Release of the SAP System [page 89]
  - Meeting the Requirements for the Upgrade Assistant [page 90]
  - Upgrading the Operating System and Database System: Overview [page 90]
- Accessing Documentation Before and During the Upgrade [page 91]
- Meeting the Requirements for the SAP Internet Solution [page 91]
- Importing Additional Languages [page 93]
5.1.1 Time Frame for Upgrading the Front-End Software

The new SAP release cannot run until the new version of the front-end software (SAP GUI) has been installed. You can import the front-end software as soon as you receive the software package. The latest possible time for the upgrade is before you start the shadow system for the first time in the `START_SHDI_FIRST` phase. This graphic shows the time period during which you can upgrade the front-end software:

The front-end software is upgraded directly from a data carrier or from a file server. For more information, see the SAP Front End Installation Guide.

5.1.2 System Switch Upgrade

Procedure

Systems are upgraded to SAP Web Application Server 6.10 and higher with the new System Switch Upgrade procedure. This procedure installs an instance of the target release, the shadow system, in parallel with the current source release system in the same database. This parallel system contains all the software of the target release and is used to integrate Support Packages that are included in the upgrade, add-ons, and customer modifications into the target release.

In the production database, the tables of the target release that contain both the descriptions of the ABAP Dictionary and the ABAP programs are imported as shadow tables under an alternative name. The shadow system enables you to access these tables. If you choose
upgrade strategy *downtime-minimized*, you can perform upgrade actions before downtime starts, which previously had to be performed during downtime.

During the **EU_SWITCH** phase in downtime, the switch is made to the new system, and any remaining data is imported. Any parts of the source release system that are no longer needed are deleted.

**Process Flow of a System Switch Upgrade**

**Characteristics of the Procedure**

- **Planning the Upgrade**
  
  No precise guidelines can be given for the duration of an upgrade. The duration of the individual actions depends to a great extent on the individual system, the number of modifications, and the number of included Support Packages and add-ons.

- **Increased space and resource requirements**
  
  Operating two instances in parallel places increased demands on free space in the file system, in the database, and, according to the upgrade strategy, on the system resources. If necessary, some parameters in the production system might need to be adjusted to enable you to operate the production and the shadow systems in parallel.

- **Extended free space check**
  
  The **PREPARE** program also checks the free space needed for tables created in the shadow system.
Creating the shadow system

The PREPARE program has a new Installation module, which is used to prepare for the shadow instance. PREPARE first creates profiles, directories, programs and files needed by the shadow instance, as well as an extra database user. All tables of the SAP Web Application Server are needed as shadow tables to operate the shadow system. As well as all substitution tables already imported, and the newly created tables, the R3up program also creates all remaining SAP Web Application Server tables and fills them.

When all the required tables are in the shadow system, aliases, synonyms or views are created for them. Additional table contents are copied into the shadow system to enable adjustment, activation and distribution functions in the shadow system.

Operating the shadow system

You can now use the shadow system to perform the modification adjustment of the ABAP Dictionary objects and activate and distribute the requests included in the upgrade. After you have operated the shadow system, you have a consistent inactive nametab with the descriptions of the table structures of the target release, including Support Packages and add-ons.

While it is running, the shadow system writes to a number of tables whose contents are required for the remainder of the upgrade, and for operating the system afterwards. These tables are renamed with their original names in the EU SWITCH phase.

Table conversion

All tables of the SAP Web Application Server whose contents need to be copied from the shadow system can be adjusted to the target release structure in the shadow system during production operation. Even the tables into which control data is imported already exist in the shadow system and only need to be renamed. The tables that need to be converted are those for which the original versions of the SAP Web Application Server will continue to be used. These tables can be converted during production operation by being copied to the shadow system, or converted externally.

External conversion no longer needs the ABAP conversion program of the source release, which means that the activation and conversion of the SAP Web Application Server only uses target release tools. This removes the restrictions of the previous procedure, such as no modifications to the SAP Web Application Server in Support Packages and add-ons.

As before, the application tables are converted during downtime in the PARCONV_UPG phase. They can be distributed during production operation. If you use the ICNV, the tables are converted during production operation.

After operating the shadow system

Any tables that receive entries are created as copies with new formats in the shadow system. The upgrade then performs the shadow import. Modifications to the contents of the original tables are indicated by triggers. These tables must be copied and imported during downtime.

During downtime

After R3up has converted the data and made all preparations, it completes the copy import action during downtime for all tables with triggers set. The EU SWITCH phase completes the switch to the new system. All tables prepared in the shadow system are copied to the target release. The KX SWITCH phase switches the kernel. The PARCONV_UPG phase converts the application table and the phase TABIM_UPG imports the remaining data. Finally, the XPRAS_UPG phase starts the XPRAs required by the system.
5.1.3 Upgrade Strategy Planning

Purpose
If you are upgrading with the System Switch Upgrade procedure, SAP provides you with two upgrade strategies: **downtime-minimized** and **resource-minimized**. Choose the strategy that is best suited to your SAP system and to your requirements concerning system availability. Your decision depends on two factors:

- Maximum permitted downtime
- System resources

Features of the Upgrade Strategies

Downtime-Minimized
- Parallel operation of production system and shadow system
- Higher demand on system resources
- Shorter downtime
- Import of the substitution set into the shadow tables during production operation
- Modification adjustment of the ABAP Dictionary objects during production operation
- Activation and distribution during production operation

Resource-Minimized
- Operation of production and shadow system only possible independently of each other
- Production operation stops before import of substitution set into shadow tables or, at the latest, before shadow instance is started for first time
- Increased downtime
- No ICNV

Benefits of the System Switch Upgrade Procedure
If you choose the **downtime-minimized** strategy, the new System Switch Upgrade procedure offers you the following benefits:

- Modification adjustment during production operation
  The modification adjustment of the ABAP Dictionary objects is performed before downtime. This is possible since the complete version management is available in the shadow system.

- Activation and distribution during production operation
  You need to activate and distribute all ABAP Dictionary objects (including their dependent objects) that Support Packages modify in the delivered release, as well as objects that are modified or created by the customer. Where a large number of included Support Packages or add-ons are concerned, or where systems have been modified greatly, this procedure may take several hours.

- Specific use of the incremental table conversion function (transaction ICNV)
  You can also increase the number of candidates for transaction ICNV, since the amount and target structure of the tables can be calculated at the customer site. Transaction ICNV can therefore be used for tables modified by customers, add-ons,
and Support Packages. This is particularly noticeable in the shorter downtime for upgrades that include one or more add-ons.

Since these processes occur during production operation, downtime is reduced considerably, and some phases during downtime are much shorter. This mainly affects the phases PARCONV_UPG and TABIM_UPG. This means that in comparison to the Repository Switch Upgrade procedure downtime is reduced further by including the Support Packages and add-ons.

Other benefits of the System Switch Upgrade for both upgrade strategies include:

- Use of target release tools for the upgrade
  To upgrade from the source release structure to the target release structure, activation and distribution actions need to be specified and executed. This is now done by tools of the target release, which removes restrictions caused by using source release tools.

- Extended shadow import
  The shadow system is used to calculate the target release state of a table before downtime starts. Because the shadow tables are created in their final structure during production operation, the amount of tables into which data can be imported in advance can be increased. Until now, this was only possible for new tables and substituted tables.

### Comparison of Upgrade Strategies

<table>
<thead>
<tr>
<th>Strategy</th>
<th>Advantages</th>
<th>Disadvantages</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Downtime-minimized</strong></td>
<td>• Short downtime</td>
<td>• Increased demand on system resources due to parallel operation of production and shadow system</td>
</tr>
<tr>
<td></td>
<td>• Medium amount of space required to be able to recover the database</td>
<td>• Offline backup required after upgrade if archiving deactivated at some stage</td>
</tr>
<tr>
<td></td>
<td>• Disk capacity for a possible database recovery is not monitored</td>
<td>• Disk capacity for a possible database recovery is monitored</td>
</tr>
<tr>
<td><strong>Resource-minimized</strong></td>
<td>• No additional system resources during upgrade</td>
<td>• Long downtime</td>
</tr>
<tr>
<td></td>
<td>• No additional space requirements to be able to recover the database</td>
<td>• Offline backup required after upgrade</td>
</tr>
<tr>
<td></td>
<td>• Disk capacity for a possible database recovery is not monitored</td>
<td></td>
</tr>
</tbody>
</table>

The upgrade strategy is one of the main factors in determining the runtime of the upgrade and how much downtime is involved.

The following graphic shows the course of the upgrade for the various strategies. It does not show the differences in the duration of the upgrade. The upgrade is divided into phases. EU_IMPORT1, REQSTOPPROD, and MODPROF_TRANS are important phases, since they mark the start of downtime (depending on the chosen upgrade and archiving strategy).
The course of the upgrade is identical in all strategies up to the \texttt{EU\_IMPORT1} phase. For the \textit{resource-minimized} strategy, the downtime either begins in the \texttt{EU\_IMPORT1} phase or the \texttt{REQSTOPPROD} phase. For the \textit{downtime-minimized} strategy, downtime begins in the \texttt{MODPROF\_TRANS} phase.

\section*{Course of the Upgrade}

\begin{figure}[h]
\centering
\includegraphics[width=\textwidth]{course_of_upgrade.png}
\caption{Diagram showing the course of the upgrade with different phases and activities.}
\end{figure}

\section*{Upgrade Runtime}

The following factors influence the total runtime of \texttt{R3up}:

- Hardware used
- Import runtime for the substitution set
- Languages installed
- Number of clients
- Extensive customer developments
- Modifications to standard SAP tables
- Add-on software
- Integration of Support Packages

The downtime depends on the upgrade strategy you choose, the hardware, and the amount of time required to create the database archives. The size of your database only has a secondary role in determining the runtime of the upgrade. Your source release can influence the runtime and downtime of the upgrade by up to approximately 25%.
5.1.4 Database Backup

Database Archiving
The archiving strategy determines the time intervals in which database mechanisms save actions to the database. This determines whether the database system can recover lost data.

This archiving mode is database-specific and is defined as follows:

- **DB2 UDB for UNIX and Windows**: LOGRETAIN and USEREXIT are ON
- **Informix**: Backup mode of the database is activated
- **MaxDB**: Logging is switched on
- **MS SQL Server 2000**: Database runs with recovery mode Full
- **Oracle**: Database is operated in ARCHIVELOG mode

**DB2 UDB for z/OS**

It is not possible to deactivate archiving.

End of the database-specific explanations

The R3up program prompts you in the INITSUBST phase to select when you want to deactivate archiving.

The following options are available:

<table>
<thead>
<tr>
<th>Archiving Strategy</th>
<th>Downtime-Minimized</th>
<th>Resource-Minimized</th>
</tr>
</thead>
<tbody>
<tr>
<td>Archiving is activated during the entire upgrade.</td>
<td>Possible</td>
<td>Possible</td>
</tr>
<tr>
<td>Archiving is deactivated in the EU_IMPORT1 phase.</td>
<td>---</td>
<td>Recommended</td>
</tr>
<tr>
<td>Archiving is deactivated before you start the shadow instance for the first time in the REQSTOPPROD phase.</td>
<td>Not recommended</td>
<td>Recommended</td>
</tr>
<tr>
<td>Archiving is deactivated in the MODPROF_TRANS phase.</td>
<td>Recommended</td>
<td>---</td>
</tr>
</tbody>
</table>

The archiving strategies that are marked as possible are only useful in certain cases. Only the recommended archiving strategies are described here.

At the selected time, you are then prompted by R3up to deactivate archiving. After you have deactivated archiving, you can no longer use your system in production operation.

If you specified during PREPARE that you are performing the upgrade in a Multiple Components in One Database System (MCOD), which means that multiple SAP systems are installed in your database, you are not prompted about archiving. Archiving is automatically activated during the entire upgrade. For more information on MCOD systems, see SAP Service Marketplace at service.sap.com/mcod.
**5 General Upgrade Information**

**Full Backup**

If you deactivate archiving at some stage during the upgrade, you have to make a full backup of the database before you switch archiving back on.

The archiving strategy that you choose also determines when you need to make a full backup of the database.

If you choose the *downtime-minimized* upgrade strategy, the full backup is made at the beginning of downtime, before the `MODPROF_TRANS` phase.

If you choose the *resource-minimized* upgrade strategy, the full backup is made before the substitution set is imported, either during production operation or during downtime.

⚠️ At the same time, make a backup of the upgrade directory and its subdirectories.

After the upgrade you need to make another backup of the database.

---

**5.1.5 Database-Specific Aspects**

**DB2 UDB for UNIX and Windows**

- **Isolation of the central instance**
  
  When you isolate the central instance (for strategy *downtime-minimized* in the `MODPROF_TRANS` phase, for strategy *resource-minimized* in the `EU_IMPORT2` or `REQSTOPPROD` phase), you are prompted to stop all work in the system. `R3up` waits for your confirmation before it stops the central instance.

  With both strategies, `R3up` switches the parameters `LOGRETAIN` and `USEREXIT` to `OFF` after confirmation. To activate these parameters, shut down the database and reboot it.

- **Database backup before the upgrade**

  You must be able to recover the database to its state before the upgrade was started. This means that you must back up the database for all strategies; at the latest when the system stops production operation.

- **Database backup at the end of the upgrade**

  At the end of the upgrade, `R3up` switches the parameters `LOGRETAIN` and `USEREXIT` to `ON` for both strategies after confirmation. The database forces you to create a full backup (otherwise a CONNECT to the database is not possible). After the database backup, continue in `R3up`.

**DB2 UDB for z/OS**

Database mechanisms back up database actions during the entire upgrade. Logging is always switched on regardless of the upgrade strategy. This has the following effects:

- You can recover the database to its current state during the entire upgrade.

- The upgrade strategy influences the downtime, but not the database logging.
Informix

When you isolate the central instance, you are prompted to stop all work with the system. R3up waits for confirmation before stopping your central instance.

You must be able to recover the database to the state it has at this point in time. This means that you must make a full backup for both strategies at this time so that you do not have to import all the logical log files created so far in case of a database failure. You can choose an online or an offline backup. You are then requested to deactivate the database backup mode. You can find the necessary commands under Changing the Database Recovery Mode [page 224]. After the upgrade, you must make an online backup.

MaxDB

The performance for the development environment import (mass insert) depends largely on the log devspace. Make sure that the log devspaces are on different hard disks. The concatenated archive logs can be located on one disk without a loss of performance, however, their mirrors should be on other disks. In the dbmgui, you can change the log configuration under Configuration. The statistics values for newly imported tables are updated automatically after the development environment import.

Update the statistics shortly before [page 131] and after [page 185] your upgrade of the SAP system.

If you deactivated the archiving option, R3up switches the log mode to OVERWRITE after confirming and checking the log backup. After the mode has been switched, the contents of the log are permanently lost.

You must be able to recover the database to the state it has at this point in time. To be able to do this, you need to make an online backup before you stop production operation.

If you use the downtime-minimized strategy, you can decide whether you want a very fast import of the substitution set. Logging is deactivated if you choose this import option.

Before you isolate your system, you must make a complete backup of the database (Backup Complete) in operating mode ONLINE (same as mode WARM in SAP DB version 7.3). Since it is not possible to estimate how long a complete backup takes, schedule a generous amount of time between starting the complete backup and isolating your system. Shortly before you isolate the system, make an additional incremental backup (Backup Incremental). When you isolate the system, make a log backup (Backup Log).

MS SQL Server

You must be able to recover the state of the database before the upgrade, regardless of the chosen upgrade strategy.

Always make an online backup of the database before the upgrade.

Make an offline backup (Windows NT file backup) before the upgrade.

Downtime-Minimized

For the downtime-minimized strategy, you can use your SAP system productively until you isolate the central instance in the MODPROF_TRANS phase.
When you are using the system productively at the same time as the upgrade, large amounts of data may accumulate in the transaction log. Make a regular backup of the transaction log. You can back up the transaction log to disk, over the network, or directly to tape. Backing up the transaction log means that it is available for you to analyze after a server crash, when you need to reset the database to its last consistent state.

Proceed as follows:

- **Start of the upgrade until the MODPROF_TRANS phase**
  
  To back up the accumulated log data permanently, schedule a job in the Enterprise Manager in the MODPROF_TRANS phase for the time between the start of the upgrade and the start of downtime. This job must back up the transaction log at least every 10 minutes.

- **Phase MODPROF_TRANS**
  
  When you isolate the central instance in the MODPROF_TRANS phase, you are prompted to stop all work with the system. R3up waits for confirmation before stopping your central instance. You must be able to recover the state of your database to this point in time.

  Proceed as follows:
  
  o Manually back up the transaction log and make sure that there are no more user actions on the database at the time of the backup.
  
  o Back up the directory tree \usr\sap\put.
  
  o Deschedule the job for the automatic backup of the transaction log in the Enterprise Manager.
  
  o You are prompted to deactivate logging of database transactions. To do this, you have to set the recovery model to *Simple* for MS SQL Server 2000.

- **After the upgrade**
  
  Make an online backup after the upgrade.

**Resource-Minimized**

With the *resource-minimized* strategy, you can use your SAP system productively until you isolate the central instance in the EU_IMPORT1 phase.

- **Phase EU_IMPORT1**
  
  When you isolate the central instance in the EU_IMPORT1 phase, you are prompted to stop all work with the system. R3up waits for confirmation before stopping your central instance. You must be able to recover the state of your database to this point in time.

  Proceed as follows:
  
  o Manually back up the transaction log and make sure that there are no more user actions on the database at the time of the backup.
  
  o Back up the directory tree \usr\sap\put.
  
  You are prompted to deactivate logging of database transactions. To do this, you have to set the recovery model to *Simple* for MS SQL Server 2000. You can make these changes with the Enterprise Manager.

- **After the upgrade**
  
  Make an online backup after the upgrade.
5 General Upgrade Information

Oracle

At the beginning of downtime, (we recommend [page 74]) that you start this in the phase MODPROF_TRANS for the downtime-minimized strategy, and in the EU_IMPORT1 phase for the resource-minimized strategy, you are prompted to stop all work in the SAP system. R3up waits for confirmation before stopping your central instance.

⚠️ You must be able to recover the database to the state it has at this point in time. Therefore, you must now make a full backup of your database so that, in case of a recovery, you need not import all the archives created so far, including those written during the previous import. You can choose between an online backup, which you must perform before you stop the central instance, and an offline backup, which you must perform before you confirm the deactivation of archiving.

Back up the upgrade directory as well.

R3up waits for your confirmation before it stops the central instance. Proceed as follows:

1. If you have opted for
   - an online backup:
     i. Perform the online backup before you stop the central instance.
     ii. Confirm that you want to stop the central instance
   - an offline backup, perform it before you deactivate archiving.

2. Deactivate archiving of the database.
   For a detailed description, see Changing the Database Recovery Mode [page 224].

3. Confirm the R3up prompt about database archiving.

4. Back up the upgrade directory now at the latest.

5. Confirm the R3up prompt about database archiving.

End of the database-specific explanations

5.1.6 Upgrades in an MCOD System Landscape

As of SAP Web Application Server 6.10, you can upgrade systems in a Multiple Components in One Database (MCOD) system landscape. Note the following when you upgrade an MCOD system:

- The database user, tablespaces, dbspaces, or devspaces, and for MS SQL Server also the database name of an MCOD system have different names to those of an MCOD system without an MCOD layout or a non-MCOD system.

  The names you need to enter for systems with normal or MCOD layouts are listed at the appropriate place in the text.

- Do not switch off archiving when upgrading in an MCOD system landscape.

  All SAP systems in the database are affected if you need to reset the upgrade.
PREPARE asks you at the start of the upgrade whether there is more than one SAP system installed in the database. If there is more than one SAP system installed in the database, do not switch off archiving during the upgrade.

MaxDB

- The free space check in an MCOD system is a check made before the upgrade, and does not guarantee a successful upgrade. The growth of data in other systems can cause a Dbfull situation. For this reason, you must constantly monitor the free space in MCOD systems.

End of MaxDB

Do not perform parallel upgrades of MCOD systems.

For more information on MCOD systems, see SAP Service Marketplace at service.sap.com/mcod.

5.1.7 Data Management Planning

Use

The upgrade runtime – and in particular the system downtime – is extended when dealing with large database tables. Table conversions during the upgrade and data adjustments at the end of the upgrade performed by, for example, XPRAs or other after-import methods, are the most time-consuming actions and can result in long upgrade runtimes. To avoid these problems, you should minimize the quantity of table entries that have to be converted prior to the upgrade. The best way to achieve this is to carry out Data Management measures, such as archiving or deleting data records from the tables.

Data Management is vital for maintaining a “healthy” live system, because it helps to keep system performance high and to make optimal use of existing hardware resources. One of the most effective Data Management methods is Data Archiving. It allows administrators to remove data that is no longer needed in everyday operations from the database and store it in archive files. These files can then be passed on to a storage system for long-term storage. After archiving, the data can still be accessed in read-only mode when the need arises, for example, during an audit.

For more information on Data Archiving, see SAP Service Marketplace at service.sap.com/data-archiving.

Procedure

Before the upgrade, analyze the database to find out which database tables can be reduced in size, and how this can be achieved.

For more information, see the documentation Archive-Quickwins for Upgrade. It provides a list of database tables that tend to grow rapidly, but whose size can be reduced quite easily without an extensive and time-consuming approval process involving the business process owners. The tables are not analyzed from a stand-alone point of view but by taking into account the entire business context in which they are embedded. The document also describes how to analyze the content of each table and gives detailed recommendations about how to reduce the table size by archiving or deleting data.

To find the latest version of this documentation, see SAP Service Marketplace at service.sap.com/dao → Media Library → Archive-Quickwins for Upgrade.
5.1.8 Incremental Table Conversion

Use

You can use incremental table conversion only if you use upgrade strategy `downtime-minimized`.

The structure of some of the tables in your database changes each time you upgrade your system to a new release. In some cases you need to convert these tables. This involves completely restructuring them and converting each individual data record. These conversions are usually made during the upgrade downtime (phase `PARCONV_UPG`).

The incremental conversion function enables many of these tables to be converted before the upgrade. The data is converted during production operation of the system.

This approach has the following benefits:

- Reduced downtime during the upgrade, especially for systems with one or more add-ons
- Simple return to the SAP standard for modified tables

Prerequisites

The System Switch Upgrade only determines the candidates for transaction ICNV after the target structure of the tables has been defined. The candidates are determined in the `ICNVREQ` phase. `R3up` checks whether the system contains tables for which an incremental conversion is an advantage. These include tables that need to be converted, and that contain large volumes of data, and therefore would increase the downtime significantly during a conversion. The System Switch Upgrade also enables you to use transaction ICNV for tables that have been modified by Support Packages, add-ons, or customer developments.

If the above applies, `R3up` prompts you to start the incremental conversion.

Use of the incremental conversion function is optional. If you do not want to use incremental conversion, the tables are converted during downtime.

Features

Incremental conversion is performed using transaction ICNV. This transaction offers the following functions:

- Displays the tables determined by `R3up` (candidates for incremental conversion)
- Decides which candidates should be converted incrementally
- Starts the conversion
- Monitors the conversion
- Estimates the runtime of the conversion

For up-to-date information see SAP Note 490788. For more information call transaction ICNV and choose F1 or Information.

Note the following:

- Transaction ICNV makes modifications to the database tables that you want to convert during the `Initialization` step. You cannot reset these modifications by resetting the upgrade. In particular, you cannot directly upgrade these modifications.
• If you use incremental table conversion, do not start an SAP archiving program for these tables at the same time, since this can lead to performance bottlenecks. Therefore, archive as much data as possible before you start the conversion.

• After the incremental conversion starts, you cannot change any more ABAP Dictionary definitions for the relevant tables until the upgrade is complete. This means you cannot change, delete or add field definitions. Transaction SE11 is locked for these tables.

• Pay special attention to the resource usage of your database management system to detect bottlenecks early on. Incremental conversion requires double the space in the relevant database memory area (tablespace, dbspace, and so on) for each table affected during the conversion. The continuous transfer of data results in more transactions being performed. Therefore, also monitor the space available for the rollback information.

MaxDB

• See SAP Notes 352081 and 362542 to determine the table size of the tables you want to convert with ICNV. Provide additional free space for these tables during the upgrade.

End of MaxDB

• Do not begin the upgrade downtime before at least 95% of the total data has been converted. R3up checks this at the beginning of downtime. If this percentage has not been reached, R3up displays an appropriate message.

   This gives you the advantage of reducing critical downtime. To monitor the progress of the conversion, you can call transaction ICNV.

   You can start downtime even if the 95% minimum has not been reached. However, the remaining data is transferred entirely during downtime. If this process is not finished before the PARCONV_UPG phase, the downtime increases depending on the remaining conversion set.

• Incremental conversion requires a sufficient number of background work processes. Ideally, there should be one process for each table that needs to be converted. If you cannot have one process for each table because there are too many of them, you can still convert them since transaction ICNV automatically distributes the tables to the available background processes. However, the incremental conversion then takes longer to complete, and the time for beginning downtime is pushed back.
5.1.9 Upgrade Schedule Planning

Purpose
Create an exact schedule for your SAP system upgrade.

Prerequisites
You have chosen one of the two upgrade strategies, downtime-minimized or resource-minimized.

Process Flow
1. You decide when to begin preparing for the upgrade.
   When you start the upgrade preparations does not depend only on the length of the preparations but also on the length of the upgrade itself. To determine the expected total length of the upgrade of your production system, perform a test upgrade of an SAP system with a similar set of data (a system copy of your production system is ideal).

2. You decide when to start the upgrade.
   If you have special requirements regarding the availability of your SAP system, adjust the process and the length of the upgrade to fit the expected amount of downtime.
   During the upgrade, various actions are performed by and in the shadow system. The runtime of these actions depends on various factors and is therefore specific to each SAP system:
   - Creating the shadow repository (EU_IMPORT phases)
   - Importing the additional software packages such as languages, Support Packages, and add-ons (phase SHD_IMP)
   - Adjusting modifications to the ABAP Dictionary objects (transaction SPDD)
   - Mass activation and distribution
   - Incremental conversion of tables (transaction ICNV)

   The runtime of these phases depends on the upgrade strategy that you choose.

   If you have chosen upgrade strategy resource-minimized, these phases take place during downtime. You can influence, among other things, how long they take by the number of import processes.

   If you have chosen upgrade strategy downtime-minimized, you can continue to use your SAP system in production operation during these activities. You can reduce downtime if you make sure that all the activities that the shadow instance performs to deal with objects are finished before the scheduled start of downtime (phase MODPROF_TRANS). Therefore start the upgrade in good time. If you finish the activities before the scheduled start of downtime, you can stop the upgrade before the MODPROF_TRANS phase.
3. You determine the time for importing the substitution set [page 85].

4. You take the necessary measures to extend the time in which the upgrade can run unmonitored.
   - Specify all mount directories at the start of the upgrade.
     
     R3up lets you specify up to 24 mount directories when you start upgrading. This significantly increases the amount of time R3up can run without user input. For more information, see Making Entries for the Parameter Input Module [page 107].
   - Early locking of the ABAP Workbench
     
     If you decided to use upgrade strategy downtime-minimized:
     
     The LOCKEU_PRE phase, which prompts you to enter the time from which the ABAP Workbench is locked, runs immediately before the EU_IMPORT1 phase. If you are sure that you can do without the ABAP Workbench from the EU_IMPORT1 phase, confirm the lock in LOCKEU_PRE.
     
     If you do not confirm the lock in LOCKEU_PRE, the system prompts you to do so in phase REPACHK2. Since the REPACHK2 phase takes place after the last request to enter a mount directory (EU_IMPORT5 phase), you may not want to do this.
   - Avoiding long upgrade downtimes
     
     The Upgrade Assistant can inform you when the R3up control program is waiting for input. This could involve either normal user input or intervention to solve an error.
To receive this alert information, activate the alert function [page 145] and enter the appropriate parameters. You can trigger an external program to start if R3up has been waiting too long for input. This then triggers a communications service that informs the system administrator. You must supply this external program yourself.

For more information on the alert function, see the online help of the Upgrade Assistant in section Set Alert window. To access the online help, choose Help → Introduction.

Regardless of whether you use the Upgrade Assistant or not, the R3up control program always stops the upgrade when errors occur so that you can intervene. R3up tells you to intervene as follows:

- A message appears on the screen.
- An upalert.log file is created in subdirectory tmp of the upgrade directory.

If you fail to notice these errors, your upgrade schedule may be delayed significantly.

To avoid these delays, you can arrange to be notified automatically by telephone, for example, that the upgrade has stopped. You can use the alert file to do this. You must provide the appropriate software for using the alert file. R3up can also send a dialog box to a specified PC if the upgrade waits longer than 60 seconds for user input. For more information, see Sending a Message When User Action Is Required [page 228].

5. You decide when a full backup is performed after the upgrade.

The full database backup, which is a prerequisite for resuming production operation of your system when archiving is deactivated, must be made after you have performed all necessary post-upgrade activities. This has the advantage that all database changes resulting from post-upgrade activities are included in the full backup.

6. You decide when production operation resumes.

If possible, resume production operation only after you have performed all required post-upgrade activities.

At the latest, system downtime begins in the MODPROF_TRANS phase. The earliest possible time for resuming production operation is the MODPROFP_UPG phase [page 158].
5.1.10 Runtime for the Import of the Substitution Set

The net total runtime of R3up depends on the amount of time required to import the substitution set.

When you use the resource-minimized strategy, you can indirectly influence the length of the import runtime by the number of the processes that are used for this.

When you use the downtime-minimized strategy, you determine the runtime for the import yourself. The longer you make the runtime, the better the performance in your production system will be. A longer runtime also means that fewer archives (Oracle) or log files (DB2 UDB for UNIX and Windows, DB2 UDB for z/OS, Informix, MaxDB, and MS SQL Server) are created each hour, which then need to be backed up.

To determine the expected total runtime of the relevant upgrade phases for your production system, perform a test upgrade of an SAP system with a similar set of data (a system copy of your production system is ideal).

If this is not possible, you can start the upgrade a few days before downtime is due to begin, and stop the upgrade process until the scheduled time.

5.1.11 Upgrade in an SAP System Group

Purpose

If you have more than one SAP system, for example, a production system and a development system, you must consider the entire system group when you upgrade. Upgrade your systems in the same sequence in which you transport your modifications.

Process Flow

- If you have a development system and a production system, upgrade the systems as follows:
  a. Development system
  b. Production system

- If your system group consists of three SAP systems and includes a quality assurance system that has been set up between the development and production system, upgrade your systems as follows:
  a. Development system
  b. Quality assurance system
  c. Production system

If you have made modifications to SAP objects that you want to retain, you must proceed with the upgrades in the above sequence. The version management functions of the SAP system record all the changes you make only in the system in which you made the modifications (the development system). Only this SAP system offers you optimal support when you adjust modifications.

Changes made in the development system after the upgrade can be transported automatically to your other SAP systems. If you use this procedure, you no longer need to perform time-consuming adjustments in the production system.
If you have modified SAP objects, make sure that you keep your development system. Do not copy your production system to your development system to test the upgrade.

To test the upgrade with realistic production data, set up a quality assurance system between the development system and production system. This system can be a copy of the production system.

### 5.1.12 Modification Adjustment Planning

#### Purpose

If you are sure that your SAP system corresponds exactly to the standard SAP system, you can skip this section.

Modifications are changes to objects of the SAP standard. There are two types of modifications: ones that make changes to the translation of an object text, and ones that make changes to the object itself.

**Changes to the Translation of an Object Text**

The changes are made in the translation environment (transaction SE63) or in the ABAP Workbench. An SSCR key is not required.

Changes to translations of SAP objects are not retained when you perform an upgrade. They are overwritten by a new version or deleted. For more information about retaining these changes, see [SAP Note 485741](https://service.sap.com/sscr).

**Modifications to the Object**

You may need an SSCR key to perform the modification adjustment. Get the key before you upgrade the system. For more information, see SAP Service Marketplace at [service.sap.com/sscr](http://service.sap.com/sscr).

All modified standard SAP objects are displayed for adjustment in transaction SPDD or SPAU. Objects that SAP no longer delivers are deleted. If you want to keep these objects, you have to accept the modifications in transaction SPDD or SPAU.

Make sure that before the upgrade there is at least one package in the customer namespace (Z*). You need this package if you have to create objects during the modification adjustment, for example, for an append structure for customer fields of an SAP table. You cannot create packages during the upgrade.

If you choose upgrade strategy **downtime-minimized**, the modification adjustment of ABAP Dictionary objects occurs during production operation. This is possible since the complete version management is available in the shadow system. The remaining Repository objects are still adjusted at the end of the upgrade.
For more information on the modification adjustment, see SAP Service Marketplace at service.sap.com/abapwb → Modification & Enhancement.

Process Flow

Modification Adjustment in the First System (Development System)

Since all modifications to standard SAP objects are displayed during the upgrade, and you have to adjust all the displayed objects, you must schedule enough time for the modification adjustment.

You must test the modification adjustment in a development system that has the same SAP release and that has been modified in the same way as the production system. If the development system contains more modifications, including the Support Package level, then contact an experienced SAP consultant for help. The following explanation assumes that the levels of modification are identical.

1. The list of objects that must be adjusted in your SAP system is determined in the ADJUSTCHK phase. This phase is executed in the PREPARE module Modification Support and runs in the upgrade between the import of the substitution set and the end of the production period. The list is in the UMODPROT.<SAPSID> log in the log subdirectory of the upgrade directory.

2. If you choose strategy downtime-minimized, the ABAP Dictionary objects (tables, data elements, domains, and so on) are adjusted during production operation. If you choose strategy resource-minimized, they are adjusted during downtime before the ABAP Dictionary is activated. The adjusted objects are collected in a repair that is released to a transport request. You cannot release this transport request; instead you must flag it for transport in transaction SPDD. Towards the end of the upgrade, R3up exports the request to the transport directory $(SAPGLOBALHOST)sapmnt\trans and registers it for transport in the umodauto.lst file.

3. Repository objects (reports, screens, and so on) are adjusted towards the end of the upgrade. At this stage the import of SAP objects has already been completed. However, the old modified version is still available in the version database. As with ABAP Dictionary objects, all changes are released to a transport request that is flagged and then exported and registered by R3up.

Modification Adjustment in Subsequent Systems

For the quality assurance and production system, we recommend that instead of adjusting modifications manually, you automatically transfer both the transport requests exported in the section “Modification Adjustment in the First System (Development System)”.

If you have not set up a central transport directory, you must perform some more steps before the transport requests can be transferred automatically. These steps are described in SAP Note 51046.

The ADJUSTPRP phase in the PREPARE module Extension prepares the requests from the development system to be transferred. If you confirm the transport requests, they are integrated into the upgrade. The phase also checks whether all the modifications identified in the system are handled by transport requests. If this is the case, you do not need to perform a modification adjustment.
The number of objects in the adjustment transport requests might exceed the number of modifications in the receiving system. In this case, the upgrade will import changes that previously did not exist in the receiving system.

For a detailed description of the modification adjustment function, see the current online documentation under Help → SAP NetWeaver Library → SAP NetWeaver → Application Platform (SAP Web Application Server) → ABAP Technology → ABAP Workbench → Changing the SAP Standard → Upgrade Procedure/Support Packages.

5.1.13 Checking the Structural Requirements

1. Configuration for R3up

During the upgrade, the upgrade control program R3up uses Remote Function Call (RFC) to call function modules and temporarily schedules ABAP report programs for background processing. For this reason, the message server must still be running after the secondary instances are stopped. You can only guarantee this if the message server is located on the same host as the central instance.

2. Update work process

If you have made modifications to the standard SAP system, versions of the modified objects are created by the version management functions during the upgrade. The update program writes these versions. This means that an update process must be running on the central instance.

A standard installation meets the structural requirements specified in points 1 and 2.

3. Background work processes

At least two background work processes must be configured for the instance.

4. Database-specific settings

Informix

Before you start PREPARE for the first time, make sure that at least 200 MB free space is available in the temporary dbspaces (for example TMPDBS1).

Oracle

Check the settings for the following parameters in the init<SAPSID>.ora file. The listed values are minimum values. Use these settings to ensure smooth operation of the SAP system:

shared_pool_size = 52428800
db_block_buffers = 10000
sort_area_size = 2097152

End of the database-specific explanations
5.1.14 Checking the Hardware Requirements

CPU, Main Memory, and Page Files

Before the upgrade, check whether you have enough hardware resources, such as CPU, main memory, disk space, and page files.

For more information, and to access the Quick Sizer, see SAP Service Marketplace at service.sap.com/sizing.

Space Requirements in the File System

Make sure that there is enough temporary disk space available in the file system for the upgrade. You need this free space to create the upgrade directory.

Space Requirements in the Database

Make sure that enough temporary and permanent free space is available in your database.

Informix and Oracle

The PREPARE program gives you information on how much free space is needed in the database. PREPARE takes the status of your database into account and calculates the exact space requirements.

End of the database-specific explanations

5.1.15 Checking the Software Requirements

Use

You must meet certain software requirements before you upgrade the SAP system.

Procedure

1. Check the source release of the SAP system [page 89].
2. If you want to use the Upgrade Assistant, meet the requirements [page 90].
3. If necessary, upgrade the operating system and database system [page 90].

Checking the Source Release of the SAP System

Procedure

Before you upgrade your SAP system, it must have one of the source releases that have been released for this upgrade.

To determine the source release of the SAP system, log on to the system and choose System → Status.

- **Basis Release 3.x – 4.5x**
  
  The release appears in the SAP Release field.

- **Basis Release 4.6x and SAP Web AS Release 6.x**

  The release appears in the Component version field.
Meeting the Requirements for the Upgrade Assistant

Network
If you do not operate the GUI and server on the same host, you must be able to set up a TCP/IP connection between the GUI host and the server host.

Java Virtual Machine
The Upgrade Assistant (Server and GUI) is implemented in Java. This means that it requires a Java Virtual Machine.

If you have any doubts about your operating system, find out about its Java porting from your Competence Center.

Procedure for the Upgrade Assistant Server
You can run the Upgrade Assistant Server on version 1.3.x or higher of the Java Software Development Kit (SDK).

To install the J2EE Engine on the central instance, however, you require at least version 1.4.x of the SDK. For information on whether the scenario you are upgrading to is using the J2EE Engine, see the Upgrade Master Guide.

For information about which versions of the SDK are released for particular database and operating system combinations, see SAP Service Marketplace at service.sap.com/platforms → Platform Availability Matrix.

Procedure for the Upgrade Assistant GUI
If the Upgrade Assistant GUI is not called on the central instance, you also require on each host at least Version 1.1.x of the Java Virtual Machine.

Under Windows 2000 and Windows Server 2003, the Microsoft Virtual Machine is part of the operating system and can be used to upgrade the system with the Upgrade Assistant.

If you use Windows NT 4.0, you need to install the Java Virtual Machine in addition to the operating system.

Upgrade of the Operating System and Database System: Overview
When you upgrade the SAP system, you may have to upgrade your operating system and database to a new version.

For more information on the operating systems released for the upgrade, see SAP Service Marketplace at service.sap.com/platforms.

If you need to upgrade an operating system or database, or migrate the database then the timing and the sequence of the individual upgrades is of great importance. The procedure differs according to the database you use.

For more information, see this section in the product-specific part of this documentation.
5.1.16 Accessing Documentation Before and During the Upgrade

**Use**

Before and during the upgrade you require documentation from the DVD *SAP Online Documentation* that contains the latest online documentation (for example, to modify adjustments). The documentation is not available online in your system until you have completed the upgrade and the installation procedure for the online documentation (SAP Library). However, you can make sure that you can read the DVD offline before the upgrade.

**Procedure**

The instructions for installing the documentation are on the *SAP Documentation* DVD in file Onldoc_e.pdf or Onldoc_e.htm. This upgrade documentation includes the paths to specific information in the appropriate sections. After the installation, you can use the same paths to find the documents online in the SAP system choosing *Help → SAP Library*. If you are upgrading from a 4.x Release, you can find most of the documentation online in the system before and during your upgrade to the new release.

5.1.17 Meeting the Requirements for the SAP Internet Solution

**Use**

As of SAP NetWeaver ’04, the SAP Internet Transaction Server (SAP ITS) is integrated into the SAP NetWeaver component SAP Web Application Server 6.40 as an Internet Communication Framework (ICF) service, which you can access, like other services, through the Internet Communication Manager (ICM). With the SAP ITS integrated in the SAP Web Application Server, the Web browser now communicates directly with the SAP system. Furthermore, all SAP ITS-related sources, such as service files, HTML templates, or MIME files, are now stored in the database of the system.

If you have developed your own SAP ITS-based Internet services, you can either use the integrated SAP ITS or you can continue using the standalone SAP ITS 6.20. ITS-based Internet services provided by SAP can run either on
- SAP Web AS 6.40 with integrated SAP ITS
- SAP Web AS 6.40 with integrated SAP ITS and SAP ITS 6.20
- SAP ITS 6.20

The SAP ITS integrated in the SAP Web AS supports the following functions:
- SAP GUI for HTML
- Internet Application Component (IAC) runtime or Web Transaction technology

The SAP ITS integrated in the SAP Web AS does not support the following functions:
- SAP ITS Flowlogic runtime
- WebRFC
• Web Reporting
• GUI XT

If you want to use these functions, you need a standalone SAP ITS 6.20.

Which ITS you can use may depend on the SAP Solution you have implemented. For more information about the SAP Solution you are using, see the Upgrade Master Guide of the specific SAP solution.

You can use the ABAP Workbench of the SAP system to develop your own Internet applications or modify the applications delivered with the standard SAP system. Any modification you make to Internet applications delivered in the standard SAP system are recorded by the Modification Assistant and can be adjusted with transaction SPAU during the upgrade.

Prerequisites

SAP ITS 6.20: The prerequisites and the upgrade of customer-specific Internet application components are described in the documentation SAP@Web Installation Guide.

Procedure

• If you want to use the integrated SAP ITS 6.40, proceed as follows:
  a. Perform the upgrade of the SAP system.
  b. Configure the integrated ITS.

  For information on how to configure the integrated ITS, see the online documentation under Application Platform (SAP Web Application Server) → ABAP Technology → UI Technology → ITS/SAP@Web Studio → SAP ITS in the SAP Web Application Server → Configuration.

  c. Migrate the applications.

  For information on how to migrate SAP ITS-based Internet services, see the online documentation under SAP NetWeaver → Application Platform (SAP Web Application Server) → ABAP Technology → UI Technology → Web UI Technology → ITS/SAP@Web Studio → SAP ITS in the SAP Web Application Server → Developing IACs with the SAP integrated ITS → Migration of existing ITS-Services.

• If you want to continue using the services with the standalone SAP ITS 6.20, proceed as follows:
  a. Upgrade the SAP system.
  b. Read SAP Note 197746 to see if newer versions of the SAP ITS and IACOR are available.
  c. Make a backup copy of all Internet applications that you have developed or modified on the SAP ITS.

  Make this backup copy even if you do not want to install a newer version of the SAP ITS.
  d. If there are newer versions, install and configure the SAP ITS and IACOR as described in the SAP@Web Installation Guide.
  e. Execute report W3_PUBLISH_SERVICES in the SAP system to publish the Internet applications from the SAP system to the SAP ITS.
5 General Upgrade Information

i. Leave the fields *Transport Request* and *Package* empty and choose *Execute*.
   A new dialog box appears.

ii. Choose *Workbench Settings*.
   A new dialog box appears.

iii. Choose the option *On Selected Site* under *Publish*.

iv. Use the input help to select the site where you want to publish, and confirm.
   If the selection menu is empty, the IACOR and its corresponding sites in the SAP system have not yet been configured correctly. For more information, see SAP Note 399578.

v. Choose *Select All* and *Publish*.
   The publishing process can take up to 15 minutes. If the publishing process was successful, an appropriate message appears.

vi. If you have configured multiple sites where you want to publish, repeat steps b. to e.

Execute report W3_PUBLISH_SERVICES even if you have not installed a new version of the SAP ITS. For more detailed information, and any updates, see SAP Note 399578.

5.1.18 Importing Additional Languages

After the upgrade you have the option of importing new languages into the SAP system. SAP recommends that you only use this option if the system contains the Support Packages for the language DVD you are using. This is the case if you did not include any additional Support Packages in the upgrade, or did not import any additional Support Packages after the upgrade. For more information, see the Language Transport documentation, or SAP Note 352941.

The upgrade procedure itself only offers to update existing languages. You cannot install any new languages during the upgrade. However, you do have the option of classifying new languages in the SAP system before the upgrade with transaction SMLT, and importing them during the upgrade. For more information about this procedure, see SAP Note 322982.

If you intend to use additional languages in your system in the future, import them during the upgrade. In this way you can avoid any sequencing problems arising from Support Packages included in the upgrade, or Support Packages you need to import after the upgrade.

![Tip](https://example.com/tip.png)

Importing new languages during an upgrade is a highly efficient process, and is preferable to importing a language into a production system after an upgrade.
5.2 Upgrade Preparations

General Information

This part of the documentation contains general information on the preparations that you need to make before you upgrade your system.

For any additional information, see the product-specific part of this documentation.

You can prepare for the upgrade while the system is in production operation. Careful preparation of the upgrade is the best guarantee that it will run without errors. The PREPARE [page 230] program supports you here by making most of the necessary checks automatically. Start PREPARE as soon as possible before the upgrade so that you can perform the necessary preparations in time.

Actions

You perform the following general actions before you start PREPARE:

- Determining the Host for the Upgrade Preparations [page 96]
- Creating the Upgrade Directory [page 96]
- Checking the Database-Specific Requirements for PREPARE [page 97]
- Importing the Latest SPAM Update (Source Release 4.x and Higher) [page 100]
- For NT 4.0: Checking the Consistency of the Host Name [page 100]

The following actions describe how to start and use the Upgrade Assistant:

- Starting PREPARE for the First Time [page 102]
- Starting the Upgrade Assistant Server [page 103]
- Starting the Upgrade Assistant GUI [page 103]
- Starting the Upgrade Assistant [page 104]
- Restarting PREPARE [page 105]
- Resetting PREPARE [page 105]
- Importing Software After Starting PREPARE [page 106]

You perform the following actions during PREPARE:

- Making the First Entries for PREPARE [page 106]
- Making Entries for the Parameter Input Module [page 107]
- Making Entries for the Initialization Module [page 112]
- Making Entries for the Import Module [page 113]
- Making Entries for the Extension Module [page 114]
- Making Entries for the Installation Module [page 124]

- If you have an MSCS configuration [page 125], you need to make entries in the General Checks module.

You perform the following actions after you have executed PREPARE:

- Evaluating the Results of PREPARE [page 126]
- **Making Preparations at the Operating System Level** [page 130]
- **Making Preparations at the Database Level** [page 131]
- **Making Preparations at the SAP System Level** [page 134]
    - Deleting the AUTOSTART Parameter [page 134]
    - Checking the User for the Upgrade [page 134]
    - Checking the Requirements for the Modification Adjustment [page 135]
    - Setting the Operation Mode for the Upgrade [page 135]
    - Processing Batch Input Sessions (Source Release 3.1I) [page 136]
    - Converting the Translation Proposal Pool (Source Release 3.1I) [page 136]
    - Processing Direct Input Error Data (Source Release 3.1I) [page 137]
5.2.1 Determining the Host for the Upgrade Preparations

Use
You need to prepare for the upgrade on the host with the central instance. Depending on your configuration, you may later also need or want to use your database host or another host.

Procedure
Decide which hosts you need for the upgrade preparation and the actual upgrade of the SAP system:

- **Host with the central instance**
  You must execute the upgrade process and PREPARE on the host where the central instance is running. The Upgrade Assistant Server also runs on this host.

- **Other hosts**
  The graphical user interfaces (GUIs) provided by the Upgrade Assistant can run on any hosts that meet the necessary requirements.

- **Database host**
  You must perform the actions that affect the database on the database host. For a description of these actions, see Making Preparations at the Database Level [page 131].

5.2.2 Creating the Upgrade Directory

Use
The system is upgraded using the upgrade directory, which is divided into subdirectories. The standard path for the upgrade directory is `\usr\sap\put` on the host with the central instance, however, you can also give it a different name. For more information, see Using a Different Upgrade Directory [page 226]. The PREPARE program needs the upgrade directory before the actual upgrade, since it copies data and programs into this directory.

Before you start the new upgrade the directory must exist, but be empty.

Prerequisites
- The upgrade directory must be installed on the host with the central instance.
- Make sure that there is enough free disk space for the upgrade directory. This space is required for the upgrade and the logs.
  
  The size of the subdirectories may vary by up to 25%, depending on your database and source release.

With the System Switch Upgrade, there are dynamic percentages in the subdirectories data and log in the upgrade directory. We recommend that
you create the directory with more space, if your systems include extensive customer developments or large amounts of individual documentation. If you want to include Support Packages and add-ons in the upgrade, you also need to make these directories larger.
You also require additional disk space in the upgrade directory for each language other than English or German.

**Procedure**

1. On the host with the central instance create the subdirectory `put` in the file structure `\$(SAPGLOBALHOST)\sapmnt`.

   If you cannot create the upgrade directory under the share `sapmnt`, or you cannot use the default path `\usr\sap\put`, see Using a Different Upgrade Directory [page 226].

   In an MSCS configuration the directory `\usr\sap\put` must be on a local disk. This means that you cannot use the released drive that contains the directory `\usr\sap\<SAPSID>`.

   If the `\usr\sap\put` directory already exists, check whether it still contains data from the previous upgrade. If this is the case we recommend that you back up at least `\usr\sap\put\log` for documentation purposes.

2. Make sure that the `\usr\sap\put` directory is empty before you start PREPARE.

**5.2.3 Checking the Database-Specific Requirements for PREPARE**

**Procedure**

Before you start PREPARE for the first time, you must meet certain database-specific requirements:

**DB2 UBD for z/OS**

- There must be 500 MB of free space for PREPARE in the database.

**DB2 UDB for UNIX and Windows, MS SQL Server, Oracle**

- There must be 500 MB of free space for PREPARE in the database. The space requirements for each tablespace are calculated by PREPARE.

**Informix**

- Make sure that you have at least 200 MB of free space available in the temporary dbspaces (TMPDBSx).

**MaxDB**

- PREPARE requires 800 MB of free space in the database. This corresponds to 100,000 pages.

**MS SQL Server**

- Check the login of the user `<SAPSID>ADM`.

   This security procedure was introduced with Release 4.5A. In this procedure, the SAP executable logs on to the SQL Server database under the Windows user under which it
is called. Therefore it is necessary that the MS SQL Server contains a login for each
Windows user under which SAP processes are started. These are usually the users
\texttt{<SAPSID>adm} and \texttt{SapService<SAPSID>}.

During the upgrade, the SAP tools use the Windows user \texttt{<SAPSID>ADM} to log on to
the database. This means that you must make sure before the upgrade that a login
exists for the user \texttt{<SAPSID>ADM} in the database and that it has the required settings.

Check the login in the SQL Enterprise Manager as follows:

1. Start the SQL Server Enterprise Manager.
2. In the Console Root tree, choose
   \textit{Microsoft SQL Servers} \rightarrow \textit{SQL Server Group} \rightarrow \textit{<DB server>} \rightarrow \textit{Security}
3. Choose \textit{Logins}

The right-hand side of the screen displays the available logins. The login for the
user \texttt{<SAPSID>ADM} must exist here. Check that the \texttt{<SAPSID>} database is the
default database for this login and that \textit{System Administrators} is set as the
server role. If you are upgrading an MCOD system, make sure that the default
database name corresponds to the \texttt{rsdb/mssql/dbname} parameter (or \texttt{dbs/mss/dbname}
in newer releases). If necessary, correct the settings and confirm your changes with \texttt{OK}.

If there is no login for the user \texttt{<SAPSID>ADM}, you have to create one:

a) From the menu, choose \textit{Action} \rightarrow \textit{New Login}.
The system displays the \textit{SQL Server Login Properties - New Login}
screen.

b) On the \textit{General} tab:
   - Enter the name of the login: \texttt{<SAPSID>ADM}.
   - For authentication, choose \textit{Windows NT}. Enter the
     accompanying domain and choose \textit{Grant Access}.
   - Under \textit{Defaults}, specify the \texttt{<SAPSID>} database as the default
database.
     If you are upgrading an MCOD system, the name of the
database in your system may not be \texttt{<SAPSID>}. For the correct
     name, see the \texttt{rsdb/mssql/dbname} parameter (or \texttt{dbs/mss/dbname}
in newer releases) in the default profile.

c) On the \textit{Server Roles} tab, select the server role \textit{System Administrators}.
d) Confirm your selection with \texttt{OK}.

- Check the environment variables.
  a. Check whether the following environment variables exist and are set correctly.
     To check the value of a variable execute \texttt{set <variable name>} in the
     command prompt.
     - \texttt{MSSQL_SERVER} must contain the database host. If you use a named
       instance, it must have the value \texttt{<hostname>\<instancename>}.
     - \texttt{MSSQL_DBNAME} must contain the database name of your system.
     - \texttt{MSSQL_SCHEMA} must be set to \texttt{<SID>} in lower case only if your start
       release is an MCOD system. If it is not (in most cases) the variable
       should not exist or must be set to \texttt{dbo}.
b. If necessary, set the missing variables in the user environment in one of the following ways:

- Execute the command `set <variable name>=<value>` in the same command prompt where you will start PREPARE
- Set these environment variables via the Windows control panel by choosing System → Advanced.

Incorrect values in these environment variables lead to errors during the upgrade. Make sure that these environment variables and the corresponding profile parameters have the same values.

- Check the profile parameters in the default profile and in the instance profile

The default profile is located in `usr\sap\<SID>\sys\profile\DEFAULT.PFL`.

The instance profile is located in `usr\sap\<SID>\sys\profile\<SID>_DVEBMGS<NN>_<HOST>`.

Check whether the following profile parameters are set:

- `dbms/type` must have the value `mss`.
- `dbs/mss/server` must contain the database host. If you use a named instance, it must have the value `<hostname>\<instancename>`.
- `dbs/mss/dbname` must contain the database name.
- `dbs/mss/schema` must be set to `<SID>` in lower case only if your start release is an MCOD system. If it is not (in most cases) the parameter should not exist or must be set to `'dbo'`.
- `SAPDBHOST` must contain the database host only without instance name in case you use a named instance.

Incorrect values in these profile parameters leads to errors during the upgrade. Make sure that these profile parameters and corresponding environment variables have the same values.

End of MS SQL Server
5.2.4 Importing the Latest SPAM Update (Source Release 4.x and Higher)

Use

As of Basis Source Release 4.0B, PREPARE calls functions of the SAP Support Package Manager (transaction SPAM) to include add-on updates and Support Packages in the upgrade. The current version of these functions must exist in your SAP system before the upgrade.

Procedure

Import the latest SPAM update for your source release before you start PREPARE.

For more information about importing a SPAM update, see the online help in transaction SPAM, or the online documentation for the corresponding Basis source release:

- **Basis Release 4.x**

- **Basis Release 6.10 to 6.30**

5.2.5 Windows NT 4.0: Checking the Consistency of the Host Name

Use

For all references to the host names in the SAP system, you need to check whether you need to enter the host name in uppercase or lowercase letters. If the host name is inconsistent, problems occur in the phases PROFCHK and RFCCHK. When you enter the host name, you must use the TCP/IP host name.

Procedure

Execute the following steps to check how host names are used:

1. Determine the TCP/IP name, by choosing:
   
   Start → Settings → Control Panel → Network → Protocols → TCP/IP Protocol → Properties → DNS → Host Name

2. Check the SAP profiles:

   All references to the host name in SAP profiles (for example, rdisp/btcname, SAPDBHOST, SAPLOCALHOST...) must contain the TCP/IP name. The only place where uppercase and lowercase letters are not important is the SAPGLOBALHOST parameter.
If you have made corrections to the SAP profiles, stop the SAP system and the SAP Service and start them both again.

3. Check the entries in the file `\etc\hosts`:

   Edit the file
   `%WINDIR%\system32\drivers\etc\hosts`

   We recommend that you maintain all the addresses and host names of all the SAP servers in the grouping in the local file `hosts`.

   Also insert an entry for the IP address and the TCP/IP name of your computer according to the following convention:
   `<IP address> <TCP/IP host name>`

   Delete any ALIAS entries that assign the host names in a different case lettering than the ALIAS for your IP address.

   Example of what you should not use:
   `155.56.172.17 pccpq1 PCCPQ1`

4. Use transaction SM51 to check the host name.

   The host names in the first and second columns must be identical and must match the TCP/IP host name.

   The output could appear as follows:
   `pn0014_KKK_10 pn0014 Dialog Update Enqueue Batch`

   If the first parameter is not correct, check step 2 again (Check the SAP profiles). If the second parameter is not correct, check the entries made under point 3 (Check the entries in the file `\etc\hosts`).

5. Check the operation mode definition:

   Check the case lettering of your host name in the definition of your operating types. To do this, call transaction RZ04 and make sure that the TCP/IP name is always referenced.
5.2.6 Starting PREPARE for the First Time

Use

You can execute PREPARE with the Upgrade Assistant or in scroll mode. We recommend that you use the Upgrade Assistant.

⚠️ When you enter passwords in scroll mode, the text of the entry will not be encoded.

To copy and unpack the Upgrade Assistant from the DVD, you must start PREPARE once directly from the DVD.

Prerequisites

- You have met the requirements for PREPARE [page 94].
- You have made the database-specific preparations for PREPARE [page 97].
- The database and the SAP system have been started.

Procedure

1. Mount the Upgrade Master DVD.
2. Log on to the host on which the central instance is running as user <SAPSID>ADM.
3. In the Windows NT Explorer, change to subdirectory \UM<x>\NT\I386 on the DVD drive. Start PREPARE.EXE.

   This creates a directory \<upgrade directory>\ua, into which the Upgrade Assistant is unpacked.
4. Decide how you want to continue.

   - **EXIT** (default value): This ends the PREPARE program. You can restart PREPARE [page 105] using the Upgrade Assistant or the scroll mode.
   - **SERVER**: Use this option if you want to continue with the PREPARE program using the Upgrade Assistant in another window. To start the Upgrade Assistant, proceed as follows:
     i. Start the Upgrade Assistant Server [page 103].
     ii. Start the Upgrade Assistant GUI [page 103].
     iii. Start the Upgrade Assistant [page 104].
     iv. In the Upgrade Assistant menu, choose Administrator → Connect UA Server to R3up.
   - **SCROLL**: You continue with the PREPARE program using the scroll mode.
5.2.7 Starting the Upgrade Assistant Server

Prerequisites

You must have started the PREPARE program once from the DVD. This creates the ua subdirectory in the upgrade directory and unpacks the Upgrade Assistant in this directory.

Procedure

1. Open a new window at the operating system level as user <SAPSID>ADM.
2. Enter the following command:
   ```
   jview /cp <upgrade directory>\UA\ua.jar UaServer
   ```
   Depending on your Java installation, you have to replace the jview character string with java in the command.

5.2.8 Starting the Upgrade Assistant GUI

Prerequisites

The Upgrade Assistant Server [page 103] is active.

Procedure

Starting the GUI from the Internet Browser

- To start the GUI from a browser, enter the following Internet address:
  ```
  http://<host name>:4239/ua/UaGui.html
  ```
  Replace <host name> with the name of the host on which the Upgrade Assistant Server is running. You need to enter the full Internet name, for example:
  ```
  w1156.wdf.sap-ag.de
  ```
- To display the phase list, upgrade documentation, and additional information about the upgrade, enter the following URL:
  ```
  http://<host name>:4239
  ```
  From this page, you can also start the Upgrade Assistant GUI using the relevant link.

Starting the GUI on Windows Hosts

Start the GUI in a command prompt as follows:

- When using the Java Software Development Kit (SDK)
  ```
  java -cp <UaGuiDir>\uagui.jar UaGui
  ```
• When using the Microsoft Virtual Machine
  jview /cp <UaGuiDir>\uagui.jar UaGui
• If you are using the SUN JDK:
  java /cp <UaGuiDir>\uagui.jar UaGui

5.2.9 Starting the Upgrade Assistant

Prerequisites
The Upgrade Assistant Server and the Upgrade Assistant GUI have already been started.

Procedure
If you did not start the GUI from an Internet browser, a connect screen appears:

1. In the Host name field, enter the name of the host where the central instance is running.
   
   ![Example of the format for the host name:]
   hw1156
   hw1156.wdf.sap-ag.de
   155.56.202.33
   If you want to start the Upgrade Assistant GUI and the Upgrade Assistant Server on the same host, you can leave the Host name field empty.

2. Do not change the default value 4241 in the Port number field.

3. Choose Connect.
   A logon screen appears.

4. In the fields User name and Phone number, enter your personal information.

5. In the Password field, you must enter a password that specifies whether the GUI has the role of the administrator or the observer. The initial passwords for the two roles are as follows:

<table>
<thead>
<tr>
<th>Role</th>
<th>Initial Password</th>
</tr>
</thead>
<tbody>
<tr>
<td>Administrator</td>
<td>admin</td>
</tr>
<tr>
<td>Observer</td>
<td>observer</td>
</tr>
</tbody>
</table>

6. Choose Login.
   After you log on, the main menu window appears.
5.2.10 Restarting PREPARE

Use

If you want to execute PREPARE again, you must restart it.

If you cannot use the Upgrade Assistant for some reason, or you do not want to, you can execute PREPARE in scroll mode. The commands for starting PREPARE for the first time [page 102] are the same for display mode Server (Upgrade Assistant) and display mode Scroll, since PREPARE is started from the DVD. When you restart PREPARE, the commands for using the Upgrade Assistant and the scroll mode are different.

Procedure

Using the Upgrade Assistant

1. Make sure that the Upgrade Assistant Server is active.
2. Start an Upgrade Assistant GUI [page 103].
3. Log on to the Upgrade Assistant GUI.
4. Choose Administrator → Start PREPARE.

Using the Scroll Mode

1. Go to the directory `\usr\sap\put\exe`.
2. Enter the following command:

   `prepare repeat`

   If you want to start PREPARE in a telnet session, use the following command:

   `prepare telnet`

   In this case, PREPARE does not open a new window during PREPARE.

5.2.11 Resetting PREPARE

Use

If you have already executed PREPARE more than once, but do not want to upgrade the system, then you must reset PREPARE.

⚠️ If PREPARE is between the phases TOOLIMPD1 and NPREPCRE0 in the Import module, you cannot reset PREPARE. In this case, you must execute the remaining phases up to at least phase NPREPCRE0 before you reset PREPARE.

Prerequisite

You are logged on as user <SAPSID>ADM.

Procedure

1. Go to the subdirectory `exe` of the upgrade directory.
2. Enter the following command:
   \texttt{R3up reset prepare}
3. Delete the contents of the upgrade directory so that it has the same state it had the first time \texttt{PREPARE} was started [page 102].

### 5.2.12 Importing Software After Starting \texttt{PREPARE}

**Use**

After you have started \texttt{PREPARE}, you may need to import software such as SAP Support Packages, languages, or add-ons (and add-on updates).

**Procedure**

1. \texttt{Reset PREPARE [page 105]}. 
2. Import the required software.
3. Start \texttt{PREPARE} again \texttt{from the DVD [page 105]} and repeat the mandatory and optional modules.

### 5.2.13 Making the First Entries for \texttt{PREPARE}

**Use**

\texttt{PREPARE} needs certain information from you so that it can run the \texttt{PREPARE} modules. Default values appear where possible. Confirm or change the default values. Certain data carriers are also required. For a list of the necessary entries for the individual \texttt{PREPARE} modules see below. For a complete list of the modules, see the \texttt{PREPARE phase list [page 228]}. 

**Procedure**

1. Enter the SAP system ID.
2. Enter the database on which the SAP system is running.
3. Enter the directory on which you have mounted the Upgrade Master DVD.
4. Enter the path to your upgrade directory.
   
   If this is the first time you start \texttt{PREPARE}, the upgrade control data is imported from the DVD.
   
   After the import has completed, display the screen for selecting the \texttt{PREPARE} modules.
5. On the screen, for selecting the \texttt{PREPARE} modules, select which modules you want \texttt{PREPARE} to run through.
Some modules are mandatory, some are optional. **PREPARE** must run through all mandatory modules before you start the actual upgrade. A successfully executed module has the status succeeded.

### 5.2.14 Making Entries for the Parameter Input Module

#### Use

**PREPARE** needs certain information from you so that it can run the *Parameter Input* module. Default values appear where possible. Confirm or change the default entry. For a list of the necessary entries for this **PREPARE** module, see below.

#### Procedure

Enter the following information or confirm the existing entries when prompted to by **PREPARE**:

- **Name of the SAP system** (<SAPSID>)
- **Host name of the central SAP server** (in an MSCS cluster, the virtual name of the SAP system resource).
General Upgrade Information

- Number of the instance, for example, 00
- If you decide to import the data from a CD, enter the letter of the drive containing your SAP Kernel CD
- Instance name of the database

**DB2 UDB for z/OS**

Enter the name of the DB2 subsystem as the instance name of the database.

**End of DB2 UDB for z/OS-specific explanations**

- Host name of the database server – in an MSCS cluster, the virtual host name in the cluster (MSSQL and MaxDB only)

**DB2 UDB for z/OS**

- Dataset for LOAD library
  Enter the name of the dataset that contains the LOAD library.
- Dataset for DSNTIAD library
  Enter the name of the dataset that contains the DSNTIAD library.
- Plan for DSNTIAD library
  Enter the name of the path that bound DSNTIAD.
- VCAT (High Level Qualifier)
  Enter the VCAT (High Level Qualifier) of the DB2 subsystem.
- SMS (Storage Management Subsystem)
  Specify whether the DB2 subsystem is **SMS managed**.
- Stop before execution of the JCL job
  Several JCL jobs are executed during **PREPARE** and the upgrade.
  Here you have to decide whether you want the upgrade to stop before the JCL job is executed, so that you can make corrections to the job.
  You always have this option if the JCL job produces errors.
- JCL Submission Service test
  Make the following entries as part of the JCL Submission Service test:
  - TCP/IP name of the database host
  - MESSAGECLASS
  - z/OS user
  - Password of the z/OS user
- Inspection of sample jobcard
  Check the jobcard `<Upgrade Directory>`\`\bin\HEADER.JCL` *(in data sharing system, the entry **JOBPARM SYSAFF** needs to be specified).*

**Source Release up to and including 4.6D only: DB2 Connect**

Specify the following DB2 Connect related parameters:
- User ID that connects to DB2 (plus password)
- Home directory of the DB2 Connect instance
o DDF Location name of the DB2 subsystem

o DDF Communication Port of the DB2 subsystem

Subsequently, the upgrade tool creates catalog entries, binds DB2 Connect and finally checks the database connection using R3trans.

• Basis Source Releases 3.1x to 4.5B only: 4.6D ICLI Connection

A 4.6D ICLI connection is set up, which is needed for the upgrade tools in directory <upgrade directory>\tools. You must enter the following:

o Port number

You are prompted for a port number for the 4.6D ICLI server. This instance is needed during the upgrade only, in addition to the instance of the source release's ICLI server. You can stop it again after the upgrade.

o User who starts the ICLI server

Enter the name of the user who starts the 4.6D ICLI server. The default name is ICLIRUN.

o High Level Qualifier for 4.6D ICLI-PTF

As part of the installation of the 4.6D ICLI server you have to enter the High Level Qualifier under which the 4.6D ICLI PTF was installed.

After the (successful) submission of BIND and GRANT jobs you are prompted to start a 4.6D ICLI server. Once, that is done the connection is tested using R3trans.

During an upgrade several database connections are employed. For each connection a different environment setting is used, and you can switch between these environments using the following environment scripts:

- SOURCE.BAT: for the source system
- TOOLS.BAT: for 4.6D executables located in <Upgrade Directory>\tools (specified in one of the next steps)
- TARGET.BAT: for the target system
- SHADOW.BAT: for the shadow system (temporarily installed during the upgrade)

These environment scripts are particularly helpful if you need to call stand-alone tools like tp, R3trans, R3load, or db2radm (for instance, if you need to check whether a database connection works).

Enter the following commands:
1. cd <upgrade directory>
2. bin\SHADOW.BAT (switches to shadow environment)

End of database-specific explanations

• Mount directories for the data carriers

If you have only one DVD drive, you do not have to enter any other mount directories. Whenever necessary, R3up prompts you to specify a mount directory or to change the data carrier. If you are working in scroll mode, choose ENTER to skip the prompts for extra mount directories.

If you have more than one DVD drive or if you are able to copy the contents of the DVDs and CDs to disk, enter all the mount directories used. You can enter up to 24 mount directories and change your entries each time you start PREPARE or R3up.
The prompt for the mount directories occurs during the **EXTRACTKRN_PRE** phase, which runs during **PREPARE** and during the **INITPUT** phase, which runs during the upgrade. You are only prompted for the mount directories, which means that it does not matter where the data carriers are mounted.

When you enter the mount directories, you can use a wildcard in the last part of the mount directory path, for example, /mnt/*dvd*. R3up fills the mount directory entry fields with all directories that the wildcard matches. Any duplicate entries found by the wildcard are removed automatically.

If you entered mount directories for all data carriers required by the upgrade, and the program finds the right directory, you are not prompted to enter mount directories. If you do this, you can ignore all further instructions to enter mount directories in this documentation.

If you do not have enough DVD disk drives, you can copy the contents of each DVD and CD to separate directories on your hard disk (providing you have sufficient disk space). Specify the names of these directories when the program prompts you to enter the mount directories.

In addition to the **Upgrade Master DVD**, **PREPARE** and **R3up** require other data carriers. For a list of the data carriers, see this section in the product-specific part of this documentation.

The other data carriers in the upgrade package are not required by **PREPARE** or **R3up**. They are used by other programs related to the upgrade, for example, for importing a new version of the database system.

- **Password of user DDIC** in the system, client 000
  
  This password is needed for the RFC connection to the SAP system. Check whether the password is correct by logging on to the SAP system. **R3up** asks you to verify the password by entering it a second time.

  During the upgrade, you must unlock the user. After the upgrade, the user will **not** be locked again automatically.

  Usually, it is not necessary to change the password of user DDIC during the upgrade. If you do change the password, you have to change it in the original system, the shadow system, and the **R3up** parameter.

- **Host name of the background server**
  
  There is usually a background service available on the central instance. You can check this with transaction SM51.

  However, in larger systems, the background service may be elsewhere to improve load distribution. In this case, enter the host name and the name of the relevant application server. Also make sure that the upgrade directory is mounted on the host with the background service, and that the background server can process background jobs of class C.

  The server you select must be available for background operations round the clock. Check the active operation modes with transaction SM63 to find out if it satisfies this requirement.

- **Number of parallel processes during production operation**
  
  This is the number of background and activator processes that can run in the system during production operation. We recommend a value of 1. If you have enough main memory, you can use up to three processes.
• Number of parallel import processes

The number of parallel processes used by R3trans to import data into the database. We recommend 3 processes for machines with 512 MB (and greater) main memory. Up to four parallel import processes are possible for multiprocessor hosts with sufficient main memory.

**DB2 UDB for z/OS**

Up to 8 parallel import processes are possible for multiprocessor hosts with sufficient main memory.

*End of DB2 UDB for z/OS-specific explanation*

• Longest synchronization time of the buffers on all application servers

Usually, 60 seconds is entered for the **bufreftime** parameter in the instance profiles of the servers.

**⚠️** If you have installed multiple instances, you must specify the largest value of all the profiles. R3up must wait for this length of time at certain points during the upgrade so that all the instances are synchronized. If the time entered is too short, time intervals might occur in which users can make unchecked changes.

• Directory for the local system log

This is the local system log of the central instance. The format of the system logs for the new release is not compatible with all previous versions. For this reason, the local system log of the central instance and the central system log are renamed in a kernel switch (**KX_SWITCH** phase).

The system logs are recreated the next time the SAP system is started with the new release.

**💡** If you run your SAP system with multiple application servers, you must manually rename the local system log of these (remote) servers (see Upgrading the Application Servers [page 169]). This action cannot be performed automatically.

• Password of the operating system user for installing the shadow instance

The **SAP<SAPSID>_<shadow instance no.>** service is created during PREPARE for locally installing the shadow instance. This service is started by the same operating system user as the central instance. For source releases lower than 4.6A, the SAP service is replaced by the new service with the DCOM interface during the upgrade.

Enter the password for the operating system user. R3up then asks you to verify the password by entering it a second time.

**⚠️** If you change the password for the operating system user, remember that in a standard installation, the SAP service or the SAPOSCOL service run under the same user. This means that you also have to change this logon data accordingly. Otherwise problems occur when the SAP service is started after the kernel switch.

• The **MCOD_CHK_INI** phase asks you whether more than one SAP system is installed in your database, which means that you are upgrading an MCOD system [page 78].
5.2.15 Making Entries for the Initialization Module

Procedure

Phase TOOLVERSION_INI

Before you can perform the upgrade, the tools in the SAP kernel directory \usr\sap\<SAPSID>\SYS\exe\run of your Basis source release must have a version [page 217] and patch number released for the upgrade.

In the TOOLVERSION_INI phase of the Initialization module, PREPARE checks the SAP kernel patch number, the tp version, and the date of R3trans. If necessary, it prompts you to switch the SAP kernel or tools to a version and patch number released for the upgrade.

The subsequent PREPARE modules require the version of the SAP kernel, released for the upgrade, since older versions contain errors that cause problems in PREPARE.

⚠️ As of Basis Source Release 4.5B, apart from the disp+work package, you also need the corresponding database library for the SAP kernel.

⚠️ Do not replace programs in the \preexe and \tools subdirectories of the upgrade directory. You may only do this if you get approval from SAP Support.

SAP Kernel

If your current SAP kernel does not fulfill the requirements of PREPARE, proceed as follows:

1. Before switching the SAP kernel, back up the existing kernel directory.

⚠️ When you switch the SAP kernel, you overwrite all files and subdirectories in directory \usr\sap\<SAPSID>\SYS\exe\run. For more information, see the PREPARE log CHECKS.LOG.

2. Switch the SAP kernel as described in the following SAP Notes:

<table>
<thead>
<tr>
<th>Source Release</th>
<th>SAP Note</th>
</tr>
</thead>
<tbody>
<tr>
<td>3.1I</td>
<td>102445</td>
</tr>
<tr>
<td>4.0B</td>
<td>102461</td>
</tr>
<tr>
<td>4.6x</td>
<td>318846</td>
</tr>
<tr>
<td>6.10</td>
<td>502999</td>
</tr>
<tr>
<td>6.20</td>
<td>664679</td>
</tr>
</tbody>
</table>

⚠️ Before continuing the upgrade, make sure that the SAP kernel has at least the minimum required patch number.

3. After you have switched the SAP kernel, repeat the Initialization module to change its status to succeeded.
Tools R3trans and tp

The upgrade may require a certain version for tools R3trans and tp. For the required versions of these tools, see SAP Service Marketplace at service.sap.com/swdc → Download → Support Packages and Patches.

You can also use the SAP kernel programs that are on the upgrade SAP Kernel DVD. For more information about the folders they are stored in, see the CHECKS.LOG file.

For more information on how to install the tools, see SAP Note 19466.

After you have replaced the tools, repeat the Initialization module to change its status to succeeded.

Phase ADDON_INFO

For most of the add-ons produced by SAP, there are special SAP Notes containing information on the upgrade strategy. In the ADDON_INFO phase, R3up writes the SAP Note numbers for your upgrade into the CHECKS.LOG file. R3up lists the general add-on Note as well as, if possible, specific add-on upgrade Notes to the add-ons installed.

Before the upgrade, check all SAP Notes listed in the CHECKS.LOG file. If there are add-ons installed in your SAP system for which there is no information in one of the listed SAP Notes, refer to the add-on producer for information.

Database-Specific Actions

DB2 UDB for z/OS

- Depending on your source release, you may need to create new stogroups in the database, or extend existing stogroups. To do this, you need information about the local hardware configuration (VOLIDs), if you do not use SMS.

  The volumes.pfl file does not exist when PREPARE starts. In the first SPACECHK phase, you are prompted to create this file using the sample file volumes.smp. The volumes.pfl file contains the disk ID.

  R3up creates the following sample file volumes.smp in the subdirectory bin of the upgrade directory.

```
#------------------------
# FILE: VOLUMES.SMP
#------------------------
# VOLUME-ID
volume DB2069
volume DB206A
volume DB206B
```

You must copy this sample file as volumes.pfl to the subdirectory bin of the upgrade directory, and then adapt it to the local hardware configuration. Enter volume for each disk, followed by the disk ID.

- R3up performs extensive database specific checks in the DBPREP_CHK phase.

End of DB2 UDB for z/OS-specific explanation
5.2.16 Making Entries for the Import Module

Procedure

Phase TOOLFIX_CHK

To ensure stability and high performance of the upgrade tools, we provide upgrade correction packages for all upgrades. In this phase, you are prompted to copy correction package FIX_<product name>.SAR to the upgrade directory.

For more information about the procedure and the availability of correction packages, see SAP Note 663240.

Phase DB_ACTION_RUN_PRE

DB2 UDB for UNIX and Windows

To avoid lock situations and any resulting problems during the upgrade, you now have the chance to update the database statistics for tables and indexes.

You can skip this step if you fulfill the following requirements:

- You update the statistics regularly.
- You already generated statistics the last time you ran PREPARE.

At the beginning of R3up (actual upgrade), you have another opportunity to update the statistics.

You have the following options:

- MEDIUM = tables with cardinality = -1 or with cardinality = 0 (and any corresponding indexes)
- HIGH = all tables (and any corresponding indexes). Long runtime.

If you do not know the state of the database statistics, choose MEDIUM.

End of DB2 UDB for UNIX and Windows
5.2.17 Making Entries for the Extension Module

Procedure

Phase LANG_SELECT

When you are prompted by PREPARE, mount the necessary directories of the language DVD. You need to do this even if only the standard languages English and German are installed in your system.

If you have installed languages other than the standard languages, you have the option of excluding some of these languages from the upgrade. The standard languages are always imported.

⚠️ If you exclude a language, you cannot work in this language after the upgrade.

⚠️ If you perform the upgrade in a Terminal Server Session, you also have to mount the language DVD for accessing the SAP Kernel outside of the Terminal Server Session. To do this, mount the language DVD with the console as user <SID>ADM, or use PCAnywhere. You can also copy the contents locally to the hard drive, and specify the path of the local directories to R3up.

In principle, it is possible to install additional languages during the upgrade. For more information, see Importing Additional Languages [page 93].

Phase UPLOAD_REQUEST

PREPARE prompts you to put all the packages such as add-on upgrade packages (SAINT packages) or Support Packages that are required for the upgrade in the specified directory.
If you want to include add-on upgrade packages (SAINT packages), Support Packages, or a SPAM update in the upgrade, proceed as follows:

1. Download the Support Packages and the SPAM update of the target release.
   You can download the Support Packages in one of the following ways:
   - From SAPNet – R/3 Frontend using transaction SPAM. If you choose this method, skip points 2 through 4 and proceed from point 5.
   - From the SAP Service Marketplace, following the instructions in SAP Note 83458
   - From a Support Package or add-on CD, following the instructions on each CD
2. Log on as user <SAPSID>ADM.
3. Go to directory <drive>:\usr\sap\trans.
4. Unpack the archive that contains the Support Packages with the following command to:
   SAPCAR -xvf <CD_DIR>:\<PATH>\<ARCHIVE>.SAR.
   If you want to download the archives from a Support Package or add-on CD, you can find details about the archives and their paths in the README file on the CD.
5. Check whether the unpacked Support Packages are in the EPS inbox of your transport directory (<drive>:\usr\sap\trans\EPS\in).
If you want to include Conflict Resolution Transports as well as Add-On Support Packages for add-on components, make sure that these packages are also in the EPS inbox.

When you select add-ons in the IS_SELECT phase, or when you select Support Packages in the BIND_PATCH phase, the corresponding packages appear as the default value.

Source Release 4.x and higher

Phase IS_SELECT

PREPARE determines all the add-ons that are contained in the SAP system and prompts you to decide how to proceed.

All add-ons that are included on the Upgrade Export DVD(s) and can be updated to a new release appear on the selection screen with default status INST/UGP WITH STD CD. For these add-ons, there is no need to make a new decision, unless you want to include a newer version of the add-on in the upgrade. For add-ons with status UNDECIDED, you have to decide how to proceed.

There are two different ways to proceed, depending on the add-on status:

- Add-on with status INST/UGP WITH STD CD:
  The add-on is included on the upgrade DVDs. Depending on whether the software components required by the add-on must be kept the same or must be updated, the
add-on can also remain unchanged or may have to be updated. If you decide to update the add-on during the upgrade, the following selection screen appears:

You have the following alternatives:

- **Upgrade with an add-on-specific CD** (*Upgrade with Add-On CD*)
  When you choose this alternative, you are asked to insert the corresponding CD. The data is copied to the upgrade directory.

- **Upgrade with SAINT packages** (*Upgrade with SAINT package*)
  The packages must be in transport directory `\usr\sap\trans\EPS\in`.

- **Upgrade to the version on the Upgrade Export DVD** (*Upgrade to version on std. Upgrade CD*)
  This alternative is valid only if there is an add-on on the Upgrade Export DVD(s). Once you have chosen this alternative, you do not need any additional CDs or packages for the add-on.

- **Add-on with status UNDECIDED:**
  These are add-ons that were installed on the source system. They are optional. When you decide about the add-on, the following selection screen appears:
For this type of add-on, there are some additional options:

- **Keep the present version of the add-on (Keep with vendor key)**
  
  Only choose this alternative if the vendor of your add-on has confirmed that you can do so without losing data. You must enter a password if you choose this alternative.

- **Keep the present version of the add-on (Keep your version)**
  
  If none of the underlying software components experiences an update, or if the add-on already has a higher version than the one in the export, then this add-on is automatically kept, provided you do not include an update.

- **Delete the add-on (Delete).**
  
  Only choose this alternative if the vendor of your add-on has confirmed that you can do this without problems, and if the present version of the add-on can also operate in the new context. You may require a password.
R3up prompts you to perform manual follow-up activities.

- Delete the add-on with CD (*Delete with CD*).

If a delete CD is available for the add-on, use it since, among other things, it deletes database objects that exist for this add-on.

To complete phase **IS_SELECT** successfully, none of the add-ons may have status **UNDECIDED**.

### Source Release 3.1I

For Source Release 3.1I, PREPARE runs through the **IS_CHK** and **IS_READ** phases instead of the **IS_SELECT** phase.

#### Phase IS_CHK

You are asked if any add-ons are installed that are not automatically recognized. If you have not installed any add-ons, confirm the prompt with **nothing else**.

#### Phase IS_READ

All add-ons appear that are found in the **IS_CHK** phase, and any add-ons that may have been added manually. The following alternatives are offered for each add-on:

1. **Upgrade the component with the add-on-specific CD (Upgrade with Add-On CD).**
   
   When you choose this alternative, you are asked to insert the corresponding CD. The data is copied to the upgrade directory.

2. **Keep the present version of the add-on (Keep (with vendor key)).**

   Only choose this alternative if the vendor of your add-on has confirmed that you can do this without losing data. You must enter a password if you select this alternative.

3. **Delete the add-on (Delete).**

   Only choose this alternative if the vendor of your add-on has confirmed that you can do this without problems.

#### End of Source Release 3.1I

### Phase PATCH_CHK3

This phase tests whether all Support Packages have been confirmed. Unconfirmed Support Packages are displayed on the screen and in the **PATCHOUT.LOG** file in the **log** subdirectory of the upgrade directory. Confirm these Support Packages with transaction SPAM.

If the source release contains Support Packages that are more recent than those in the delivered target release, a warning appears that informs you which Support Packages these are. All software components appear whose Support Package level is more up-to-date than the status of the software components on the *Upgrade Export* DVD(s).

Always include all available Support Packages for the target release, and all released Basis Support Packages. This means that your system is completely up-to-date after the upgrade.
If you use an add-on component, you can find information about including the corresponding Add-On Support Packages or Conflict Resolution Transports in the SAP Note for the add-on supplement CD.

If `R3up` displays a warning that your Support Package level of the source release is too up-to-date, and you want to include the corresponding Support Packages of the target release, you must do this in the next phase `BIND_PATCH`. You can include the Support Packages for multiple software components in this phase.

**Phase BIND_PATCH**

**Source Release 3.1I**

You can only include Support Packages for the main software components (SAP_BASIS, for example).

**End of Source Release 3.1I**

You can include the Support Packages for the target release in this phase.

If the release of a component does not change during the upgrade, the Support Packages previously installed for this component are automatically kept and do not have to be included again. Even another adjustment of the modifications contained within using transaction SPDD or SPAU is not required. You can also include additional Support Packages for this component.

To include Support Packages, proceed as follows:

1. If you want to include Support Packages for your various software components, answer *Yes* to the prompt about including Support Packages in the `BIND_PATCH` phase.

   If you did not download the Support Packages for the target release during the `UPLOAD_REQUEST` phase, do this now. Proceed as described in steps 1 to 5 in the description of phase `UPLOAD_REQUEST` above.

2. In the column *Support Package Level select*, enter the Support Package level you want for your various software components.

   When the `BIND_PATCH` phase is started for the first time, `PREPARE` tries to find a default Support Package queue. It first searches for a package inclusion file of a previous upgrade. If it can find one in the `save` subdirectory of the upgrade directory, `PREPARE` checks whether this package inclusion file contains a selection valid for the current upgrade. If the selection is valid, you can use it as default.

   If there is no package inclusion file from a previous upgrade, `PREPARE` calls the SPAM Patch Queue Calculator. It tries to generate a Support Package queue of all Support Packages that you have uploaded. If it can generate a valid queue, you can use it as default.
Column **Support Package Level min** contains the minimum Support Package level required for a component to meet the import prerequisites of the add-ons in the IS_SELECT phase.

Column **Support Package Level equi** contains the equivalence Support Package level. This is the Support Package level of the target release, which corresponds to the Support Package level of the source release. To avoid data loss, the Support Package level of the target release must not be lower than the equivalence Support Package level.

You no longer need to reset PREPARE to reduce the number of Support Packages that you want to include. All you need to do is overwrite the default Support Package level.

If you want to cancel the selection for a software component completely, delete the relevant entry if you are using the Upgrade Assistant, or enter **NONE** if you are using scroll mode.

Column **Support Package Level current** contains the highest Support Package level that is currently included. To find out the current state of the SAP system, PREPARE checks the following Support Package level information:

a. Support Package level that has already been installed in the source system. This only applies when the release of the SAP component does not change during the upgrade (component upgrade procedure).
b. Support Package level that is delivered with the upgrade DVDs (for example, a Support Release level)

c. Support Package level that has already been selected and confirmed by the customer

3. Apart from including Support Packages, you can also include the latest SPAM update for the target release. This prevents any error messages resulting from the fact that your SPAM update in the source release is newer than the SPAM version on the upgrade DVD. It can also save you from having to import the latest SPAM update immediately after the upgrade. PREPARE automatically looks in the EPS inbox for a current SPAM update and offers it for inclusion.

4. In addition, you can include a single change request. In certain situations, you can use a single change request to avoid losing data. The modification adjustment function ignores this request.

⚠️ Using the single change request function is risky. Only use this function if the owner of the request can guarantee that it is compatible with the upgrade.

💡 Apart from the single change request and the requests for the modification adjustment, there is no other way of importing a request into the system before activation, or during the adjustment of the ABAP Dictionary objects.

5. When you confirm the confirmation prompt, you integrate all Support Packages up to the specified level into the upgrade for this component.

It may take a few minutes to unpack the Support Package data.

You can include any necessary Conflict Resolution Transports (CRTs) in the upgrade. Any Support Packages that you cannot include in the upgrade must be imported into the system after the upgrade.

Phase ADJUSTPRP

If you want to execute PREPARE in a target system and you made preparations for an automatic modification adjustment in the first system, you are prompted to choose a request.
5.2.18 Making Entries for the Installation Module

Use

All tables of the SAP Web Application Server are needed as shadow tables to operate the shadow system. The Installation module prepares the shadow instance.

You decide whether to run the central instance and the shadow instance on the same host or on different ones. If you install the shadow instance locally, PREPARE automatically creates the SAP Service, required profiles, directories, programs, and files for the shadow instance in the Installation module. If you run the shadow instance remotely, the dialog instance that already exists is adjusted for use as the shadow instance.

SAP recommends that you install the shadow instance locally, provided that this does not cause a bottleneck of resources when you run both instances at the same time.

Prerequisites

If you want to run the shadow instance on a separate host, follow the instructions in SAP Note 430992 before you start the Installation module.

Procedure

Phase INITSHD

- Enter the instance number of the shadow system when you are prompted by PREPARE.
  - If you install the shadow instance locally using R3up, you have to enter an instance number that has not yet been used in your system landscape.
  - If you run the shadow instance remotely, you have to enter the instance number of the dialog instance that you want to adjust to become the shadow instance.

**DB2 UDB for z/OS**

The shadow instance cannot be run on a remote application server.

End of DB2 UDB for z/OS

- If you run the shadow instance remotely, you can determine another host for the shadow instance in this phase.

**MaxDB**

On the application server the DB client software may have to be updated.

End of MaxDB

Proceed as follows:

a. Enter the host name of the server for the shadow instance.

b. Determine the path of the upgrade directory for remote access from the application server of the shadow instance. For example, enter the UNC path to the upgrade directory: \<HOST>\SHARE_PUT.

c. Install a license for the shadow instance.
   i. To do this, use saplicense -get on the other (remote) application server to get the hardware key. For more information, see SAP Note 94998.
Use `saplicense -install` to install a license on the central instance.

d. Continue PREPARE.

**Phase SHDINST_OS**

**PREPARE** performs operating system-specific actions in this phase:

1. `R3up` maintains the ports that are required for the shadow system in the file `%WINDIR%\system32\drivers\etc\services`.

2. If it is a local shadow instance, the SAP service is installed and started for the shadow instance.
   
   If it is a remote shadow instance, the existing SAP service is adjusted and started for the shadow instance.

   ![Warning]

   If the SAP service for the shadow instance cannot be started, there may be a problem with the logon data in the INITPUT phase.

   If you change the password for the operating system user, remember that in a standard installation, the SAP service or the SAPOSCOL service run under the same user. This means that you also have to change this logon data accordingly.

**Phase SHDINST_CPY**

If you have made a backup of the save directory from a previous upgrade, you can now use the profiles for the shadow instance [page 193] that have been stored in the directory.

![Warning]

Only use the profiles if both upgrades have the same environment and use the same upgrade strategy.

If you want to use the shadow instance profiles, make sure that the save directory has been copied to the upgrade directory and confirm the prompt with Yes.

5.2.19 Making Entries for the MSCS Configuration

**Use**

In an MSCS configuration, the `CONFCHK` phase determines that the database and central instance are running on different servers and prompts you for the operating system of the database host. This prompt also appears if both are running on the same cluster server because, in a cluster, the database and the SAP System are assigned different logical host names.

**Procedure**

Enter the operating system for the database.
5.2.20 Evaluating the Results of PREPARE

Use

PREPARE [page 230] writes its results to the CHECKS.LOG file. This file is located in the log subdirectory of the upgrade directory. Each time you run PREPARE, it generates a header entry containing the text: Starting new execution of PREPARE modules <module name> at <timestamp>. This is followed by the PREPARE results.

The entries in the CHECKS.LOG file can be error messages, information or prompts for user action.

Procedure

Check the CHECKS.LOG file and perform any measures required by the information it contains. To make sure that all the requirements are met, you can choose certain PREPARE modules more than once. If the CHECKS.LOG file already exists, it is overwritten each time you execute a module again. Its contents are saved in the CHECKS.SAV file.

Most of the entries are self-explanatory. You can find information and troubleshooting procedures for entries that are not self-explanatory below:

- Your Windows NT dlls have been updated.
  Reboot your operating system before starting the upgrade.
  PREPARE has updated several Dynamic Link Libraries of Windows NT that contain SAP-specific corrections. You must restart the host before you start the upgrade so that the current DLLs are used.

- The buffers of your SAP system instance are not automatically validated.
  a. Make sure that parameter rdisp,bufrefmode has one of the following values in the DEFAULT.PFL profile of directory \usr\sap\<SAPSID>\sys\profile:

```
<table>
<thead>
<tr>
<th>Value</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>sendon,exeauto</td>
<td>Your SAP system (&lt;SAPSID&gt;) has multiple instances.</td>
</tr>
<tr>
<td>sendoff,exeauto</td>
<td>Your SAP system (&lt;SAPSID&gt;) has only one instance.</td>
</tr>
</tbody>
</table>
```

  b. Also make sure that parameter rdisp,bufrefmode is not set in the instance profile (usually <SAPSID>_DVEBMGS<INSTANCENUMBER>_<HOSTNAME>).

  If you have distributed application servers that do not use NFS to share access to the profile of the central instance, follow the procedure described above for each server.

  After making changes to the DEFAULT profile and the START profile you must start up the SAP service to activate the changes. It is not enough to just start the SAP system.

- Insufficient freespace in the database as follows

The new release needs more space in the database. The existing space in your database is not sufficient to import the data for the new release. For information on the extensions that you need to make, see the table that follows the message in CHECKS.LOG. Also add the space you need for any extra data that is created before you actually upgrade your system.
The procedure is described in the section Extending Free Space in the Database [page 221].

- In Release <rel> you applied the following unconfirmed patches to your system.

  There are unconfirmed Support Packages in your SAP system (such as Support Packages for the technical components SAP_BASIS or SAP_BW). Confirm these Support Packages before the upgrade using transaction SPAM.

- There are dependencies between Basis Support Packages included in phase BIND_PATCH and the patch level of the target release kernel in directory \usr\sap\put\exe.

  The disp+work needs at least patch level <number> or higher.

  Please proceed as described in note 211077.

  A Support Package included in the upgrade requires a different patch level for the SAP kernel. Proceed as described in SAP Note 211077.

- no write permission on <file name>:

  The specified file cannot be overwritten because the authorizations have not been set correctly. Correct this by changing the authorizations.

- Release these open transport requests and repairs:

  If you ignore open repairs, you could lose modifications.

  Your SAP system contains locked SAP objects in open repairs or requests. The numbers of these open repairs or requests are listed.

  Before you start the upgrade, you must release and confirm all the open repairs and requests listed by PREPARE, since the objects in them are locked. For more information, see Releasing and Confirming Open Repairs and Requests [page 226].

  If open repairs that do not belong to this system appear, then this system was created by a database copy. You cannot release these repairs in the normal way. For more information on releasing these repairs, see SAP Note 62519.

  To release and confirm these open repairs, you must log on to the system with the name of their owner. The list in CHECKS.LOG contains these names.

- Restart logs of DB conversions found.

  Outstanding DB conversions found.

  Your SAP system contains outstanding conversions and restart logs of terminated conversions. Clean these up as described under Cleaning Up Terminated Conversions in the DB Conversion Phases [page 203].

- Unresolved request found in TRBAT.

  .......

  TRBAT entry indicates that a batch job is running.

  .......

  TRBAT entry indicates that a batch job has finished.

  .......

  Corrupted TRBAT entry found.
The transport control program `tp` uses the table TRBAT to communicate with the SAP system. Entries found in this table by R3up may be the remains of a terminated or running import or export.

When you prepare the upgrade, locate any entries left over from imports or exports that terminated and clean them up. Do not delete entries made by running imports or exports during production operation.

First try to process the TRBAT entries from `\usr\sap\trans\bin` with the following command:

```
  tp getprots <SAPSID>
```

This does not affect any imports or exports that are still running. `tp` informs you about possible processing problems in the file `\usr\sap\trans\log\SLOG<rel>`. You can monitor this file using the commands `type` or `tail` (MKS tools), but do not use an editor. To delete any entries in TRBAT that cannot be processed and that are no longer needed, call transaction SM31.

For more information on the transport control program `tp`, see the online documentation for Basis or SAP Web AS of the source release:

- **Release 3.x**
  - Help → R/3 Library → BC – Basis → System Administration → Transport Control → Transport Control Program `tp`

- **Release 4.x**
  - Help → SAP Library → BC – Basis Components → Change and Transport System → BC – Transport Tools → Transport Control Program `tp`

- **Release 6.x**
  - Help → SAP Library → mySAP Technology Components → SAP Web Application Server → Change and Transport System → Transport Tools → Transport Control Program `tp`

• The following indexes `<number>` were read:

Indexes whose names are identical up to the 14th character were found in a table belonging to the substitution set. The 14th character is an 'X' in one of the two names and is empty in the other. This is an inconsistency and would result in an error during the import of the substitution set.

The index with the 'X' as the 14th character can only have occurred in a previous upgrade or have been created outside the SAP system. For more information, contact your SAP consultant.

• The following database tables have names that are identical to names of Basis views. The views will be created in this upgrade. Therefore ...

Delivered views may have names identical to the names of customer tables in the SAP namespace. You must delete these tables. If you need the table data, you must make a backup before deleting the tables.

• Update records still exist - please process

Make sure that you have cleaned up all outstanding updates and, for Source Releases 4.x and higher, all outbound queue RFC calls by the `JOB_RSVBCHK_R` or `JOB_RSVBCHK_D` phase (during downtime) at the latest.

If you are still in the preparation phase (PREPARE) and therefore in production operation, you must only delete the **terminated** updates.
We recommend that you clean up as many updates and RFC calls as possible. Otherwise, you will have to clean them up during downtime.

To find terminated or outstanding updates, proceed as follows:

   b. Delete the default values for the client, user, and time.
   c. Select all the update requests.

To find outstanding outbound queue RFC calls, proceed as follows:

   a. Call transaction SMQ1.
   b. Delete the default values for the client.
   c. Make sure that the list of outbound queue RFC calls is empty.

   Otherwise you might lose data in other systems (for example, in SAP BW).

Repeat these checks when production operation ends. For more information, see Isolating the Central Instance [page 220].

If you have installed the PI plug-in, R3up will display more information.

**DB2 UDB for UNIX and Windows**

- DATABASE ERROR: The value <old value> of <param> database configuration parameter is too low.
  
  ---> Set the parameter to <new value>.

Certain database parameters are set too low for the upgrade. Set the parameter(s) to the required value.

Proceed as follows:

   a. Log on as user db2<sapsid> and start CLP by choosing Start → Programs → DB2 for Windows NT → DB2 Command Line Processor.
   b. Increase the <parameter> with the following command:

      update db cfg for <dbname> using <parameter> <new_value>

      For DB2 UDB EEE only. If you have configured a database with multiple partitions, use the following command (in one line):

      db2_all "db2 update db cfg for <dbname> using <parameter> <new_value>"

   c. The parameters do not become effective until the database is restarted.

      Make sure that the SAP system was stopped.

      After that, stop the service DB2-DB2<SAPSID> by choosing Start → Settings → Control Panel → Services. Then restart it.

**Oracle**

- The user needed by the shadow instance does not yet exist.

  Please create the user for the shadow instance by executing SQL script crshdusr.sql.

No user has been created for the shadow instance. To create a user, proceed as follows:
a. Log on as user <SAPSID>ADM.
b. Copy the script crshdusr.sql from directory <DIR_PUT>\bin to directory %ORACLE_HOME%\database.
c. Execute the script with the command:
   sqlplus /NOLOG @crshdusr.sql

• For kernel Release 6.10 and higher, the tablespaces need to have
default storage (MAXEXTENTS UNLIMITED)! The following tablespaces have been found with MAXEXTENTS < '2147483645':
   [...] Also newly created tablespaces need to have default storage (MAXEXTENTS UNLIMITED)! You have to set the default storage (MAXEXTENTS UNLIMITED) before the upgrade can be started.

As of SAP Web Application Server 6.10, tablespaces must have the parameter DEFAULT STORAGE set to MAXEXTENTS UNLIMITED before you can start the upgrade. Proceed as follows:

a. Log on as user <SAPSID>ADM.
b. Copy the file ORAMAEXT.SQL from directory <upgrade directory>\bin to the directory %ORACLE_HOME%\database.
c. Execute the script as database user system with the following command:
   sqlplus system/<pwd> @ORAMAEXT.SQL

End of the database-specific explanations

MSCS Configuration

If the database and the SAP system are running on different nodes in a cluster installation, ignore the following warning:

Your database and central instance are running on different hosts. Executables have to be transferred to the database host.

5.2.21 Making Preparations at the Operating System Level

Use

You must perform these actions manually on the host where the central instance runs.

Procedure

Backing Up the SAP Kernel

During the upgrade, all files and subdirectories of the directory \usr\sap\<SAPSID>\sys\exe\run are deleted. Make sure that you can restore the contents of the old directories, if necessary. Make a backup copy of these programs to guarantee this.
The directory `\usr\sap\<SAPSID>\sys\exe\run` must not be write-protected. Otherwise problems occur when the SAP Kernel is started after the Kernel substitution (phase `STARTR3_NBAS`).

### 5.2.22 Making Preparations at the Database Level

**Procedure**

**Backing Up the Database**

Make sure that you can reset the database to the state it had before the upgrade by using an existing database backup. For more information on timing and performing database backups, see Upgrade Strategy Planning [page 71], Database Backup [page 74], and Database-Specific Aspects [page 75].

At the same time, make a backup of the upgrade directory and its subdirectories.

- **MaxDB**
  - Perform a full backup of the database before the upgrade. You must back up the log when you isolate the central instance.

- **Oracle**
  - For detailed information about making backups as well as about the programs `brbackup` and `brarchive`, see the SAP online documentation on database administration for Oracle.

  **As of Basis Source Release 4.0B:** Make sure that the statistics are up-to-date for all tables. Out-of-date statistics can increase the runtime of the upgrade significantly. Proceed as described in Oracle: Performing Actions for the Cost-Based Optimizer [page 183].

**End of the database-specific explanations**

**Making Database-Specific Preparations**

**DB2 UDB for UNIX and Windows**

1. **For Source Release 4.6A and lower:** Start the program `ntreg2env.exe` as user `<SAPSID>ADM`.

   This program adjusts the environment variables of the user `<SAPSID>ADM` with the Registry entries under `HKEY_LOCAL_MACHINE \ SOFTWARE \ SAP \ <SAPSID> \ Environment`.

   You must do this to make sure that the SAP system runs properly after the Kernel switch (upgrade phase `KX_SWITCH`), otherwise the Registry entries may be lost.
2. User sapr3 (sap<sapsid>) needs additional authorizations for updating the statistic values.

To do this, enter the following commands:

grant update on table sysstat.tables to user sapr3
grant update on table sysstat.columns to user sapr3
grant update on table sysstat.indexes to user sapr3

**DB2 UDB for z/OS**

Refresh the statistics before the upgrade.

For more information on the procedure, see the documentation SAP Database Administration Guide: IBM DB2 UDB for z/OS.

**MaxDB**

**Updating Optimizer Statistics**

To improve the response times of the database during the upgrade, you must update the optimizer statistics.

Proceed as follows:

1. Log on to the SAP system.
2. In the role SAP_BC_DB_ADMIN_SAPDB, choose Database: Operation → DBA Planning Calendar (transaction DB13)
3. Double-click a day in the DBA Planning Calendar. The menu for scheduling database actions appears.
4. Select Create new optimizer/space statistics.

Schedule this action as close to the upgrade as possible.

**Oracle**

1. Check the value of parameter shared_pool_size in file 
%ORACLE_HOME%/database/init<DBSID>.ora. If the value is lower than 150 MB, increase it to at least 150 MB (400 MB is better), and restart the database.
2. Log on as user <SAPSID>ADM at the operating system level.
3. Log on to the database as the Oracle user system with sqlplus (default password is manager).
4. Check the resource quotas of the database user SAPR3(SAP<SAPSID>):

   Oracle error 1536 can occur during the upgrade if the resource quotas of database user SAPR3 (SAP<SAPSID>) are limited. Make sure that these quotas are unlimited.

   Check whether the table DBA_SYS_PRIVS contains one of the following entries:

<table>
<thead>
<tr>
<th>grantee</th>
<th>privilege</th>
<th>adm</th>
</tr>
</thead>
<tbody>
<tr>
<td>'SAPR3'</td>
<td>'UNLIMITED TABLESPACE'</td>
<td>'NO'</td>
</tr>
<tr>
<td>'SAPR3'</td>
<td>'UNLIMITED TABLESPACE'</td>
<td>'NO'</td>
</tr>
</tbody>
</table>

   To do this, enter the following SQLPLUS statement:

   ```sql
   select * from dba_sys_privs where grantee = 'SAPR3';
   ```

   If this entry does not exist, enter the SQLPLUS statement:

   ```sql
   grant unlimited tablespace to sapr3;
   ```
5. Log off from the database with the command `exit`.

6. Only if using the `dictionary managed tablespaces` function:
   
   Make sure that the storage parameters `MAXEXTENTS` and `NEXT` have the correct values for certain tables and indexes. Otherwise, they may overflow during the upgrade. The Oracle-specific upgrade SAP Note contains the tables and the required minimum values.

   You can display the current settings with `BRSPACE`. The index names are not constant. However, you can also determine these names with `BRSPACE`. SAP Note 11777 describes how to change the parameters `NEXT` and `MAXEXTENTS`.

7. For Source Release 3.1I only:

   Make sure that parameter `OPTIMIZER_MODE` has the following setting in the Oracle profile `%ORACLE_HOME%/database/init<SAPSID>.ora`:

   ```
   OPTIMIZER_MODE=RULE
   ```

   If you have to change the parameter, restart the database afterwards.

8. Check the value of storage parameter `MAXEXTENTS` for the tablespace `PSAPTEMP`. If you are not sure, execute the `psaptemp.sql` script as the database administrator.

   This script sets the value of `MAXEXTENTS` for the tablespace `PSAPTEMP` to `UNLIMITED`.

   The `psaptemp.sql` script is located in the `bin` subdirectory of the upgrade directory.

9. If your database version is already higher than the minimum version for the new release, we recommend that you exchange the DBA tools (such as `BRSPACE`) for the upgrade.

   The `Database Software Oracle` DVD for the database contains the up-to-date tools that you unpacked on the current kernel when you migrated the database. After you execute `PREPARE`, unpack this archive again into the `exe` subdirectory of the upgrade directory.

   This overwrites the DBA tools optimized for the minimum required database version with the tools best suited to your database version.

   **End of the database-specific explanations**
5.2.23 Making Preparations at the SAP System Level

Procedure
In addition to the preparations at the operating system level and the database level, you also need to make preparations at the SAP system level:

- Deleting the Autostart Parameter [page 134]
- Checking the User for the Upgrade [page 134]
- Checking the Requirements for the Modification Adjustment [page 135]
- Setting the Operation Mode for the Upgrade [page 135]
- Processing Batch Input Sessions (Source Release 3.1I) [page 136]
- Converting the Translation Proposal Pool (Source Release 3.1I) [page 136]
- Processing Direct Input Error Data (Source Release 3.1I) [page 137]

Deleting the AUTOSTART Parameter

Procedure
Delete the parameter AUTOSTART = 1, if it is set, in the start profile (START_<SPECIFICATION><INSTANCE_NO>_HOSTNAME).

Setting the parameter Autostart = 1 causes the R/3 service and the SAP system to start when the Windows system is booted. This mechanism must be switched off during the upgrade.

You can set the parameter again if required once the upgrade has been successfully completed. Note that this parameter may not be set in a MSCS cluster configuration.

Checking the User for the Upgrade

Procedure
Make sure that you can log on to the system in client 000 as user DDIC. The initial password for DDIC is 19920706 in a newly installed system.

To be able to perform all necessary actions for the upgrade, user DDIC needs the authorization SAP_ALL.
Checking the Requirements for the Modification Adjustment

Procedure
If you modified SAP objects in your SAP system, make sure that you meet the requirements for the modification adjustment [page 86].

⚠️ In particular, make sure that changes to the Repository are allowed in the client in which you want to perform the modification adjustment. To check this, call transaction SCC4.

For more information on the requirements for the modification adjustment, see the online documentation for the target release under SAP NetWeaver Library → SAP NetWeaver → Application Platform (SAP Web Application Server) → ABAP Technology → ABAP Workbench → Changing the SAP Standard → The Modification Assistant.

⚠️ If you do not make sure that you have met the requirements for the modification adjustment, we cannot guarantee complete support during the adjustment. You also risk losing the data for ABAP Dictionary objects.

Setting the Operation Mode for the Upgrade

Use
Various background jobs are started during the upgrade. When you schedule jobs, a check is made to see whether the SAP instance on which you want them to run is defined in an operation mode. The operation mode specifies which services are offered by the work processes (dialog, update, background processing, enqueue, spool, and so on).

Prerequisites
No operation modes must exist that contain servers other than those belonging to the current system.

Procedure
1. Before you start the upgrade, call transaction RZ04 to check the definition of your operation modes. Also check the operation mode DUMMY. The DUMMY operation mode may have <host name>_<SAPSID> entered as the server name. Change this entry to <host name>_<SAPSID>_<instance number>.
2. Delete the invalid operation modes. If operation modes contain names of servers other than those belonging to the system, problems may arise in the background interface in some phases. The jobs may be released, but not set as active (in theory, this affects all jobs scheduled to start on a specific server and triggered by an event).
3. If the SAP instance on which you want to upgrade the system is not entered in an operation mode, create the operation mode for the upgrade as follows:
   a. Call transaction RZ04.
   b. Choose Operation mode → Create.
Enter a name for the operation mode, for example, Upgrade. Enter a short description and then save the operation mode.

c. Make sure that the instance required for the upgrade has been started up.

d. Position the cursor on the new operation mode and choose Operation mode → Maintain instances → Instances/OP modes.

e. Choose Settings → Based on act. status → New Instances → Create.
   This displays all instances and their current configuration.

f. Choose Save.

g. Call transaction SM63 to enter the operation mode you have defined as an active operation mode for 24 hours (select Normal operation (24 hours)).

**Processing Batch Input Sessions (Source Release 3.1I)**

**Use**
Due to a change in the data structure, old sessions cannot be processed after the upgrade.

**Prerequisites**
Your source release is 3.1I.

**Procedure**
Make sure that you have finished processing all your batch input sessions before the upgrade.

**Converting the Translation Proposal Pool (Source Release 3.1I)**

**Use**
If you have a production system for translation in your SAP system, you must convert the existing proposal pool before the upgrade. If you do not, the existing proposal pool will be lost.

**Prerequisites**
Your source release is 3.1I.

**Procedure**
Use report RSTRMINI for the conversion.
For more information, see the documentation on the report in the system.
Processing Direct Input Error Data (Source Release 3.1I)

Use

In Release 4.0 there are changes to the way error data, which occurs during the transfer of data by direct input (material master industry), is stored. These changes are primarily intended to ensure upward compatibility in the future.

As a result, you can no longer use standard functions (direct input administration, program RMDATINF) to process any error data remaining from a direct input run performed with Release 3.x. You can use the RMDATINF_3X program to display the messages of previous direct input runs after the upgrade to Release 4.x.

Prerequisites

Your source release is 3.1I.

Procedure

1. Before the upgrade, check whether there are any direct input jobs that have terminated abnormally or that have been completed with logical errors.

2. If jobs of this type exist, remove the errors and run the jobs again.
5.3 The Upgrade

General Information

This part of the documentation provides general information on upgrading your system.

For any additional information, see the product-specific part of this documentation.

Before you begin the upgrade, you must have completed all required planning and preparation actions.

When you upgrade your system, note the following information (in addition to the information in Upgrade – Step by Step):

- **R3up** controls the entire upgrade of the SAP system, from checking the requirements and importing the necessary programs through stopping production operation until it is resumed. The upgrade procedure is divided up into a number of different phases with the successful completion of a phase being a precondition for the success of all subsequent phases. This section describes all the required user input and actions, as well as critical points during the upgrade. For a complete list of all phases, see the **htdocs** subdirectory of the upgrade directory.

- **R3up** must run on the application server of the central instance.

- If your central instance and database are running on different hosts, you must perform the actions that affect the database on the database host.

- You can use the Upgrade Monitor, the upgrade logs, and the alert function to monitor the upgrade.
  - The **Upgrade Monitor** lets you monitor the upgrade, and helps you to recognize processes that have exceeded their runtime.
  - **R3up** logs all actions in the **upgrade logs**. Use them as your starting point for troubleshooting.
  - You can use the **alert function** to gather information if the upgrade has stopped.

- Many phases of the upgrade require little user input (or none at all). User actions are generally required when problems occur. If an error occurs, correct it and repeat the phase in which the error occurred. Once the phase has been repeated successfully, you can continue the upgrade.

- During the upgrade, you are prompted to enter a mount directory for a specific data carrier at the appropriate times. To avoid having to manually enter the mount directory during the upgrade, you can specify several mount directories in the **INITPUT** phase. This documentation assumes that you only have one DVD drive. If you have multiple DVD drives, you can ignore instructions to mount a directory.

We recommend that you use the Upgrade Assistant to upgrade your system.
Actions

The following sections are important for performing the upgrade:

- Upgrading with Microsoft Cluster Server [page 140]
- Starting the Upgrade [page 140]
- Stopping the Upgrade [page 141]
- Monitoring the Upgrade [page 143]
  - Upgrade Logs [page 143]
  - Alert Function [page 145]
- Phase INITPUT [page 146]
- Phase PATCH_CHK [page 146]
- Phase KEY_CHK [page 147]
- Phase INITSUBST [page 147]
- Phase CONFCHECK_X [page 149]
- Phase VIEWCHK1 [page 150]
- Phase REPACHK1 [page 150]
- Phase JOB_RSVBCHK2 [page 150]
- Phase FREECHK_X [page 151]
- Phase LOCKEU_PRE [page 151]
- EU_IMPORT Phases [page 152]
- Phase REPACHK2 [page 153]
- Phase CNV_CHK_XT [page 153]
- Phase ADJUSTCHK [page 154]
- Phase ACT_<Rel> [page 154]
- Phase VIEWCHK2 [page 156]
- Phase MODPROF_TRANS [page 156]
- Phases JOB_RSVBCHK_R and JOB_RSVBCHK_D [page 157]
- Continuation the Upgrade After the MODPROFP_UPG Phase [page 158]
- Phase CHK_POSTUP [page 158]
5.3.1 Upgrading with Microsoft Cluster Server

Use

The SAP system is stopped and started repeatedly during the upgrade. To make sure that the configuration for \textit{R3up} is unchanged during the upgrade, the resource \texttt{SAP-R/3\textless SAPSID\textgreater} is set offline the first time that the SAP system is stopped. This occurs with the \textit{resource minimized} upgrade strategy in the \texttt{EU\_IMPORT1} phase, and with the \textit{downtime-minimized} strategy in the \texttt{MODPROF\_TRANS} phase.

Before you set the resource \texttt{SAP-R/3\textless SAPSID\textgreater} online again in the cluster administrator, follow the instructions in the section \textit{Post-Upgrade Activities for the Microsoft Cluster Server} [page 169].

5.3.2 Starting the Upgrade

Prerequisites

- You are logged on to the central instance as user \texttt{<SAPSID>ADM}.
- You have completed the mandatory \texttt{PREPARE} modules.
- No files must have been deleted in the upgrade directory. Deleting these files could cause unpredictable inconsistencies.
- You have made the preparations that are not supported by \texttt{PREPARE}.
- You have decided on whether to use the Upgrade Assistant or scroll mode. We recommend that you use the Upgrade Assistant

Procedure

Using the Upgrade Assistant

1. Check that the Upgrade Assistant Server is active on the host in which the central instance is running.
2. Start the Upgrade Assistant GUI and log on as administrator (see \textit{Using the Upgrade Assistant} [page 235]).
3. In the main menu, choose \texttt{Administrator} $\rightarrow$ \texttt{Start R3up}.
   \texttt{R3up} displays the initial screen of the upgrade. This screen appears in each future restart. It displays the \texttt{R3up} version, the target release, the SAP system ID and the database you use.
4. If the entries are correct, confirm this screen with \texttt{Continue}.

Using the Scroll Mode

1. Log on to the host on which the central instance is running.
2. Go to the directory \texttt{\usr\sap\put\exe}.
3. Enter the following command:
   \texttt{R3up.exe}
5.3.3 Stopping the Upgrade

Use
You can stop R3up at the beginning of a specific phase or at the end of a phase that is currently running. For example, you need to do this if an SAP Note tells you to correct a program before you execute it.

Procedure

Stopping the Upgrade at the End of the Current Phase
To stop the upgrade at the end of the current phase, you have the following options:

- In the main menu of the Upgrade Assistant, choose Administrator → Stop R3up after current phase.
- Enter the following command in a second window at the operating system level:
  ```
  R3up stop
  ```

Stopping the Upgrade at the Start of a Phase
Enter the following command in a separate window at operating system level:

```
R3up stop <phase name>
```

R3up stop XPRAS_UPG

5.3.4 Restarting the Upgrade

Use
You usually only have to restart the upgrade when errors have occurred or an upgrade phase has terminated.

If a phase terminates, R3up stops and suggests that you repeat the phase by choosing repeat.

If you have exited R3up by choosing exit, other start modes are offered.

- repeat
  If nothing else is specified in this documentation, always use start mode repeat to restart R3up. This is the only way to make sure that all upgrade phases have been completed correctly.

  The repeat start mode restarts the upgrade at the exact point where it was interrupted. R3up runs through the phase and checks where it has to be restarted. This means that the repeat start mode does not necessarily restart from the beginning of the phase.

- init
  When you choose the init start mode, the phase in which the upgrade was interrupted is repeated from the beginning.
• **reset**

The *reset* start mode is used to restart the upgrade from the beginning. This is only possible up to the **SUBSTNT_INS** phase. After this you can restart the upgrade only by resetting the database.

This mode resets the upgrade to the **INITPUT** phase. If the system is already in downtime, it must be restarted once manually if *reset* is chosen.

Alternatively, you can also correct the entries with **R3up set stdpar** or **R3up set DDICpwd**. For more information, see Correcting Entries Made in the **INITPUT** and **INITSUBST** Phases [page 199].

⚠️ Other start modes can cause errors. SAP must confirm their use for your specific situation.

**Prerequisites**

- If you need to restart due to an error or termination during the upgrade, the cause of the error must be clear and you must correct the error first.

  For more information on finding and correcting errors, see Troubleshooting [page 196]. If you are not sure how to proceed, contact SAP Support.

- A password is generally necessary if you want to ignore an error, or jump to a phase other than the one currently being executed. Only enter this password when your troubleshooting has clearly identified the source of the error and you have checked with SAP. Support cannot be guaranteed if you do not consult SAP. In only a very few cases is it a good idea to ignore an error with a password. A large number of cases are known where ignoring an error resulted in serious inconsistencies, at worst making a recovery of the database necessary. Only in exceptional cases, such as in phases **ACT_<rel>** and **XPRAS_UPG**, can you ignore errors with **repair severe errors**.

  For more information on finding and correcting errors, see Troubleshooting [page 196] and under Help in R3up.

**Procedure**

If you do not exit **R3up** after it has terminated:

1. If a phase terminates, choose start mode **repeat**.

   **R3up** continues the phase from the point where it terminated. This checks whether the error repeats itself. If the error is not repeated, the upgrade continues after the phase has been completed. If the error occurs again, you must correct it.

2. If an error occurred, choose **exit** to leave **R3up** and correct the error.

If you exited **R3up** with **exit**:

1. Start the Upgrade [page 140].

2. If possible, choose start mode **repeat**.

   **R3up** repeats the terminated phase and continues the upgrade.
5.3.5 Monitoring the Upgrade

The upgrade tools offer a range of options for monitoring the upgrade.

- **Upgrade Monitor** [page 236]
- **Upgrade Logs** [page 143]
- **Alert Function** [page 145]

**Upgrade Logs**

**Use**

R3up logs all actions in log files. You can use these log files to monitor your upgrade. If you encounter any errors you can analyze them to help you find a solution.

**Features**

R3up records all actions in log file R3up.log in the directory \usr\sap\put\log. Temporary logs are located in the directory \usr\sap\put\tmp.

The *tp* steps are also written to \usr\sap\put\log\SLOG<rel>. Additional detailed logs are usually written for these *tp* steps.

To monitor the collective log, you can display the log using the command `type` or `tail` (MKS tools). Do not use the option `-f` for the command `tail` and do not edit the file using an editor, otherwise the file is write-protected by *tp*.

Each *tp*-driven phase is divided up into a number of different steps whose start and end times are noted in the SLOG log. The start and end of a phase are indicated by the lines **START put** and **STOP put**. The section in the SLOG log relating to the ACT_<rel> phase looks like this:

```
START put PS1 20010307182423 psladm ds0007
INFO: event SAP_IMPORT_START triggered successfully
START SET STOPMARK PS1 20010307182423 psladm ds0007
INFO: Buffer saved as \usr\sap\put_psl\buffer\PS1SAV.
STOP SET STOPMARK PS1 20010307182423 psladm ds0007
LIST put PS1 (3{3|
START tplock_eu PS1 ( 20010307182423 psladm ds0007
STOP tplock_eu PS1 ( 20010307182423 psladm ds0007
START tpsapstart PS1 3 20010307182423 psladm ds0007
STOP tpsapstart PS1 3 20010307182423 psladm ds0007
START locksysX PS1 { 20010307182423 psladm ds0007
STOP locksysX PS1 { 20010307182423 psladm ds0007
START tpsapstart PS1 3 20010307182423 psladm ds0007
STOP tpsapstart PS1 3 20010307182423 psladm ds0007
```
Additional detailed logs are also written for most steps. These are in the \usr\sap\put\tmp directory, where you can also monitor them with `tail -f`. After the various steps of the phase have been completed, `tp` moves the individual logs to \usr\sap\put\log.

Make sure that you do not use the option `-f` for the command `tail` to display the files in \usr\sap\put\tmp, otherwise nothing can be copied to \usr\sap\put\log and the phase cannot be completed correctly.

The table below lists the most important steps together with their log names, and specifies which programs execute the steps:

<table>
<thead>
<tr>
<th>Step</th>
<th>Log Name</th>
<th>Program Executing the Step</th>
</tr>
</thead>
<tbody>
<tr>
<td>SHADOW_IMPORT</td>
<td>SAPK??????..&lt;SAPSID&gt;</td>
<td>R3trans</td>
</tr>
<tr>
<td>DD IMPORT (H)</td>
<td>SAPH??????..&lt;SAPSID&gt;</td>
<td>R3trans</td>
</tr>
<tr>
<td>DD ACTIVATION (A)</td>
<td>SAPA??????..&lt;SAPSID&gt;</td>
<td>ABAP program (RDDMASGL)</td>
</tr>
<tr>
<td>DISTRIBUTION OF DD OBJECTS (S)</td>
<td>DS&lt;DATE&gt;..&lt;SAPSID&gt;</td>
<td>ABAP program (RDDDIS0L)</td>
</tr>
<tr>
<td>TBATG CONVERSION OF DD OBJECTS (N)</td>
<td>N&lt;DATE&gt;..&lt;SAPSID&gt;</td>
<td>ABAP program (RDDGEN0L)</td>
</tr>
<tr>
<td>tpmvntabs</td>
<td>P&lt;DATE&gt;..&lt;SAPSID&gt;</td>
<td>tp</td>
</tr>
<tr>
<td>MAIN IMPORT (I)</td>
<td>SAPI??????..&lt;SAPSID&gt;</td>
<td>R3trans</td>
</tr>
<tr>
<td>tpmvkernel (C)</td>
<td>C&lt;DATE&gt;..&lt;SAPSID&gt;</td>
<td>tp</td>
</tr>
<tr>
<td>TBATG CONVERSION OF MC OBJECTS (N)</td>
<td>N&lt;DATE&gt;..&lt;SAPSID&gt;</td>
<td>ABAP program (RDDGEN0L)</td>
</tr>
<tr>
<td>IMPORT OF SELFDEFINED OBJECTS (D)</td>
<td>SAPD??????..&lt;SAPSID&gt;</td>
<td>ABAP program (RDDDIC1L)</td>
</tr>
<tr>
<td>VERSION UPDATE (V)</td>
<td>SAPV??????..&lt;SAPSID&gt;</td>
<td>ABAP program (RDDVERSL)</td>
</tr>
<tr>
<td>EXECUTION OF REPORTS AFTER PUT (R)</td>
<td>SAPR??????..&lt;SAPSID&gt;</td>
<td>ABAP program (RDDEXECL)</td>
</tr>
</tbody>
</table>

Once the logs are located in the directory \usr\sap\put\log, you can also display them in the SAP system. You can do this by executing program RDDPROTT with transaction SE38. RDDPROTT displays all the logs for a specific transport request. In the field `Transport`
Request field, enter the name of the transport request (for example, SAPK<rel>D01) and then choose Execute.

A brief overview of all the logs existing for this transport request appears. Double-click a line to display a log for this step. The logs are broken down into several levels. Level 1 only displays the return code for the step. Check at least level 2 to display any error messages. Double-click an error to see its long text.

After completing each tp-driven phase, R3up creates a summary of all individual logs in this phase. The names of the summaries usually comprise the phase name (without underscore) and the extension .ELG (for example, DDIC<rel>.ELG). The summary contains the names of the individual logs, any errors that occurred and the return codes. If no errors have occurred, you need to check these summaries only.

Alert Function

Use

Use the alert function so that you are informed if the upgrade waits for a long time, or if the upgrade terminates (for example, due to an error).

Features

- Alert file

If the upgrade stops, an appropriate message appears. An alert file UPALERT.LOG is also created in the tmp subdirectory of the upgrade directory, to indicate that you need to take action. You can use this to notify the system administrator, for example by telephone, and minimize downtime. For starting a communication service, however, you must provide the external software. The alert file is deleted when the upgrade is continued. R3up can also send a dialog box to a specified PC if the upgrade waits longer than 60 seconds for user input. For more information, see Sending a Message When User Action Is Required [page 228].

- Alert Function of the Upgrade Assistant

When you use the Upgrade Assistant for your upgrade, you can use an alert function, instead of analyzing the alert file. You can then be informed if the control program R3up waits longer than a predefined period of time for input. As with the alert file, you must also provide the external software for starting a communication service.

Activities

To activate the alert functions of the Upgrade Assistant, go to the main menu of the Upgrade Assistant and choose Administrator → Set Alert.

The following dialog box appears:
You can get more information online in the Upgrade Assistant. Choose Help → Introduction and look for the section ‘Set Alert’ window.

### 5.3.6 Phase INITPUT

**Use**

In the Parameter Input [page 107] PREPARE module you are prompted to enter values for certain system-specific parameters needed by the upgrade, for example, names, paths and passwords. You can modify the entries you made in PREPARE in the INITPUT phase.

**Activities**

At the start of this phase R3up asks you whether you want to change any parameters.

- If you confirm this, you are prompted for all the parameters. If the default values are correct, confirm them.
- If you skip this phase and realize in the following phases that you made an incorrect entry, correct it as described in Correcting Entries Made in the INITPUT and INITSUBST Phases [page 199].

### 5.3.7 Phase PATCH_CHK

**Use**

This phase checks that the following prerequisites are met:

- All Support Packages have to be confirmed for the source release. Unconfirmed Support Packages are displayed on the screen and in the PATCHOUT.LOG file in the log subdirectory of the upgrade directory.
- The source release does not contain Support Packages that are more recent than those in the delivered target release.
5 General Upgrade Information

PREPARE phase PATCH_CHK3 has already made these checks. For more information, see the description of the PATCH_CHK3 phase in Making Entries for the Extension Module [page 114].

Activities

1. If you still have to confirm Support Packages for the source release, call transaction SPAM and confirm the Support Packages that are proposed there.
2. If a warning appears that the Support Package level of your source release is too high, proceed as follows:
   - If you have already included Support Packages in the BIND_PATCH phase of PREPARE, you can ignore this warning
   - If you have not included any Support Packages in the BIND_PATCH phase of PREPARE, you will lose data if you continue with the upgrade. In this case, you must reset the upgrade [page 210], repeat PREPARE, and include the necessary Support Packages.

5.3.8 Phase KEY_CHK

Use

This phase prompts you for the keyword specified in the current SAP Upgrade Note.

Activities

If you have not already done so, request the latest SAP Notes now. SAP Notes are continually being updated. For a list of the SAP Notes you need for the upgrade, see the introductory part of this documentation under SAP Notes for the Upgrade.

If you use SAP add-on components in your system (such as IS components), you are also prompted for other keywords. SAP systems that have other software components (add-ons) installed must wait until the upgrade has been released by the relevant add-on software vendor.

5.3.9 Phase INITSUBST

Use

You must specify the following in this phase:

- Upgrade strategy
- Import time for the substitution set
- Number of parallel processes available to import the substitution set
- Archiving strategy
- Number of parallel background processes
- Number of parallel tp processes during the PARCONV_UPG phase (DB2 UDB for z/OS)
- Threshold quantity for indexes to be created with DEFER YES (DB2 UDB for z/OS)
Activities

- Upgrade strategy

  Choose between the strategies *downtime-minimized* and *resource-minimized* described in [Upgrade Strategy Planning](page 71).

  - If you decide to use *downtime-minimized*, the system now prompts you to enter your runtime for the total import of the substitution set.

    For information on which factors you must consider when you choose a runtime, see [Runtime for the Import of the Substitution Set](page 85).

  - If you decide to use *resource-minimized*, you are asked for the number of parallel processes for importing the substitution set.

    **DB2 UDB for UNIX and Windows**

    We recommend three parallel R3load processes.

    **DB2 UDB for z/OS**

    We recommend ten parallel R3load processes.

    **Informix**

    The number of parallel R3load processes you choose depends on your upgrade strategy and hardware. We recommend between two and five parallel processes.

    **MaxDB**

    The number of parallel R3load processes you choose depends on a number of factors. For the most up-to-date recommendations, see [SAP Note 46430](page 428).

    **MS SQL Server**

    We recommend up to three parallel R3load processes.

    **Oracle**

    We recommend up to three parallel R3load processes.

  *End of the database-specific explanations*

- Archiving strategy

  Choose a time when you want database archiving to be switched off. The archiving strategy [page 74] is not linked to the chosen upgrade strategy. However, if you choose upgrade strategy *downtime-minimized*, we recommend the MODPROF_TRANS phase; if you choose upgrade strategy *resource-minimized*, we recommend the EU_IMPORT1 phase or before the first start of the shadow instance in the REQSTOPPROD phase.

  **DB2 UDB for z/OS**

  Make sure that DB2 logging is always activated. Therefore, the upgrade does not offer the possibility to choose an archiving strategy.

  *End of DB2 UDB for z/OS-specific explanation*

- Number of parallel background processes

  During downtime, the SAP system is started with a modified number of background processes so that operations can be processed in parallel. To enable this, the profile of the central instance is modified temporarily. For hosts with up to 128 MB choose two background processes, for hosts with up to 256 MB choose three background processes, and for hosts with more than 256 MB, choose four background processes.
### DB2 UDB for z/OS

- **Number of parallel tp processes in the PARCONV_UPG phase**
  
  You are asked whether you want to use multiple parallel tp processes in the PARCONV_UPG phase. This function reduces the runtime during the PARCONV_UPG phase.

  We recommend six parallel tp processes.

  Note that deadlocks may occur if you use multiple tp processes. These deadlocks appear in the MVS system log. However, the upgrade process deals with them by repeating a follow-up process.

- **Creating indexes with the DEFER YES option**
  
  You can choose to create large indexes with the DEFER YES option in phases PARCONV_UPG and PARMVNT_XCNV. The upgrade tool automatically rebuilds the indexes after these phases. If you want to create indexes with the DEFER YES option, you are prompted to enter a threshold value for the primary and secondary quantity. If either of the quantities is larger than the given value, the DEFER YES option is used when creating the index.

---

**End of DB2 UDB for z/OS-specific explanation**

If you realize in the following phases that you made an incorrect entry, correct it as described in Correcting Entries Made in the INITPUT and INITSUBST Phases [page 199].

---

### 5.3.10 Phase CONFCHK_X

**Use**

This target release is released for certain combinations of operating system and database versions only. This phase checks that the operating system and database versions installed on your computer satisfy the requirements for the upgrade.

**Activities**

If the version check determines that the operating system must be upgraded to a new version, or that you need to import additional software, you can interrupt R3up at this point.

⚠️

Do not make any changes in the upgrade directory.
5.3.11 Phase VIEWCHK1

Use
This phase displays conflicts between customer tables in the SAP namespace and views that are newly delivered. It also writes this information to the VIEWCHK1.LOG file.

Activities
You can ignore the messages at this point. You must, however, rename or delete the tables in the VIEWCHK2 phase at the latest. First save any data that you need in these tables.

5.3.12 Phase REPACHK1

Use
This phase displays all repairs and requests containing objects locked by SAP, and writes them to the REPACHK1.LOG file.

Activities
You can ignore the messages at this point. These objects must be released and the repairs confirmed at the latest by the REPACHK2 phase.

5.3.13 Phase JOB_RSVBCHCK2

Use
If there are any outstanding or incomplete updates, the upgrade stops in this phase with an error message.

Activities
If errors occur in this phase and you have not yet resumed production operation, you can skip these errors with ignore without entering a password. However, we recommend that you check for outstanding updates and clean them up. For more information, see Evaluating the Results of PREPARE [page 126]. The PREPARE message is:
Update records still exist - Please process
5.3.14 Phase FREECHK_X

Use

This phase checks whether there is enough free space in the log subdirectory of the upgrade directory during the upgrade. You must have enough free space in the log directory so that the upgrade can run without errors.

During downtime, the SAP programs are substituted in the kernel directory `/usr/sap/<SAPSID>/sys/exe/run`. This phase also compares the free disk space in the kernel directory with the space requirements of the new SAP kernel.

Activities

At this point, make sure that you are able to restore the old kernel, if this becomes necessary.

⚠️ All files and subdirectories in directory `/usr/sap/<SAPSID>/sys/exe/run` are overwritten during the upgrade when the kernel is switched. For more information, see the PREPARE log CHECKS.LOG.

5.3.15 Phase LOCKEU_PRE

Use

If you have chosen upgrade strategy `downtime-minimized`, R3up asks you in this phase if you want the ABAP Workbench to be locked on all SAP instances now or in phase REPACHK2.

This lock is needed to prevent development objects (for example, ABAP reports, table definitions, and so on) from being changed during the upgrade, since these modifications would be lost.

Activities

If you have chosen strategy `downtime-minimized`, you can continue to use your SAP system in production operation, even if you confirm that the ABAP Workbench can be locked.

If you confirm the lock now:

- R3up does not stop in the REPACHK2 phase to allow you to confirm the lock on the ABAP Workbench. This increases the time in which R3up does not need user input after the last request for a mount directory (EU_IMPORT5 phase).
- You may not perform any more transports into or out of the SAP system.
- R3up waits until the time entered in the INITPUT phase as the maximum synchronization time for all the instances has expired (see Phase INITPUT).
5.3.16 EU_IMPORT Phases

Import Runtime
The total runtime of the import is distributed unevenly over the various import phases. If you have extended the runtime for the import of the substitution set [page 85], this also extends the duration of the individual phases. If an error causes the import to terminate in one of the phases, you have the option of speeding up the import when you restart it.

Activities

Phase EU_IMPORT1
At the start of this phase, the upgrade control program R3up stops and waits for user input.

If you have chosen the resource-minimized upgrade strategy, you are prompted at the beginning of this phase to do the following:

- Isolate the central instance [page 220].
- Verify that all secondary application servers are shut down.
- If necessary, verify that you can recover the database to its current state at this point.
- Disable the capability of the database to continually restore data [page 224].

MaxDB
R3up automatically deactivates archiving.

End of MaxDB

MaxDB

- Decide – if you chose strategy resource-minimized, and archiving is deactivated – whether you want a very fast import of the substitution set. Logging is deactivated if you choose this import option.

End of MaxDB

Then confirm that you want to continue with the upgrade.

After End of Import

MaxDB
The statistics for newly imported tables are updated automatically.

End of MaxDB
5.3.17 Phase REPACHK2

Use
This phase displays all the repairs and corrections that are not released and writes them to the REPACHK2.LOG file.

Activities
- Before you continue with the upgrade, you must release and confirm all the open repairs; otherwise the objects in them are locked. For a description of this procedure, see Releasing and Confirming Open Repairs and Requests [page 226].

> If you ignore open repairs, you could lose modifications.

Once you have released and confirmed all the open repairs, you must repeat the REPACHK2 phase. Any modifications made to SAP objects in your repairs might be overwritten during the upgrade.

For information on how modifications are copied to the new SAP standard during the upgrade, see the documentation DVD for the target release under SAP NetWeaver Library → SAP NetWeaver → Application Platform (SAP Web Application Server) → ABAP Technology → ABAP Workbench → Changing the SAP Standard → Upgrade Procedure / Support Packages.

- Upgrade strategy downtime-minimized: If you did not confirm the ABAP Workbench lock in the LOCKEU_PRE phase, do this now.

> After you have confirmed the ABAP Workbench lock, no more transports can be made into or out of the SAP system.

R3up waits until the time entered in the INITPUT phase as the maximum synchronization time for all instances has expired (see Phase INITPUT).

This phase displays all the repairs that are still in open transport requests. They are also written to the REPACHK2.LOG file. Release these transport requests so that you can continue; otherwise the objects contained in the repairs will be locked.

5.3.18 Phase CNV_CHK_XT

Use
This phase checks whether the following still exist:
- Unprocessed conversion requests
- Restart logs

Activities
If you find errors, proceed as described in Cleaning Up Terminated Conversions in the DB Conversion Phases [page 203].
5.3.19 Phase ADJUSTCHK

**Use**
If you chose to copy a request in the ADJUSTPRP phase, the modifications it contains are now compared with the modifications in the system. The result of this comparison appears.

**Activities**
You are prompted to confirm that the request was copied. If this request contains all the modifications found in the system, R3up does not stop before the activation of the ABAP Dictionary objects. However, you can still specify that you want R3up to stop in this phase.

5.3.20 Phase ACT_<Rel>

**Use**
Depending on the results of the ADJUSTCHK phase, you may be asked at the beginning of this phase to adjust your modifications to ABAP Dictionary objects so that they correspond to the new SAP standard version of the objects.

⚠️
The objects are adjusted on the shadow instance.

**Activities**

⚠️
Do not attempt to import adjustment transport requests into the system manually in this phase. This leads to the loss of data in customer fields. Any requests for automatic adjustment from previous upgrades can be included in this upgrade in the PREPARE phase ADJUSTPRP only.

You must make adjustments in the ACT_<rel> phase if you have made structural changes to tables. Otherwise, data will be lost.

1. In R3up, confirm that you want to perform a modification adjustment.
2. Add an entry for the shadow instance to the SAP Logon.
   
   Take the values from the original system for the server and system ID; for the instance number, take the value you specified in PREPARE for the shadow instance. The default value in PREPARE is the instance number of the original system plus one.
   
   Since the original system is still running if you use the downtime-minimized strategy, you can also log on to the shadow instance in transaction SM59 with the RFC connection SAP_UPGRADE_SHADOW_SYSTEM.
   
3. Log on to the shadow instance with the user DDIC and the DDIC password of the original system.
   
   Only the users DDIC and SAP* exist in the shadow instance.
4. Call transaction SE06 to set the system change option. Set:
   
   - the global setting to Modifiable.
5 General Upgrade Information

- the change option for the software components to Modifiable or Restricted modifiable.
- the SAP namespace to modifiable.

5. Call transaction SU01 to create one or more users to perform the modification adjustment. To do this, copy the DDIC user.

In some cases, the error message Error occurred in address management appears. You can ignore this error message.

If you directly create new users, this may cause terminations.

The new users exist only on the shadow instance and are not copied to the original system.

6. Log on to the shadow instance with one of the new users.

Modification adjustment of ABAP Dictionary objects must be performed in client 000.

7. Use transaction SPDD to determine the ABAP Dictionary objects that need to be adjusted.

For more information about transaction SPDD, see the online documentation for the target release under Help → SAP NetWeaver Library → SAP NetWeaver → Application Platform (SAP Web Application Server) → ABAP Technology → ABAP Workbench → Changing the SAP Standard → Upgrade Procedure / Support Packages → Adjusting ABAP Dictionary Objects.

If errors appear when you activate your own developments after executing this phase, you can correct these here, since R3up stops when errors occur. However, you also have the option of choosing ignore to temporarily ignore these errors. You do not need a password to do this. If you chose ignore here, you must activate these objects after the upgrade.

Only choose ignore if you are sure that this does not affect SAP objects.

If you are prompted for a password anyway, this means that the activation has been terminated and you must not continue with the next phase. You first have to remove the cause of the termination.

While you are upgrading on the shadow system, adjust only objects of the ABAP Dictionary.

You can make changes to the SAP Repository (changing and creating programs or packages, for example), but we do not recommend this since it may make the system inconsistent.
5.3.21 Phase VIEWCHK2

Use
This phase displays conflicts between customer tables in the SAP name range and views delivered for the first time. It also writes the information to the VIEWCHK2.LOG file.

Activities
You must delete these customer tables now, at the latest. You can use R3up to do this if the tables are transparent. You must delete pooled or cluster tables manually in the SAP system. First save any data that you need in these tables.

5.3.22 Phase MODPROF_TRANS

Use
The R3up program stops the SAP system in this phase and modifies the instance profile for the duration of the upgrade. R3up prompts you to perform several activities, depending on your database and the upgrade strategy you have chosen.

Activities
- If you chose upgrade strategy downtime-minimized, make sure that the following prerequisites are met:
  - All production work in the SAP system is stopped and no users are logged on to the SAP system.
  - The central instance is isolated [page 220].
  - All secondary application servers are shut down.
  - The capability of the database to continually restore data is disabled.

**DB2 UDB for z/OS**
If you use DB2 UDB for z/OS, you are not prompted to do this.

**End of DB2 UDB for z/OS-specific explanation**

- If you called transaction ICNV during the upgrade, R3up checks whether you have already converted the recommended percentage of the selected data (see Incremental Table Conversion [page 80]). R3up informs you if you have not. If you ignore the information from R3up, the rest of the data is converted in the conventional manner during downtime. For details on the status of the incremental conversion, call transaction ICNV.

⚠️
So that you can recover your SAP system after errors, perform the following actions:

Strategy downtime-minimized: Make sure that you can recover the database to its current state.

Both upgrade strategies: Back up the upgrade directory now, so that you can reset the upgrade to this state at a later point.
5 General Upgrade Information

Result

Once you have performed all activities, R3up automatically shuts down the central instance and modifies the instance profile in directory \usr\sap\<SAPSID>\SYS\profile for the duration of the upgrade. All changes to the profile are written to the ALPXPOOLLOG file.

If you want to use transaction RZ10 to adjust the instance profile during the upgrade, start by reimporting the current version of the profile into your SAP system. If you do not do this, the changes made by the upgrade are reset, which can cause the upgrade to stop running.

5.3.23 Phases JOB_RSVBCHCK_R and JOB_RSVBCHCK_D

Use

If some updates have not been performed yet, the upgrade stops in phase JOB_RSVBCHCK_R (if you use strategy resource-minimized), or in phase JOB_RSVBCHCK_D (if you use strategy downtime-minimized).

Activities

In this phase you must clean up all outstanding updates. Proceed as follows:

1. Make sure that the release for all background jobs was canceled, except for RDDIMPDP. For more information, see Isolating the Central Instance [page 220].
2. Clean up the outstanding updates as described in Evaluating the Results of PREPARE [page 126].
   The PREPARE message is:
   Update records still exist - Please process
3. Repeat this phase.
5.3.24 Continuation of the Upgrade After the MODPROFP_UPG Phase

Purpose

Up to the MODPROFP_UPG phase, R3up does not expect any further user input unless an error occurs. In this and the following phases, R3up makes preparations for restarting production operation and prompts you to take some actions. You can restart production operation after these actions have been completed.

Process Flow

R3up performs the following actions in the MODPROFP_UPG phase and the STARTR3_FUPG, REQGENLD, and CHK_POSTUP phases. R3up

- Displays the P errors (see Phase CHK_POSTUP [page 158]).
- Stops the system for the last time and recovers the state of the system profiles before the upgrade.
- Prompts you to set the database so that it can be recovered.
- Prompts you to make a full backup of your database.
- Prompts you to start the secondary application servers.
- Prompts you to start transaction SGEN to generate ABAP loads [page 185].

You can then resume production operation again or begin the post-upgrade activities.

5.3.25 Phase CHK_POSTUP

Use

You can solve some of the problems that occur during an upgrade after you complete the upgrade. This type of problem is indicated by a P in the second column of the .ELG logs.

R3up displays a complete list of these P messages in this phase in the LONGPOST.LOG file. You must usually remove the cause of these problems before you start using your SAP applications again.

Some of the secondary indexes may not have been created because they were not unique. Use the ABAP Dictionary tools (transaction SE14) to create these indexes in the database.

Activities

To remove an error, proceed as described in the long text of the message.

Any messages that you do not handle immediately need to be handled at the next possible opportunity.
5.4 Post-Upgrade Activities

General Information

This part of the documentation contains general information on the post-upgrade activities that you need to perform after you have upgraded your system.

For any additional information, see the product-specific part of this documentation.

When you perform post-upgrade activities, note the following information (in addition to the information in Upgrade – Step by Step):

- Perform the actions in section Upgrade – Step by Step in the specified order.
- Before you start the post-upgrade activities, you must have run the upgrade up to and including the MODPROFP_UPG phase.
- R3up stops in the MODPROFP_UPG phase and prompts you to start several post-upgrade activities. R3up then executes the last phases and completes the upgrade. At the same time, you can already perform the specified post-upgrade activities.

The post-upgrade activities are divided into three blocks:

- Actions needed before resuming production operation
  These actions ensure that all the processes that are relevant to system operation are available again. You can start these actions while R3up is finishing the upgrade.

- Actions during limited production operation
  During this time, your SAP system is already consistent and all the processes that are relevant to system operation are available. However, this system state does not yet contain measures for optimizing performance, or actions for resuming standard operation (resuming background processing, or adjusting authorizations, for example). Check the actions that are listed in this block and perform them before you restart production operation, if necessary.

- Actions during production operation
  You can also perform these actions when the system is back to production operation.

Actions

You must perform the following actions before you resume production operation of your system:

- DB2 UDB for UNIX and Windows: Performing Specific Actions [page 161]
- DB2 UDB for z/OS: Performing Specific Actions [page 163]
- Informix: Performing Specific Actions [page 165]
- MaxDB: Backing Up the Database [page 166]
- MS SQL Server: Performing Specific Actions [page 167]
- Oracle: Performing Specific Actions [page 167]
- Post-Upgrade Activities for Microsoft Cluster Server (MSCS) [page 169]
- Upgrading the Application Servers [page 169]
- Distributing SAP Programs [page 171]
5 General Upgrade Information

- **Renaming the Local System Log (Source Release 3.1I)** [page 171]
- **Checking the Profile Parameters with Transaction RZ10** [page 172]
- **Installing the SAP Internet Graphics Service [Extern]**
- **Installing the J2EE Engine** [page 172]
- **Reimporting Additional Programs** [page 174]
- **Adjusting Repository Objects** [page 174]
- **Performing Post-Upgrade Activities for the Applications** [page 175]
- **Setting Up Single Sign-On** [page 176]
- **Adjusting Start and Stop Procedures (Source Releases Lower than 4.6A)** [page 181]

You can perform the following actions during limited production operation of your system:

- **Rescheduling Background Jobs** [page 181]
- **Rescheduling DB13 Jobs (Source Release 3.1I)** [page 182]
- **Migrating Matchcodes to Search Help Objects (Source Release 3.1I)** [page 182]
- **Informix: Updating Statistics** [page 183]
- **MaxDB: Updating Optimizer Statistics** [page 185]
- **Oracle: Actions for the Cost-Based Optimizer** [page 183]
- **Generating ABAP Loads** [page 185]
- **Generating BSP Applications** [page 186]
- **Performing Actions for the SAP Online Documentation** [page 187]
- **Performing Post-Upgrade Activities in the Authorizations Area** [page 187]
- **Processing Table Clusters After the Upgrade (Source Release 3.1I)** [page 188]
- **Installing More Dialog Instances** [page 189]

You can perform the following actions during production operation of your system:

- **Importing Support Packages After the Upgrade** [page 190]
- **Transport Management System (TMS): Distributing the Configuration** [page 190]
- **Performing Post-Upgrade Activities for the Language Transport** [page 191]
- **Oracle: Deleting Tablespaces** [page 191]
- **Converting Batch Input Logs** [page 192]
- **Saving Files for Further Upgrades** [page 193]
- **Evaluating the Upgrade Runtime** [page 193]
5.4.1 DB2 UDB for UNIX and Windows: Performing Specific Actions

Prerequisites

You have not yet resumed production operation of the SAP system.

In the following description, the variables <dbsid> and <DBSID> are used in the text. They have to be replaced with the correct value.

- More than one SAP system on the database:
  
  Display the environment variables of user <sapsid>adm (as user <sapsid>adm) by choosing Start → Settings → Control Panel → System → Advanced → Environment and find the variable DB2DBDFT. Set <dbsid> and <DBSID> as follows:
  
  - For variable <dbsid> use <value of DB2DBDFT in lower case>.
  - For variable <DBSID> use <value of DB2DBDFT in uppercase>.

- Only one SAP system on the database:
  
  - For variable <dbsid> use <sapsid>.<DBSID> = <SAPSID>
  - For variable <DBSID> use <SAPSID>.

Procedure

Installing and Updating the DB2 Admin Tools

The installation, upgrade and configuration of the DB2 Admin Tools is described in the Database Administration Guide: SAP on IBM DB2 Universal Database for UNIX and Windows. For the latest information about installing or upgrading the Admin Tools, see SAP Note 455506.

The following procedure contains only the minimum steps to update the Admin Tools executables and administration database:

1. Log on as user <sapsid>adm.
2. Execute the following command:

   `<drive of the kernel DVD>:\K<x>\NT\I386\DBTOOLS\SDDB6INS -u <release of previously installed Admin Tools> -db2dbnamepwd <password of the db2<dbsid> user>`

Activating Log Archiving

If you did not reactivate log archiving for the database with R3up, you must convert the database parameters LOGRETAIN and USEREXIT.

To do this, enter the following commands in the DB2 command line:

   `db2 update db cfg for <DBSID> using LOGRETAIN ON`
   `db2 update db cfg for <DBSID> using USEREXIT ON`

   **For DB2 UDB EEE Only:** If you have configured your database with multiple partitions, you must adapt the database parameters on all partitions. To do this, execute the following commands on partition 0 (catalog node):

   `su - db2<dbsid>`
   `db2_all "db2 update db cfg for <DBSID> using LOGRETAIN ON"`
General Upgrade Information

```
db2_all "db2 update db cfg for <DBSID> using USEREXIT ON"
```

You must then make a full database backup before DB2 can permit new database connections.

**Backing Up the Database**

Perform a full backup of the database.

**Deleting Substitution Tablespaces**

After the upgrade, a number of tablespaces are no longer used and you can delete them. This applies to the following tablespaces in a System Switch Upgrade:

<table>
<thead>
<tr>
<th>For Non-MCOD Systems</th>
<th>For Systems with MCOD Layout</th>
</tr>
</thead>
<tbody>
<tr>
<td>PSAPES&lt;source release&gt;D</td>
<td>&lt;SAPSID&gt;#ES &lt;source release&gt;D</td>
</tr>
<tr>
<td>PSAPES&lt;source release&gt;I</td>
<td>&lt;SAPSID&gt;#ES &lt;source release&gt;I</td>
</tr>
<tr>
<td>PSAPEL&lt;source release&gt;D</td>
<td>&lt;SAPSID&gt;#EL&lt;source release&gt;D</td>
</tr>
<tr>
<td>PSAPEL&lt;source release&gt;I</td>
<td>&lt;SAPSID&gt;#EL&lt;source release&gt;I</td>
</tr>
</tbody>
</table>

where `<source release>` is the source release for the current upgrade.

If the source release is the same as the target release, R3up cannot use the normal naming conventions. To distinguish the old tablespace from the new tablespace, R3up adds an X to the name of the new tablespace:

PSAPES<source/target release>DX. In this case, you can delete the old tablespace PSAPES<source/target release>D.

To delete a tablespace, enter the following command at the operating system level:

```
db2 drop tablespace <tablespace name>
```

DB2 checks whether there are still database objects in the specified tablespace before it executes this command. If there are, the command is not executed.

**Updating Statistics**

1. Log on to the SAP system.
   You require the authorizations for database administration and background jobs.
2. Call transaction DB13.
3. Double-click a cell in today's date to display a dialog box for scheduling actions.
4. In the list field, choose **RUNSTATS and REORGCHK for all tables**.
5. Set the parameters **Maximum runtime** and **Maximum runtime for long fields** to 0.
   This removes runtime restrictions for the job.
6. Choose **Execute**.
   **Runstat_all** is scheduled for today and started immediately.
The time required to update statistics depends on the size of the database. You need about one hour for a database of 2 GB.

7. Check the progress of the job.
   To do this, double-click the entry for the action in the calendar. The dialog box with the details of the action contains the log file of the job.

**Scheduling Update Statistics Jobs**

1. Log on to the SAP system.
   You require the authorizations for database administration and background jobs.
2. Call transaction DB13.
3. Choose *Pattern Setup*.
   Several defined database actions appear.
4. Choose the following actions:
   - *Check Tables for Statistics Update*
   - *RUNSTATS and REORGCHK (DBSTATC)*
   - *RUNSTATS and REORGCHK for all Tables*
5. To page through the descriptions of the selected actions, choose *Next* and enter a start time for each one. Select times when the system is running, but with a low load.
6. Save your entries.

---

**5.4.2 DB2 UDB for z/OS: Performing Specific Actions**

**Prerequisites**

You have not yet resumed production operation of the system.

**Procedure**

**Backing Up the Database**

Perform a full backup of the database.

**Reorganizing the Database**

Reorganizing the database at this point in time is optional. Only reorganize now if you have enough time. Otherwise reorganize the database according to the usual cycle.

For a list of all tablespace and indexes that you need to reorganize, see the file `<upgrade directory>\bin\DB2RGTSFLST`. 
Importing Correction Transports

Import the transports and the SAP Basis Support Packages that are relevant for DB2 UDB for z/OS. For more information, see SAP Notes 661260 and 686905.

Adjusting Storage Attributes of New Tables

The storage attributes for some special tables are lost during the upgrade because the tables are new. You have to repeat the tuning of these tables after the upgrade. This affects the following tables:

- VBDATA, VBHDR, VBMOD (see SAP Note 122599)
  
  Note that transport KDOK000668 which moves VBDATA into a 4K tablespace is automatically imported into the SAP system during the upgrade. Therefore, there is no need to re-apply this transport.

- DDXTF, DDNTT

Removing Empty Database Objects

This step can be postponed if there is not enough time.

1. Use report RSDB2CLN to check whether there are any empty database objects that you no longer need, such as tablespaces, databases and stogroups.
2. If objects and tables that are no longer required are displayed, use the report to remove them.
3. Execute the report as a background job.

Installing SAP Software on z/OS

This step can be postponed if there is not enough time.

Install and configure the following SAP tools on z/OS:

- saposcol
  
  For details refer to the Planning Guide: z/OS Configuration for SAP on IBM DB2 UDB for z/OS.

- Rfcoscol
  
  The procedure is described in the SAP Database Administration Guide: IBM DB2 UDB for z/OS.

End of DB2 UDB for z/OS-specific explanation
5.4.3 Informix: Performing Specific Actions

Informix

Prerequisites
You have not yet resumed production operation of the SAP system.

Procedure
Deleting dbspaces
The following dbspaces are empty after the upgrade and can be deleted.

<table>
<thead>
<tr>
<th>For a non-MCOD system</th>
<th>For a system with MCOD layout</th>
</tr>
</thead>
<tbody>
<tr>
<td>psapes&lt;source release&gt;</td>
<td>psap&lt;sapid&gt;es&lt;source release&gt;</td>
</tr>
<tr>
<td>psapel&lt;source release&gt;</td>
<td>psap&lt;sapid&gt;el&lt;source release&gt;</td>
</tr>
</tbody>
</table>

where <source release> is the source release for the current upgrade.

If the source release is the same as the target release, R3up cannot use the normal naming conventions. To distinguish the old dbspace from the new dbspace, R3up adds an x to the name of the new dbspace: psapes<source/target release>x. In this case, you can delete the old dbspace psapes<source/target release>.

Proceed as follows:
1. First check that the dbspaces really are empty. To do this, start dbaccess as user informix and enter the following SQL statement:
   ```sql
   select count(*) from systables where dbinfo('DBSPACE',partnum) = '<dbspace name>'
   and partnum != 0;
   count(*) = 0 should be the result.
   ```
2. Execute this statement for both of the dbspaces that you want to delete.
3. To delete the dbspaces use the database tool onspaces as follows:
   ```bash
   onspaces -d <dbspace name>
   ```

Before you can use the space freed by deleting the dbspaces, you must make a level 0 database backup.

Backing Up the Database
There are two different procedures when you back up the database, depending on whether you have operated the database during the upgrade with the backup mode activated or deactivated.

- Backup: Database was operated with backup mode activated
Since a large number of logical log files were created during the upgrade, make a full offline or online backup of the database as quickly as possible. Otherwise restoring the database may be very time-consuming.

- Backup: Database was operated with backup mode deactivated
  Reactivate the backup mode, and then create a full backup of the database. Make this backup offline.

End of Informix

5.4.4 MaxDB: Backing Up the Database

MaxDB

Prerequisites
You have not yet resumed production operation of the SAP system.

Procedure
1. Stop the SAP system.
   ! The database parameters only become active when the database has been stopped and started.
2. Make the database capable of being recovered again. This step depends on whether archiving is switched on or off.
   a. Archiving switched off
      Since the log mode is reset to the original value after the upgrade, you must back up the database completely in operating mode ADMIN (same as operating mode COLD in SAP DB version 7.3) before you can start production operation again.
      You can only continue the upgrade in operating mode ONLINE (same as operating mode WARM in SAP DB version 7.3).
   b. Archiving switched on
      We recommend that you make a full backup so that you do not have to upgrade all the logs again if you need to recover the database.
      You can make an incremental online backup instead of a full backup. However, we recommend that you make a full backup as soon as possible after the incremental backup.
3. Start the SAP system.

End of MaxDB
5.4.5 MS SQL Server: Performing Specific Actions

Procedure

1. Create a full online backup of the database.
2. Start the SQL Server Agent, if it is not running.

These are actions that have to be performed for every SAP product. See also the actions that are listed in the product-specific part under Post-Upgrade Activities for the SAP Web Application Server.

5.4.6 Oracle: Performing Specific Actions

Oracle

Prerequisites

You have not yet resumed production operation of the system.

Procedure

Creating and Updating the SAPDBA Role

To increase the security of your system, do not assign the DBA role to the OPS$ database users as of Basis Release 4.x. You have already performed most of the required manual changes when you migrated Oracle to the required version (see the guide Upgrading to Oracle <number> Release <number>: Windows).

The upgrade imports additional objects that you need to adjust. This means that you must execute the SQL script sapdba_role.sql again.

Proceed as follows:

1. Log on as user <SAPSID>ADM at Windows level.
2. Start the SQL script with:

   cd %ORACLE_HOME%\database
   copy <DRIVE>:\usr\sap\<SAPSID>\SYS\exe\run\sapdba_role.sql
   sapdba_role.sql
   sqlplus /nolog @sapdba_role <SAPSCHEMA_ID> NT

   Where <SAPSCHEMA_ID> is R3 for SAPR3 and <SID> for SAP<SID>

   If the following error message appears, you can ignore it:

   Error accessing PRODUCT_USERPROFILE
   Warning: Product user profile information not loaded!
   You may need to run PUBLD.SQL as SYSTEM.

Checking the Environment Variables for the BR*Tools Program

To check whether all the environment variables have been set correctly for BR*Tools, see the online documentation under:
Adding New Parameters to the init<DBSID>.sap Profile (Basis Source Releases Lower than 4.5A)

As of Basis Release 4.5, new parameters are used for creating backups with the `brbackup`, `brarchive`, and `brestore` programs. If you want to use the new functions of these programs, you must use an editor to enter them in the profile `<ORACLE_HOME>\database\init<DBSID>.sap`.

If you make backups to a remote tape device (`backup_dev_type = pipe | pipe_auto | pipe_box`), replace the parameter `read_fifo_cmd` (no longer supported as of Release 4.5A) with the following parameters:

- `remote_host = <remote host name>`
- `remote_user = <remote user name>`

For detailed information, see the online documentation about database administration for Oracle.

In particular, you must adjust the `compress_cmd` parameter in `init<DBSID>.sap` as follows:

- If you use tape device hardware compression for backups (software compression is only used to determine the compression rate)
  ```
  compress_cmd = "<DRIVE>:\usr\sap<\SAPSID>\sys\exe\run\mkszip -l 0 -c $ > $"
  ```

- If you use software compression for backups (`brbackup option brbackup -k yes`)
  ```
  compress_cmd = "<DRIVE>:\usr\sap<\SAPSID>\sys\exe\run\mkszip -c $ > $"
  ```

Back up the Database

The procedure for backing up the database depends on the mode with which you operated the database during the upgrade.

Backup: Database Was Operated in NOARCHIVELOG Mode

Activate ARCHIVELOG mode again and create a full backup of the database. This must be executed as an offline backup.

Proceed as follows:

1. Stop the SAP system.
2. Activate ARCHIVELOG mode again. To do this, execute the `ARCHIVE_ON.BAT` script from the directory `\usr\sap<\SAPSID>\sys\exe\run`. This stops and starts the database again.
3. Use the `brbackup` program to start the offline backup of the database.
4. When you have made the backup, you can start up your SAP system again.

For more information about offline backups and `brbackup`, see the SAP online documentation on database administration for Oracle.
5.4.7 Post-Upgrade Activities for the Microsoft Cluster Server

Use

Some post-upgrade activities are necessary for an MSCS configuration. For more information, see SAP Note 544988.

Procedure

1. Stop the SAP system and the SAP service.
2. Perform the steps listed in SAP Note 544988.
3. Set the resource SAP-R/3<SAPSID> online in the cluster administrator.

5.4.8 Upgrading the Application Servers

You upgrade the application server in a series of steps. You may need to perform the following steps:

- **Upgrade the operating system**
  
  Upgrade your operating system to Windows 2000, or Windows Server 2003 with the latest Service Pack.

- **Migrate/Upgrade the database software**
  
  You can find information on this in your database-specific upgrade guide or migration guide.

- **Source Release 4.6A and lower: Change the instance profile of the application server**
  
  R3up never adjusts instance profiles of the application servers, even if software is stored centrally.

  Therefore, make the following changes in the instance profile of the application server. The instance profile \(<SAPSID>_<SPECIFICATION><INSTANCE NO.>_<HOST NAME>\) is located in the directory \(\text{usr}\backslash\text{sap}\backslash<SAPSID>\backslash\text{sys}\backslash\text{profile}\).

  - **Profile parameters** `ipc/shm_psize_40` and `ipc/shm_psize_10`

  The following messages may appear in the developer trace (trace file `dev_disp` in the directory `\text{usr}\backslash\text{sap}\backslash<SAPSID>\backslash<INSTANCE NAME>\<INSTANCE NO.>\work}`):
I Profile configuration error detected, use temporary corrected setup
I Shared Pool 40: ipc/shm_psize_40 = 22000000 (too small)
I Shared Pool 40: (smaller than min requirement 39832400)
I Shared Pool 40: (estimated size assumed 44000000)

(The same messages may appear for ipc/shm_psize_10.)

You do not have to process these messages, since the SAP system automatically uses correct values.

- Increase the parameter value rsdb/cua/buffersize by 2400.
- Profile parameter rdisp/elem_per_queue

You can only set the parameter rdisp/elem_per_queue in the instance profile of an application server if it is also set in the start profile of this server at the same time.

If the parameter is set to the same value for all instances, it can also be set in the default profile (and you do not need to set it a second time in the start profile). If you do not stick to this restriction, the configuration will be inconsistent when you start the SAP service.

- **Switch administration to the Microsoft Management Console**

The actions in this section are executed automatically when you run R3up.

In this step:

- The snap-in for the Microsoft Management Console is configured.
- The environment variable dbms_type=<dbtype> is set.
- Various Windows NT Dynamic Link Libraries (DLL) are updated, if they do not match the version required by SAP. If R3up has updated DLLs, you must restart your computer and run R3up again.

Proceed as follows:

a. Insert the DVD *SAP Kernel* in the DVD drive.

b. Switch to a local directory on your hard disk and copy the R3up.exe program from the DVD (NT\I386 directory; for Windows Server 2003 for 64 bit: NT\IA64) to the local directory.

c. Start R3UP.exe to upgrade the application server with the following command:
   R3up.exe upg_applserver

d. If an R3up dialog box tells you that R3up cannot locate MSVCP60.DLL, you must first execute the R3dllins.exe program from the *SAP Kernel* DVD. This program is in the directory NT\I386\NTPATCH.

- **Restart the application server**
5.4.9 Performing Post-Upgrade Activities for the SAP Kernel

Installing the SAP Kernel

For production operation, you must replace the kernel which has been installed during the upgrade with the current kernel from SAP Service Marketplace.

For more information about how to install the current kernel, see SAP Note 19466.

Distributing SAP Programs

If your SAP system has multiple application servers and you do not use NFS to share the kernel directory of the central instance, you must distribute the programs in directory /usr/sap/<SAPSID>/SYS/exe/run to all servers.

If you use distributed servers, we recommend that you use NFS to share programs in /usr/sap/<SAPSID>/SYS/exe/run. This avoids inconsistent programs and having to distribute them manually.

To keep the network load low, you can also save the programs locally on the servers and update them automatically with program sapcpe.

For more information on using sapcpe, see Help → SAP NetWeaver Library → SAP NetWeaver → Application Platform (SAP Web Application Server) → ABAP Technology → Client Server Technology → System Services → Setting Up Local Executables on UNIX SAP Instances.

5.4.10 Renaming the Local System Log (Source Release 3.1I)

Use

The format of the system log was changed for Release 4.0. The SAP kernel cannot correctly interpret entries in the old format. This means that you must have an empty system log when you start the system with Release 4.x for the first time. You can create an empty system log by renaming the old system log. If a log does not exist, a new one is created when you start the system.

R3up already renamed the central and local system logs on the host with the central instance.

This is not done automatically on the remote application servers. If you use the SAP system with multiple application servers then you have to rename the local system log on these remote servers.

Prerequisites

Your source release is 3.1I.

Procedure

Rename the SLOG<INSTANCE NO.> in directory \usr\sap\<SAPSID>\<INSTANCE NAME>\log.

SLOG<INSTANCE NO.>.OLD.
### 5.4.11 Checking the Profile Parameters with Transaction RZ10

**Use**

After the upgrade, use transaction RZ10 to check the settings in your system profiles. This transaction checks the profiles of all servers.

**Procedure**

1. Make sure that all active servers (SAP instances) are started.
2. Make sure that you have the authorization S_RZL_ADM in the SAP system.
3. Call transaction RZ10.
4. Choose Utilities → Import profiles → Of active servers.
5. Choose Utilities → Check all profiles → Of active servers.
   - If parameters are set incorrectly, a warning appears.
6. Check the parameters whose values differ from the default.
   - You can use transaction RZ10 to display the parameters with their current settings and their default value.
     - a. On the initial screen of the transaction, choose Goto → Profile values → Of a server.
     - b. Double-click a server to display its settings.

   Whenever possible, return the parameter values to the default values.

For more information about changing the profile parameters, choose SAP NetWeaver Library → SAP NetWeaver → Solution Life Cycle Management → System Management → Configuration → Profiles in the online documentation for the target release.

### 5.4.12 Installing the J2EE Engine

**Use**

The J2EE Engine is an integral part of the SAP Web Application Server 6.40. The use of the J2EE Engine largely depends on the business scenario you are upgrading to. In the following, we will describe several different installation and migration options. For information on which option to choose, see the Upgrade Master Guide for your business scenario.

When upgrading to this release, there are three different cases, depending on your system landscape on the source release:

- New central SAP system installation
- J2EE Engine 6.20 exists
- J2EE Engine 6.30 exists

**Prerequisites**

You have upgraded the central instance successfully.
The database you are using for the J2EE Engine must be Unicode-enabled.

**Informix**

You can not use the Informix database for the J2EE Engine. If you would like to use the J2EE Engine, you have to additionally install either MaxDB or DB2 UDB for UNIX and Windows.

*End of database-specific explanations*

**Procedure**

**New Central SAP System Installation**

There is no installation of an J2EE Engine on the source release, and the business scenario you are implementing requires an J2EE Engine 6.40. In this case, you can install the J2EE Engine on the central instance. With this installation, all mandatory SAP components are installed on the same host, including the central services instance.

Install the J2EE Engine as described in the documentation *Installation Guide – SAP Web Application Server Java 6.40 on <Platform>: <Database>*.

**J2EE Engine 6.20 Exists**

There is an installation of an J2EE Engine 6.20 on the source release and the business scenario you are implementing, requires an J2EE Engine 6.40. In this case, install the J2EE Engine according to the documentation *Installation Guide – SAP Web Application Server Java 6.40 on <Platform>: <Database>*.

This will replace the existing J2EE Engine 6.20 with the J2EE Engine 6.40.

**J2EE Engine 6.30 Exists**

To upgrade to J2EE Engine 6.40, apply the relevant J2EE Engine Support Packages.
5.4.13 Reimporting Additional Programs

**Use**

During the upgrade, the contents of directory `\usr\sap\<SAPSID>\sys\exe\run` are completely deleted before the new SAP kernel is imported. If you installed additional programs in this directory, such as the RFC library, the CPIC library, or ArchiveLink, you must install them again from the *Presentation DVD*.

**Procedure**

Enter the following commands:

1. `cd \usr\sap\<SAPSID>\sys\exe\run`
2. `<drive>:\SDK\NT\I386\SAPCAR.EXE -xvf <drive>:\SDK\NT\I386\<additional package>.SAR`
   
   Windows Server 2003 for 64 bit:
   
   `<drive>:\SDK\NT\IA64\SAPCAR.EXE -xvf <drive>:\SDK\NT\IA64\<additional package>.SAR`

5.4.14 Adjusting Repository Objects

**Use**

If you have made modifications to programs, screens or interfaces (GUIs), you must adjust them with transaction SPAU.

Until now, customer exits were used to enhance the standard SAP system without modifying it. To exploit the advantages of the new Business Add-In technology, and to unify enhancement techniques, some of the customer exit definitions you use might have been migrated to Business Add-Ins by SAP. You can migrate the customer exits you have implemented to Business Add-In implementations at the touch of a button. The implementations that need migrating are displayed by the modification adjustment functions.

**Procedure**

For more information on the modification adjustment, see the online documentation for the target release under *SAP NetWeaver Library → SAP NetWeaver → Application Platform (SAP Web Application Server) → ABAP Technology → ABAP Workbench → Changing the SAP Standard → Upgrade Procedure / Support Packages → Adjustment of Repository Objects*.

💡 After you have completed the upgrade you have a maximum of 14 days to execute transaction SPAU without the key being checked (SAP Software Change Registration) for the objects that you modified.
5.4.15 Performing Post-Upgrade Activities for the Applications

Use

Some applications require you to perform some application-specific post-upgrade activities, without which the applications cannot run. If you need to display Release Notes in your SAP system, proceed as follows:

- In the IMG structure, choose Additional Information → Release Notes.
- If you want to display the Release Notes independently from the IMG, choose Help → Release Notes.

When you choose this option for the first time, you are prompted to generate the Release Notes before you can display them.

Procedure

Application-Specific Activities

These application-specific activities are described in the Release Notes for the particular application, and in the product-specific part of this documentation.

Source Release SAP Basis 4.6D and lower: Converting Codepages

In SAP Basis Release 6.10, the codepage administration has changed considerably. If you have created customer-specific codepages starting with “9”, and you want to continue using them after the upgrade, convert the codepages with report RSCP0126.

For more information, see SAP Notes 485455, 413396, and 511732.

Adjusting Customer Developments

The programs and applications that you have written, which run without errors on the source release, may contain syntax or runtime errors after the upgrade. These may be caused by additional developments of the ABAP Workbench, changes to the ABAP syntax, or stronger syntax checks when you upgrade from one release of SAP Basis or SAP Web AS to the next one.

For information about recommendations for adjustments and instructions, see the following SAP Notes:

<table>
<thead>
<tr>
<th>SAP Note</th>
<th>SAP Basis/SAP Web AS Release</th>
</tr>
</thead>
<tbody>
<tr>
<td>178482</td>
<td>3.1 to 4.0</td>
</tr>
<tr>
<td>178452</td>
<td>4.0 to 4.5</td>
</tr>
<tr>
<td>178725</td>
<td>4.5 to 4.6</td>
</tr>
<tr>
<td>367676</td>
<td>4.6 to 6.10</td>
</tr>
<tr>
<td>452229</td>
<td>6.10 to 6.20</td>
</tr>
</tbody>
</table>
5.4.16 Secure Single Sign-On with Microsoft NT LAN Manager SSP

Use

Single Sign-On (SSO) is a mechanism that allows your users to access a number of systems, distributed applications, or shared resources on a network after a single interactive authentication. Based on cached information (“credentials”) from the initial interactive user authentication, automatic re-authentication takes place for each access to resources across the network by the underlying Single Sign-On authentication technology. After the single interactive logon procedure, hundreds or thousands of automatic network-level authentications are possible. Depending on the particular SSO mechanism, there may be a time limit on the capability of automatic re-authentication, after which another interactive logon will be required.

Most users like SSO because they do not have to type passwords over and over again and they no longer have to memorize multiple (different) passwords. Many administrators like SSO because they only have to maintain a single user and password database and users will call them less often because of forgotten passwords.

We have a number of Single Sign-On options available. Some of the options are only available when using a Web front end (for example, X.509 certificates), while others are available using the SAP GUI for Windows (for example, Secure Network Communications). Some offer integrity and confidentiality protection for the entire communication, while others are purely used for authentication. When deciding which option you want to use, you should consider your security needs and the complexity of your IT landscape. For more information, see SAP Note 138498.

This section describes the option that is the easiest to implement when using a complete Microsoft Windows landscape (Win 9x, Win ME, Win NT, Win 2K). It is a tailored version for SSO using Secure Network Communications (SNC) that uses the Microsoft NT domain authentication (NTLM SSP = NT LAN Manager Security Service Provider). For more information on using SNC, see the SNC User Guide that is available on the SAP Service Marketplace at the Internet address service.sap.com → security.

Typically, SNC requires the use of an external security product that adheres to the Generic Security Service API V2 (GSS-API V2) interface and has been certified by the SAP Software Partner Program. However, in this scenario, we provide a library that adheres to the GSS-API V2 interface on one side that talks to Microsoft's NTLM SSP on the other. Since NTLM SSP is already an integral part of the Microsoft Windows 32-bit platforms, you do not need to purchase an additional security product to be able to use Single Sign-On.

⚠️ The Microsoft NTLM SSP only provides authentication based on a challenge-response authentication scheme. It does not provide data integrity or data confidentiality protection for the authenticated network connection. All third-party BC-SNC certified security products do offer data integrity and privacy protection. If you want to use these security features, you will have to obtain a certified security product.

For pure Microsoft Windows 2000 environments we also offer an alternative library (gsskrb5.dll) that uses the Microsoft Kerberos SSP instead of the NTLM SSP for authentication. The Microsoft Kerberos SSP offers data integrity and confidentiality protection. When using gsskrb5.dll, the Microsoft Kerberos SSP is interoperable with Kerberos implementations from other vendors/suppliers. To use SSO with application servers on Unix and W2K front ends with gsskrb5.dll, a Kerberos implementation for the Unix
machine(s) may have to be purchased. We distribute two different versions of the wrapper library for Microsoft NTLM SSP. The older version is called gssapi32.dll and the newer version is called gssntlm.dll. The newer gssntlm.dll is available for download on the sapservX. It contains a few additional workarounds for bugs in Microsoft's NTLM SSP. gssntlm.dll works on all existing Microsoft Win32 platforms and with all supported SAP software releases (SAP system kernel Release 3.1I and newer, and SAP system database 3.0F and newer).

For additional security aspects involved with this scenario, see SAP Note 165485.

**Prerequisites**

- An all Microsoft Win32 environment is required (Win 9x/ME, Win NT, Win 2K, Win XP). The Microsoft NTLM SSP is not available for UNIX or any other operating system.

- When using separate Windows NT domains for users, for their front-end PCs and for the SAP application server machines, then bi-directional trust is required between these Windows NT domains.

- SAP GSS-API V2 library wrapper (gssapi32.dll/gssntlm.dll) must be installed on the application server(s).

- SAP GSS-API V2 library wrapper must also be installed on every front-end PC.

- All Windows NT user IDs must be from the 7-bit ASCII character space. It may not be possible to enter Windows NT user IDs that contain 8-bit characters into the USRACL table (by using transaction SU01, for example) when the code page of the SAP system is different from the code page on the Windows machines. The combination of Windows ANSI (=ISO Latin 1) and the default SAP code page 1100 provide the same encoding of 8-bit characters and will permit the use of 8-bit characters with gssntlm.dll.

**Integration**

For information on how to improve the security of your system with the help of third-party products, see the SAP online documentation on Secure Network Communications. To view the documentation, choose mySAP Technology Components → SAP Web Application Server → Security → Secure Network Communications (SNC).

**Activities**

To use Microsoft NTLMSSP for Single Sign-On, you need to:

- Install the gssapi32.dll/gssntlm.dll and configure SNC on the application server.

- Install the gssapi32.dll/gssntlm.dll and configure the SAP GUI and SAP Logon on the front-end PC.

- Maintain a mapping between the Windows NT user accounts and their SAP system user IDs.

Before you begin this, you must first start the Service Windows LM Security Support Provider:

2. Select the service NT LM Security Support Provider.
4. In the Properties dialog box, on the General tab, change the startup type from manual to automatic.

**Configuration SNC on the Application Server**

1. Install the GSS-API V2 library (gssapi32.dll or gssntlm.dll) on the application server. SAP recommends that you install it in the directory `<drive>:\usr\sap\<SAPSID>\sys\exe\run`.
2. Set the environment variable `SNC_LIB` to the location of the library.
3. In the profile of the central instance, enter the following SAP parameters:

   **Required SNC Parameters:**
   
   - `snc/data_protection/max = 1`
   - `snc/data_protection/min = 1`
   - `snc/data_protection/use = 1`
   - `snc/enable = 1`
   - `snc/gssapi_lib = location of the GSS-API V2 library`  
     (<drive>:\usr\sap\<SAPSID>\sys\exe\run\gssapi32.dll or gssntlm.dll>)
   - `snc/identity/as = p:<DOMAIN_NAME><SAP Service User>`

   `<SAP Service User>` is the user who starts the SAP system.

   `<DOMAIN_NAME>` is the Windows NT domain of this user.

   Although you can freely choose the Windows NT account under which the SAP system runs, it is typically SAPService<SAPSID>.

   If you use a local account for SAPService<SAPSID>, most operations will work; however, any operations or communications where the SAP system is the initiator of an SNC-protected communication to a remote machine will **NOT** work with a local account for SAPService<SAPSID>. Therefore, use a domain account.

   **Additional SNC Parameters:**

   The following profile parameters allow you to continue to have password-based access to the SAP system when SNC has been enabled. You have to use these additional parameters at least once after enabling SNC to be able to log on to the SAP system as an administrator to maintain the mapping of Windows NT user accounts to SAP system user IDs (user and client). Once the mapping (at least for the administrator) has been entered, you can disable further password-based logons by removing the respective profile parameter(s).

   - `snc/accept_insecure_cpic = 1`
   - `snc/accept_insecure_gui = 1`
   - `snc/accept_insecure_rfc = 1`
   - `snc/permit_insecure_start = 1`
   - `snc/permit_insecure_comm = 1`
4. Stop and restart the SAP system to enable the profile parameters to take effect. Changes to SNC profile parameters always require an application server restart to take effect.

**Configuration SAP GUI and SAP Logon**

1. Copy the file gssapi32.dll or gssntlm.dll (from the application server directory \usr\sap\<sapsid>\sys\exe\run, for example) to the SAP GUI directory.

On the front-end PC (where the SAP GUI runs), you have two alternatives for installation:

   a. Copy gssapi32.dll or gssntlm.dll to a location of your choice and set the environment variable SNC_LIB using the Control Panel to that location, for example, <DRIVE>:\<SAPGUI_PATH>\gssapi32.dll.

   b. Copy gssapi32.dll or gssntlm.dll to a directory of the default search path, for example, %SystemRoot%\system32 (on Windows NT) and rename the file as sncgss32.dll. This is the default file name that SNC will use when SNC_LIB is neither passed on the command line nor available in the environment.

2. Set the required logon options to activate Single Sign-On.

   a. In the SAP logon window, choose Edit and in the window that opens, Advanced. The Advanced Options dialog box appears.

   b. In the SNC name field, enter:

   
   p:<DOMAIN_NAME>\<SAP service user>

   Where <DOMAIN_NAME> is the Windows NT domain that the SAP system user (SAPService<SID>) belongs to.

   ![The administrator of the system HWA, belonging to the domain DEC_NT, would enter:](image)

   Entries in the SAP Logon window with SNC enabled show a small yellow key in the icon. When the SAP administrator has entered the mapping between a Windows NT account and the corresponding SAP system user ID (see below), the user can then log on to the SAP system with SNC without having to enter a password. If only one possible match exists between the Windows NT account and the SAP system user ID, then the logon screen is skipped (unless the profile parameter snc/force_login_screen = 1 is present in the instance profile of the application server).

**Maintaining the User Mapping**

Once you have configured your system, you can enable SAP system users to log on using Single Sign-On by maintaining the mapping between their Windows NT user accounts and their SAP system user IDs.

1. Log on to the SAP system.

   a. Choose Tools → Administration → Maintain users → Users.

   Alternatively, call transaction SU01.

   b. The User Maintenance window appears.

2. Enter the name of the SAP user and then choose User names → Change.
5 General Upgrade Information

3. Choose the SNC tab. In the field SNC name, enter the name of the Windows NT user that corresponds to the SAP system user in uppercase: \p:<\text{DOMAIN_NAME}>\<\text{NT_USERNAME}>

Where \text{<DOMAIN_NAME>} is the Windows NT domain that the Windows NT user belongs to and \text{<NT_USERNAME>} is the Windows NT user account name. \text{\p:} is a prefix that all SNC names require. \text{\p:} is a prefix that all SNC names need.

For the Windows NT user Kissnerj belonging to the domain SAP_ALL, enter \text{p:SAP_ALL\kissnerj}.

4. Select \text{Insecure communication permitted}. This permits the user to still access the system without using the Single Sign-On feature, for example, when working in a different domain.

5. Save your entries.

**Configuration of Kerberos Single Sign-On**

With Windows 2000, it is possible to implement Single Sign-On using the Kerberos security protocol. Single Sign-On is a method of logging on to the system that simplifies the authentication process for the user. It allows a user that has logged on to Windows 2000 to access other SAP Systems without entering an additional user ID or password. The security context for authentication is made available with the Application Programming Interface (API) and Kerberos. The user simply has to select an SAP System in the SAP logon window, or click on its shortcut, to automatically start the authentication process in the background.

The advantage of the Single Sign-On solution based on Kerberos is that the security information which has to be exchanged between the SAP front end and the SAP application server is encrypted. This encryption is not implemented for the solution available for SAP on Windows that is based on the Generic Security Service API (GSS-API) interface.

⚠️ Single Sign-On based on Kerberos can only be set up for users that are members of a Windows 2000 domain.

💡 When using \text{gsskrb5.dll}, the Microsoft Kerberos Security Service Provider (SSP) is interoperable with Kerberos implementations from other vendors/suppliers. To use SSO with application servers on Unix and Windows 2000 frontends with \text{gsskrb5.dll}, you might have to purchase a Kerberos implementation for the Unix machine(s).

For more details see section “Configuration of Kerberos Single Sign-On” in the documentation \text{Installation Guide SAP Web Application Server 6.20 on Windows: <Database>}. 
**5.4.17 Adjusting Start and Stop Procedures (Source Release Lower than 4.6A)**

**Use**

The parameters of the programs `stopsap.exe` and `startsap.exe` changed in Release 4.6A.

**Procedure**

Check all scripts that use the tools for stopping and starting the SAP System, as well as the transport configuration file `TPPARAM`.

The following values are expected as parameters as of Release 4.6A:

- `name=<SAPSID> nr=<instance number> SAPDIAHOST=<HOST>`

**5.4.18 Rescheduling Background Jobs**

**Use**

Use this procedure to release all background jobs that were locked when you isolated the central instance.

**Procedure**

- **For source releases up to and including 4.0B**
  - a. Log on in client 000 as user `DDIC`.
  - b. Call transaction SM37.
  - c. Find all the relevant jobs.
  - d. To release the jobs, choose `Job → Schedule → Release`.

- **As of Source Release 4.5x**
  - a. Log on in client 000 as user `DDIC`.

Errors may occur if a background report was changed by the upgrade, since the report variants will no longer be correct. If this is the case, you must reschedule the job.
5.4.19 Rescheduling DB13 Jobs (Source Release 3.1I)

Use
At the start of downtime, you deleted all scheduled jobs. You can now reschedule these jobs with transaction DB13 (see also Isolating the Central Instance [page 220]).

Prerequisites
- Your source release is 3.1I.
- You have already checked that all old DB13 jobs were deleted properly.

Procedure
1. Call transaction SM37 in the SAP system.
2. Select the following jobs:

<table>
<thead>
<tr>
<th>Selection Item</th>
<th>Entry</th>
</tr>
</thead>
<tbody>
<tr>
<td>Job name</td>
<td>DBA*</td>
</tr>
<tr>
<td>User name</td>
<td>*</td>
</tr>
<tr>
<td>Start date from</td>
<td>No entry</td>
</tr>
<tr>
<td>Start date to</td>
<td>No entry</td>
</tr>
<tr>
<td>Only jobs with status</td>
<td>scheduled, released, ready, active</td>
</tr>
</tbody>
</table>
3. Delete all the jobs displayed.
4. Call transaction DB13 and reschedule your jobs.

5.4.20 Migrating Matchcodes in Search Help Objects (Source Release 3.1I)

Use
As of Release 4.0 the ABAP Dictionary objects help views and matchcodes are replaced by the new ABAP Dictionary object Search Help. The upgrade migrates most matchcodes to search helps automatically. Only in exceptional cases do you need to follow up these actions manually. These exceptions are listed in the Release Note DDIC40_MC_MIGR Migration of Matchcodes to Search Helps.

Prerequisites
Your source release is 3.1I.

Procedure
Use the Release Note Migration of Matchcodes to Search Helps to check if manual post-upgrade activities are necessary.
You can find this Release Note offline on the documentation DVD.
If you have already installed the current online documentation, the Release Note is in the SAP system. Choose Help → Release Notes → Complete list from Rel. 4.0 → 40A → Basis Components → ABAP Workbench → ABAP Dictionary → Activation Program, Conversion Program, DB Utility, MC, SPDD → Migration of Matchcodes in Search Helps.

5.4.21 Informix: Updating Statistics

Informix

Use
To improve the response of the database after the upgrade, use the sapdba program to perform an Update Statistics.

Procedure
To do this, enter the following command:

```
sapdba -updstat
```

End of Informix

5.4.22 Oracle: Performing Actions for the Cost-Based Optimizer

Oracle

Use
The following text only describes those actions that you need to perform for the Cost-Based Optimizer (CBO) directly after the upgrade. For more information on this topic, see the following documents in the target release online documentation:

- SAP NetWeaver Library → SAP NetWeaver → Application Platform (SAP Web Application Server) → Databases → Oracle → CCMS: Oracle → Update Statistics for Cost-Based Optimizer in CCMS (Oracle)

Procedure

Switching the Optimizer Mode (for Basis Source Release3.1I)
You must switch the database optimizer to cost-based optimizer mode after the upgrade. You can make this switch during production operation.
When you run the database in rule-based mode you significantly reduce the performance of the system. SAP no longer supports the parameter setting optimizer_mode = rule after the upgrade to SAP Basis 4.x and higher.

Proceed as follows:

1. The cost-based optimizer requires table statistics to be created.

   Use the following command to call the brconnect program:
   ```
   brconnect -c -f stats -t all
   ```
   If the user system does not have the default password manager you need to add the following command option in front of the -f option:
   ```
   -u system/<password>
   ```
   You can do this during production operation. The runtime depends strongly on the size of your database and can take several hours. System performance is reduced considerably during this time.

   Check the success of the action with one of the following options:
   
   - In the SAP system, make sure that the return code is either 0 or 1 by choosing Administration → CCMS → DB Administration → Operations Monitor.
   - Check the logs in the file system if necessary.
     ```
     <SAPDATA_HOME>/sapcheck/*.sta
     ```
   If there are errors, you can analyze the cause by double-clicking the log line and pushbutton Detail Log in the menu above. If you cannot solve the problem yourself, send a problem message and the log file to SAP.

   Correctly created optimizer statistics are essential for the performance of your system.

2. The Optimizer must be set to cost-based mode.

   Make sure that the following parameters are set in the file %ORACLE_HOME%/database\init<SAPSID>.ora:
   ```
   optimizer_mode = choose
   db_file_multiblock_read_count = 8
   ```

3. Restart the database to activate the parameters.

**Updating the Statistics (for Basis Source Release 4.x)**

If your system had Basis Release 4.x before the upgrade, your database is already running in cost-based optimizer mode. After the upgrade you only need to update the statistics.

Use the following command to call the brconnect program:
```
brconnect -c -f stats -t all
```  
If the user system does not have the default password manager you need to add the following command option in front of the -f option:
```
-u system/<password>
```  
You can do this during production operation. System performance is reduced considerably during this time.
Scheduling Periodic Statistics Updates (For All Source Releases)

Make sure that the statistics are updated at regular intervals. After the database has been in use for one day after the upgrade, schedule the next call periodically (every Saturday or Sunday night, for example).

```
brconnect -c -f stats -t all
```

You can schedule these actions with transaction DB13. For more information on transaction DB13, see the online documentation under Help → Application help.

End of Oracle

5.4.23 MaxDB: Updating Optimizer Statistics

MaxDB

Use

To improve the response times of the database, you must also update the optimizer statistics after the upgrade.

Procedure

Proceed as described in Making Preparations at the Database Level [page 131]. Schedule this action as soon as possible, to avoid a drop in your system performance.

End of MaxDB

5.4.24 Generating ABAP Loads

Use

After an upgrade, the ABAP loads for the SAP system programs do not yet exist. When you call a program, a load is automatically generated, if it does not already exist. This may, however, reduce production system performance. To avoid this, you can use transaction SGEN to generate the missing loads.

Transaction SGEN offers the following functions:

- Selection of predefined generation tasks. Choose Regenerate after an SAP System upgrade.
- Selection of software components to restrict the amount of objects being generated (SAP_ABA, SAP_BASIS and so on)
- Selection of the application servers for parallel generation
- Generation in the background
- Job Monitor for checking the progress of the generation in the background
5 General Upgrade Information

Procedure

If you are planning to install a new SAP kernel after the upgrade, do not start the load generation until after the installation. Kernel parameters introduced with the new kernel might invalidate the loads.

If possible, generate the loads directly after the upgrade. Load generation requires a large amount of system resources.

For a detailed description of the features, see the online documentation in transaction SGEN by choosing Information on the SAP Load Generator, or in the Job Monitor by choosing Job Monitor.

For more information on the free space requirements in the load tables, see SAP Note 186066.

5.4.25 Generating BSP Applications

Use

After an upgrade, the Business Server Page applications (BSP applications) do not yet exist. If you plan to implement BSP applications in your SAP system, you can generate them with transaction SGEN.

Transaction SGEN offers the following functions:

- Selection of predefined generation tasks. Choose Generation of BSP Applications.
- Selection of software components to restrict the amount of objects being generated (SAP_ABA, SAP_BASIS and so on)
- Selection of the application servers for parallel generation
- Generation in the background
- Job Monitor for checking the progress of the generation in the background

Procedure

Start to generate the BSP applications as soon as possible after the upgrade. The generation requires a large amount of system resources.

For a detailed description of the features, see the online documentation in transaction SGEN by choosing Information on the SAP Load Generator, or in the Job Monitor by choosing Job Monitor.
5.4.26 Performing Actions for the SAP Online Documentation

You must perform the following actions before you can display the online documentation (SAP Library) in your SAP system:

- Install the files for the online documentation.
- For help type PlainHtmlHttp: Set up the Web server.
- Maintain the settings variants for the Online Help in the IMG.
- Install a Web browser/viewer.

For the exact procedure, see the documentation *Installing the SAP Library*.

5.4.27 Performing Post-Upgrade Activities in the Authorizations Area

Procedure

Adjusting the Assignments Between Check Flags and Transactions

You can use transaction SU24 to do the following:

- Deactivate checks within a transaction.
- Define proposals for the profile generator for activated checks.

Both the check flags and the default values are based on SAP default values. To change these, call transaction SU24.

To copy the latest SAP default values while retaining your own modifications, call transaction SU25 (steps 2 and 3):

- The transaction displays the differences between your own check flags or authorization default values and the new SAP default values for all the changes by SAP.
- It also defines all the roles which will have to be generated later on with the profile generator, so that authorizations can be generated for all the current checks.

For more information, see the online documentation for transaction SU25.

Upward Compatibility for Authorization Checks

Some functions are protected in more detail by new authorization objects in the new release. The authorizations for these new objects are in the single profiles SAP_NEW_<rel>, where <rel> is the release for which the new authorization check was delivered. The composite profile SAP_NEW contains all single profiles SAP_NEW_<Rel> (the naming convention S_NEW_<rel><number> applies as of Release 4.6A).

⚠️

The SAP_NEW composite profile contains all the individual SAP_NEW_<Rel> profiles. This means that the composite role also contains the overall authorization for the S_TCODE check.
Every user should have the profile SAP_NEW in his or her master record. This guarantees that after an upgrade users can still perform the same functions that they were able to perform previously without an authorization check. Before this, delete all the individual profiles from SAP_NEW that refer to releases that are lower than the source release for the upgrade.

After the upgrade the user administrator must go through the profile SAP_NEW and decide for each authorization object, into which customer profile the authorizations need to be copied. This defines which users can continue to perform the corresponding functions.

Empty and activate the SAP_NEW profile after completing these actions. To do this, remove the single profile SAP_NEW_<rel> from the composite profile SAP_NEW. Keep the single profiles SAP_NEW_<rel>, so that you can find out later which authorization appeared in which release.

The SAP_NEW profile does not contain the authorizations for functions delivered in the upgrade. It only contains the authorizations for new checks in functions that have already been delivered.

**Handling Problems with User Buffers**

If the user master records were already very large before the upgrade, the predefined buffer size might not be large enough for the newly delivered profiles. If you encounter authorization problems after the upgrade where authorizations are missing for users although they are included in the master record, see [SAP Note 10187](#).

### 5.4.28 Processing Table Clusters After the Upgrade (Source Release 3.1I)

**Use**

The table clusters EDIDOC and CDCLS are converted after the upgrade from Basis Release 3.1I to Basis Release 4.x and higher. Since there is often a large amount of data to handle, you can use transaction ICNV to convert the table clusters during production operation of the system. This considerably reduces the downtime during the upgrade.

> The time when you process the table clusters is not critical, but it must be done before you begin the next upgrade. If you have not, PREPARE warns you about any outstanding conversions. You will not be able to start the upgrade.

**Prerequisites**

Your Basis source release is 3.1I.

**Procedure**

1. Call transaction ICNV.

    Read the online documentation. For more information on the individual fields, choose F1.
Directly after the upgrade, the tables EDIDOC and CDCLS must have the status Conversion. If they do not, create a problem message under the component BC-UPG-TLS.

2. To start the data transfer, choose Control → Data transfer → Start.

3. Monitor the progress of the action. After a while, the estimated time for the remaining data transfer appears automatically.

4. When at least 95% of the data has been converted, switch to the new tables.
   
   To do this, choose Control → Switch (STRG+F2). You now have the option of selecting tables and starting the process in the background. Any data that has not yet been transferred is included in the process.

5. End the conversion.
   
   As soon as the tables have the status Done, you can delete them from the list. To do this, choose Control → Delete entry (STRG+F3). You can then select the tables you want to delete and remove them from the list.

⚠️
You must complete step 5 before you start the next upgrade.

### 5.4.29 Installing More Dialog Instances

#### Use

You can use the SAP tool SAPinst to install more dialog instances in an SAP system.

#### Procedure

Proceed as described in the documentation *Installation Guide: Additional Instances on <Platform>*.
5.4.30 Importing Support Packages After the Upgrade

Use
To avoid problems with your SAP software, we recommend importing new Support Packages into your system as soon as they become available. This also applies after the upgrade, in order to avoid potential problems in your system before they occur.

If you have not included all the necessary Support Packages during the upgrade, you can also import them after the upgrade.

Procedure
Import the newest Support Packages. Always start with the newest SPAM update.

If you want to install additional languages in your SAP system, perform the language import before you import the Support Packages. The Support Packages always contain the current language version for text-relevant objects.

For information on importing a language, see the online documentation under Help → SAP NetWeaver Library → SAP NetWeaver → Solution Life Cycle Management → Change and Transport System → Language Transport.

5.4.31 Transport Management System: Distributing the Configuration

Use
After an upgrade, you must distribute the information about the new release to all systems in the transport domain.

Procedure
If your Transport Management System has already been set up, proceed as follows:

1. Log on to the system that is configured as the domain controller.
2. Call transaction STMS and choose Overview → Systems.
3. Select the system that has been upgraded and choose SAP System → Update Configuration.
4. Choose Extras → Distribute TMS Configuration.
5.4.32 Performing Post-Upgrade Activities for the Language Transport

**Use**

To reduce downtime during the upgrade, some data from the Languages DVD was only imported into container tables, and not yet imported into the actual database tables of the system. This data includes glossary and terminology data. If you want to use a glossary or terminology in your system, use the following procedure to copy the data from the container tables to the database tables.

**Prerequisites**

- You have imported a language during the upgrade.
- You are using a glossary or terminology in your system.

**Procedure**

Call transaction SMLT.

The transaction automatically recognizes that post-upgrade activities are necessary, and schedules a background job for this purpose.

5.4.33 Oracle: Deleting Tablespaces

**Oracle**

**Use**

After the upgrade, several tablespaces are empty and are no longer used. You can delete these tablespaces. This applies to the following tablespaces in a System Switch Upgrade:

<table>
<thead>
<tr>
<th>For a non-MCOD system</th>
<th>For a system with MCOD layout</th>
</tr>
</thead>
<tbody>
<tr>
<td>PSAPES&lt;source release&gt;D</td>
<td>PSAP&lt;SAPSID&gt;&lt;source release&gt;</td>
</tr>
<tr>
<td>PSAPES&lt;source release&gt;I</td>
<td></td>
</tr>
<tr>
<td>PSAPEL&lt;source release&gt;D</td>
<td></td>
</tr>
<tr>
<td>PSAPEL&lt;source release&gt;I</td>
<td></td>
</tr>
</tbody>
</table>

where `<source release>` is the source release for the current upgrade.

💡 If the source release is the same as the target release, R3up cannot use the normal naming conventions. To distinguish the old tablespaces from the new tablespace, R3up adds an X to the name of the new tablespace: `PSAPES<source/target release>DX`. In this case, you can delete the old tablespace `PSAPES<source/target release>D`. 
To delete tablespaces, use the program `BRSPACE`. This program checks whether the following prerequisites are met:

- The tablespace is empty.
- The space is actually released.

Make sure that no other application has access to the files.

**Procedure**

1. Start the program `BRSPACE` at the operating system level as user `<SAPSID>ADM` with the following command:
   ```
   brspace -f tsdrop
   ```
2. Choose *Drop tablespace*.
3. Select the tablespace you want to delete.
4. Choose *Continue* to drop the tablespace.
   
   If the tablespace is empty, `BRSPACE` executes the `drop` command on the database and deletes the data files at the operating system level.

---

**5.4.34 Converting Batch Input Logs**

**Use**

As of Release 4.6C, the system only supports the new batch input log procedure. All old batch input logs must be converted with program RSBDCLCH in all clients, otherwise the system cannot read them. The old log files are deleted after they have been converted successfully.

**Prerequisites**

You have not yet converted your logs from a Basis release lower than 4.6C.

**Procedure**

For the procedure and additional information, see SAP Note 175596.
5.4.35 Saving Files for Follow-Up Upgrades

Use

In phase SAVEPRO, several upgrade files are saved in the save subdirectory of the upgrade directory. If you perform a follow-up upgrade with the same environment and the same upgrade strategy, you can reuse these files.

Prerequisites

You are planning a follow-up upgrade with the same environment and the same upgrade strategy.

Procedure

1. After the upgrade, make a backup of the save subdirectory of the current upgrade directory.

2. When you start with the new upgrade, copy the save subdirectory to the new upgrade directory.

   ![You can copy the subdirectory as soon as you have created the new upgrade directory.]

   The following files are saved in the directory and can be used in a follow-up upgrade:
   - Shadow system profile
     - In PREPARE phase SHDINST_CPY, you can reuse the shadow system profiles.
   - Results from phase BIND_PATCH (file patbind.lst)
     - If suitable, you can use the Support Package selection as default selection.

5.4.36 Evaluating the Upgrade Runtime

Use

Our aim is to provide you with a fast and efficient upgrade procedure. In phase EXIT, R3up extracts statistical data and evaluates the upgrade, for example, calculates the runtimes of the individual phases. Evaluating this information helps us to improve both the current upgrade procedure and new upgrades. We would also appreciate feedback on your experience with the SAP upgrade. Therefore, we have designed the SAP System Upgrade Evaluation. It contains the following:

- Upgrade Evaluation Form
  - This form consists of a simple questionnaire on your experiences with the upgrade and an upgrade log file generated by R3up.

- Upgrade Information
  - Using the corresponding link in the text, you can open the file upana.htm. It is designed to help you evaluate your upgrade and to better plan follow-up upgrades. It contains detailed information on the system, the overall upgrade and the individual phases. You can add your own comments to this file.
If you are using the Upgrade Assistant, the *SAP System Upgrade Evaluation* is displayed automatically in a browser window.

**Prerequisites**
- A browser has been installed on the machine from which you are monitoring the upgrade.
- The machine has an e-mail connection.
- The upgrade has finished.

**Procedure**
To send the *Upgrade Evaluation Form* to SAP, proceed as follows:

1. Wait until phase EXIT has finished.
   - If the Upgrade Assistant is running, a browser window appears displaying the *SAP System Upgrade Evaluation*.
   - If the Upgrade Assistant is not running, you are prompted to open the following address:
     
     `http://<host name>:4239/htdocs/eval/index.htm`
   - If you are using scroll mode, open file `index.htm` in the following folder:
     
     `<upgrade directory>\htdocs\eval`

2. Answer the questions under *Upgrade Evaluation Form*.

   Answering the questions is optional.

3. Choose *Send to SAP*.
   
   This submits the *Upgrade Evaluation Form* to SAP.

   After the upgrade has finished, you can return to the *SAP System Upgrade Evaluation* either by directly opening file `index.htm` in subdirectory `\htdocs\eval` of the upgrade directory or by entering the following path:

   `http://<host name>:4239 → Upgrade Evaluation`
6 Additional Information

This part of the documentation contains general information on the following topics:

- Troubleshooting [page 196]
- Upgrade Administration [page 217]
- Upgrade Tools [page 230]
6.1 Troubleshooting

This part of the documentation contains additional information on how to proceed when you want to correct known problems that have occurred during the upgrade.

- Logs
  - Upgrade Logs [page 143]
  - Evaluating the ELG Log Files [page 197]

- Correcting Errors After Phases
  - Correcting Errors in the RFCCHK Phase [page 198]
  - Correcting Entries Made in the INITPUT and INITSUBST Phases [page 199]
  - Correcting Errors in the DBCHK Phase [page 200]
  - Correcting Errors in the BATCHCHK Phase [page 201]
  - Correcting Errors in the INTCHK and INTCHK_SW Phases [page 202]
  - Correcting Errors in the SPACECHK_ALL Phase [page 202]
  - Correcting Errors in the JOB Phases [page 203]
  - Cleaning Up Terminated Conversions in the DB Conversion Phases [page 203]
  - Correcting Errors in the TRBATCHK_XT Phase [page 206]
  - Correcting Errors in the ACT Phase [page 206]
  - Correcting Conversion Errors in the PARCONV Phase [page 207]
  - Correcting Errors in the XPRAS Phase [page 208]

- General Problems
  - Preparing the Restart of the Upgrade After a System Failure [page 210]
  - Resetting the Upgrade [page 210]
  - Correcting Problems when Processing ABAP Steps [page 213]
  - Correcting Problems when Starting the SAP System [page 214]
  - Correcting Problems when Copying SAP Programs [page 215]
  - Providing SAP Support with Information [page 215]

As well as the problems listed here, also read the SAPNet - R/3 Frontend Notes. Request the SAP Notes that are relevant to this upgrade.
6.1.1 Evaluating the ELG Log Files

Use

The <PHASE>.ELG log files are summary log files that contain a list of all the errors that occurred during a specific phase of the upgrade. From these files, you can call up detailed log files that contain more information. When errors are detected during a phase, R3up displays an appropriate message and prompts you to repeat that phase. First check the <PHASE>.ELG log to find out why the step terminated:

- No errors have occurred if a return code less than 8 appears in the log at the end of a step, and no error messages appear for that step.
- Errors have occurred if the return code is 8 and error messages appear before it, or if the return code is greater than 8.

Procedure

1. Analyze the errors, using the detailed log file if necessary. The name of this log is listed in the header of each phase step.
   - If a return code is greater than or equal to 12, then tp or a program called by tp has terminated.
2. Determine when the program terminated from the last two lines of the SLOG log. If tp or R3trans have terminated, analyze the last log that was written. For a chronological list of the files in both log directories, enter the following commands:
   
   ```
   DIR /OD \usr\sap\put\log
   DIR /OD \usr\sap\put\tmp
   ```
3. If a background step in the SAP system terminates, you must analyze the job log in the SAP system to determine the cause of the error.
   a. Log on as user DDIC and call transaction SM37. Enter the job name as the name of the report that usually processes the terminated step (RDDMASGL for DD ACTIVATION, for example).
      - Make sure that the date in the SM37 input screen is correct and that an asterisk (*) appears in the or after event: field. The job overview normally displays one canceled job and one background job that completed normally.
   b. Double-click the canceled job to display the job log.
   c. Double-click the error line to display the long text for the error.

If you use a user ID other than DDIC to log on to the SAP system and correct the error, the SAP system may prevent you from logging on. In this case, proceed as follows:

1. Enter the following commands to unlock the SAP system (here <transport_profile> is the transport profile of the transport domain to which the system is connected):
   ```
   cd \usr\sap\put\exe
   tp.exe unlocksys <SAPSID> pf=<transport_profile>
   tp.exe unlock_eu <SAPSID> pf=<transport_profile>
   ```
2. Log on to the SAP system and correct the error.
3. Enter the following commands to lock the SAP system again:
   ```
   cd \usr\sap\put\exe
   tp.exe locksys <SAPSID> pf=<transport_profile>
   tp.exe lock_eu <SAPSID> pf=<transport_profile>
   ```
4. Once you have found and corrected the error, repeat the phase by selecting repeat in R3up. The repeated phase is usually completed quickly, since the transport control program tp automatically starts from the point at which it terminated.

**Result**

In some cases, you can choose ignore in R3up to continue with the upgrade and avoid repeating the failed phase. Generally, you must always remove the cause of the error. When you choose ignore, R3up prompts you to enter a password if the errors are serious. In this case, you must get approval to ignore the error from SAP Support.

⚠️ A return code of 8 indicates that some individual objects have not been processed or not been processed completely.

Remove all errors to avoid the risk of follow-on errors. If you are not sure how to proceed, contact SAP Support.

### 6.1.2 Correcting Errors in the RFCCHK Phase

**Use**

This phase tests the RFC connection to your SAP system.

**Prerequisites**

An error message appears. This can be caused by the following:

- Your SAP system has not been started.
- Your SAP system cannot be reached with the gateway and password you have specified.

**Procedure**

1. Check whether your system is started and that you have specified the correct gateway.
2. If you need to correct the gateway information, proceed as described in Correcting Entries Made in the INITPUT and INITSUBST Phases [page 199].
6.1.3 Correcting Entries Made in the INITPUT and INITSUBST Phases

Use

If in later phases you find that entries you made in the INITPUT and INITSUBST phases were incorrect, you can correct them.

Frequently, the password of user DDIC is changed during the upgrade. For this reason, background jobs could not be started in the JOB <name> phases or the RUN <name> phases. So that you do not have to reconfirm all the entries you made in the INITPUT phase, you have the option of only changing the password of user DDIC.

Procedure

If you are using the Upgrade Assistant

1. In the main menu of the Upgrade Assistant, choose Administrator → Start R3up with option.
2. If you need to correct entries made in phase INITPUT, enter the following command:
   
   set stdpar

   Usually, it is not necessary to change the password of the user DDIC during the upgrade. After the installation of the shadow system, the password of user DDIC in client 000 is the same as on the original system. If you change the password on the original instance afterwards, you also have to change the password on the shadow instance and in the R3up parameter.

   To change the password of user DDIC, enter the following command:

   set DDICpwd (original system)
   set shDIDCpwd (shadow system)

3. If you need to correct entries made in phase INITSUBST, enter the following command:

   set rswpar

4. Choose exit to exit R3up and then restart the upgrade [page 141], otherwise the changes will not take effect. To do this, use start mode init.

If you are using scroll mode

1. If you need to correct entries made in phase INITPUT, enter the following command:

   R3up set stdpar

   Usually, it is not necessary to change the password of the user DDIC during the upgrade. After the installation of the shadow system, the password of user DDIC in client 000 is the same as on the original system. If you change the password on the original instance afterwards, you also have to change the password on the shadow instance and in the R3up parameter.

   To change the password of user DDIC, enter the following command:

   R3up set DDICpwd (original system)
   R3up set shDDICpwd (shadow system)
2. If you need to correct entries made in phase INITSUBST, enter the following command:

   R3up set rspar

3. Restart R3up, otherwise the changes will not take effect. To start the current phase, use start mode init.

6.1.4 Correcting Errors in the DBCHK Phase

Use
This phase determines the database version and the release of the SAP system. To do this, R3up runs the transport control program tp, which logs on to the database and reads the necessary information from there. Any problems in this phase are usually due to a failed database connection.

Prerequisites
The system has displayed the error message No information received from the database.

Procedure
Depending on your Basis source release, proceed as follows:

Release 3.x – 4.5B

1. Check the SLOG<rel> file in the log subdirectory of the upgrade directory. Any problems with tp are usually due to a non-initialized Workbench Organizer.

2. If the Workbench Organizer has not been initialized, call transaction SE06 in the SAP system as user DDIC.

3. In the initial screen of transaction SE06, select New installation as the system status and then the correct System configuration.

4. Choose Set up.

5. Choose Yes or Continue in the dialog boxes that follow until all the system settings have been made. Exit the transaction.

   Information on transaction SE06 is in the online documentation. To display the documentation, choose Help → Application help in transaction SE06. This takes you to the documentation Setting up the Workbench Organizer and the Transport System. Choose Configuring the Workbench Organizer with Transaction SE06.

Release 4.6x and higher

1. Check the SLOG<rel> file in the log subdirectory of the upgrade directory. Any problems with tp are usually due to a non-initialized Transport Organizer.

2. To initialize the Change and Transport System, call transaction STMS from the Transport Management System (TMS).

   For more information, see the TMS online documentation. To display the documentation, choose Information in transaction STMS, or the following:
6.1.5 Correcting Errors in the BATCHCHK Phase

Use

This phase tests whether the background server can access the upgrade directory. To do this, the background job RDDIT008 is started on the specified background server. This job writes a test log in the tmp subdirectory of the upgrade directory.

Procedure

1. If errors occur, call transaction SM37 to check whether the background job has run.
   o If the background job cannot be started, this is generally due to a problem with the name of the background server.
     i. Check whether the host specified in phase INITPUT is included in the list with a running background service.
        To do this, perform a test call of function module TH_SERVER_LIST in transaction SE37. To display the list, double-click the table parameter LIST after executing the function module.
     ii. Depending on the problem, you either have to change the network configuration or change the entries made in the INITPUT phase.
        To change the entries, proceed as described in Correcting Entries made in the INITPUT and INITSUBST Phases [page 199].
   o If the job terminates, call transaction SM21 to check the system log of the SAP system.
   o If the job is successful, however, R3up cannot find the log, make sure of the following:
     i. The file system of the upgrade directory must be mounted on the background server.
     ii. The value of the SAP profile parameter DIR_PUT must match the current upgrade directory.

2. To repeat the phase, choose repeat.
6.1.6 Correcting Errors in the INTCHK and INTCHK_SW Phases

Use
These phases check whether the inactive nametab is empty. If not, an error occurs.

Procedure
1. Analyze the DDXTTCHK.LOG file to find the affected objects.
2. Call transaction SE11 to activate these objects.
   The inactive nametab is then empty.
3. Call R3up again with repeat.

6.1.7 Correcting Errors in the SPACECHK_ALL Phase

Use
This release requires more space in the database than the previous releases. This phase compares the free space currently available in the database with the minimum requirements for the total amount of imported data. If more space is required in the database, this is shown on screen and in the file DBFPLUSD.LOG.

Prerequisites
In the PREPARE log file CHECKS.LOG the error message Insufficient freespace in the database as follows appears.

Procedure
For a description of the required actions, see Evaluating the Results of PREPARE [page 126], since PREPARE has already made these checks.
6.1.8 Correcting Errors in the JOB Phases

Use

A JOB phase starts a background job in the SAP system and waits for it to be completed. If problems occur during execution of the background job, you receive an error message.

The naming convention for the JOB phases is JOB_<name> or RUN_<name>, where <name> is the name of the job or report.

Procedure

1. Log on to the SAP system as user DDIC.
2. Call transaction SM37 and restrict the start time and start date of the background job as much as possible
   - If no background job was started, this is generally due to a syntax error in the calling program. If there is no SAP Note explaining this error, contact SAP Support.
   - If the background job was started, there are two possible situations:
     - The job was terminated.
       Check whether the error can be reproduced by selecting repeat in R3up. If the error occurs again, contact SAP Support. In this case, proceed as described in Providing SAP Support with Information [page 215].
     - The job was completed normally, but with error messages.
       In certain situations, you can ignore these error messages. In this case R3up does not require a password if you choose ignore. If you are not sure how to proceed, contact SAP Support.

6.1.9 Cleaning Up Terminated Conversions in the DB Conversion Phases

Use

These conversion errors are indicated by the following PREPARE and R3up error messages:

- Restart logs of DB conversions found
- Outstanding DB conversions found

These errors can occur in the phases CNV_CHECK_GEN, CNV_CHECK_IMP and CNV_CHECK_XT.

If both messages appear, process the message Restart logs of DB conversions found first.

Procedure for Restart Logs of DB Conversions Found

To clean up terminated conversions indicated by the message Restart logs of DB conversions found, proceed as follows:
1. Call the database utility transaction (transaction SE14) to find the terminated conversions.

2. Choose DB Requests → Terminated.
   A list of the terminated conversions appears.

3. Double-click a table name to see its details.

4. Check the meaning and status of the table.
   a. Find out whether the table is still needed. Sometimes the tables are test tables that are no longer needed.
   b. Ask the last person who changed the table, or the table owner, to find out its status.
      - If the table is no longer needed, choose Cancel adjustment in the detailed display (Unlock table as of Release 4.5A). This prevents the conversion being continued automatically. The table itself does not return to a consistent state. Any data that is still in the temporary table is lost during the next conversion.
      - In some cases, however, the table was already corrected without the reset log being deleted. The function Cancel adjustment (Unlock table as of Release 4.5A) is harmless in this case.
   c. You can determine the state of the table with Check → Database object and Check → Runtime object.
   d. Also check if the table contains the data you expect. You can do this with transaction SE16, for example. If the data does not exist, it could still be in the temporary table. Contact your SAP consultant or SAP Support for help in saving this data.

5. Determine the cause of the error.
   If you find out that the table is still needed, choose Object log. Look for error messages that explain why the conversions were terminated. You could encounter the following problems here:
   - You cannot find a log because it was deleted at some time in the past. Continue with step 6 (continue the conversion to the end).
   - The log does not contain an error message, but ends abruptly. This indicates that the conversion was stopped by an external event. Call transaction SM21 to read the system log and find out the approximate time the conversion was terminated, and to look for the cause of the error.
   - If the log clearly gives a reason for the error, you must correct it.

6. Continue the conversion to the end.
   In the detailed display, choose Continue adjustment. Since you do not know how long this will take, choose processing type Background.
   The situation can be as follows:
   - The conversion finished successfully. You can see this because the error message disappears, the Check function does not display any further problems, and there is a success message in the object log.
   - The conversion terminates again. A log now exists. Repeat the analysis from step 5 (Determine the cause of the error).
If, after several attempts, you still cannot complete the conversion, contact an SAP consultant or SAP Support.

**Procedure for Outstanding DB conversions found**

To clean up terminated conversions indicated by the message `Outstanding DB conversions found`, proceed as follows:

1. Determine the objects that are affected.
   a. Start the database utility transaction (transaction SE14) and choose `DB Requests → Mass Processing`.
   b. Choose `All requests`.
      
      You now see the worklist of the conversion program. This worklist was generated by developments or modifications in your SAP system, but has not yet been processed.
   c. Choose `DB requests → Created with import`.
      
      This displays the worklist that was not processed correctly during the last upgrade.

2. Check the meaning and status of the requests.
   In contrast to the procedure for the message `Restart logs of DB conversions found`, this procedure can also include requests for indexes, views and matchcode objects. The requests that are found are not always terminated. They might not even have been started.
   a. Ask the last person who changed the object if the request should still be processed.
   b. If the user does not want it to be processed, select the request and choose `Delete selected`.
      
      This removes the objects from the worklist of the conversion program.

   Do not remove requests from the last upgrade.

3. Process the outstanding requests.
   You can select the requests from the list of mass processing requests and schedule a job for execution with the function `Schedule selections`.
   a. Go to the detailed display of the object by double-clicking it in the list of requests created by the import.
   b. Schedule the request, or continue it. Since you do not know how long this will take, choose processing type `Background`. 
6.1.10 Correcting Errors in the TRBATCHK_XT Phase

Use

The tp program uses table TRBAT to communicate with the SAP system. If this table contains entries, they could be the remains of an import or export that either terminated or is still running. PREPARE already made this check.

Procedure

Clean up table TRBAT. For information on this, see Evaluating the Results of PREPARE [page 126] under the following PREPARE messages:

Unresolved request found in TRBAT.

TRBAT entry indicates that a batch job is running.

TRBAT entry indicates that a batch job has finished.

Corrupted TRBAT entry found.

6.1.11 Correcting Errors in the ACT Phase

Use

Depending on the results of the ADJUSTCHK phase, you may be asked in the ACT_<rel> phase to adjust your modifications to SAP objects so that they correspond to the latest SAP standard version of the objects. If your SAP system has been modified, error messages with return code 8 might occur during the ACT_<rel> phase.

Prerequisites

Before you can correct ABAP Dictionary objects that cannot be activated, you may need to unlock the shadow instance of the SAP system. Proceed as follows:

1. Log on as user <SAPSID>adm.
2. Enter the following command:
   
   cd <upgrade directory>\exe
   .\R3up.exe unlockshd <SAPSID>

Procedure

1. Log on to the shadow instance as a user other than DDIC.
   
   If you have not yet created users on the shadow instance, do so now as described in Phase ACT_<Rel> [page 154].
2. Make the required corrections.
To make the corrections, use only the maintenance transaction of the ABAP Dictionary (SE11). Do not try to repair the objects with the Database Utility transaction (SE14). This can cause serious inconsistencies.

3. If you had to unlock the SAP system, as described under “Prerequisites”, lock it again with the following command:

   cd <upgrade directory>\exe
   .\R3up.exe lockshd <SAPSID>

Result

Once you have corrected all the errors, you can proceed with the upgrade where it terminated in the ACT_<rel> phases by selecting repeat in R3up.

If you choose ignore severe errors, all error messages with return code 8 are ignored.

6.1.12 Correcting Conversion Errors in the PARCONV Phase

Use

This procedure enables you to correct problems that occur in the PARCONV_UPG phase. The errors can roughly be divided into two classes:

- Technical problems on the database

  You can recognize these in the system log (transaction SM21), where they are marked with SQL-ERROR followed by an abbreviation with an error number. The problem is often called by a lack of space.

- Logical errors in the object definition

  These could also appear in the form of SQL errors. Some of them, however, are already detected by the system before a command can be given to the database.

  This type of error frequently occurs if you decide to revert to the SAP standard when you use the modification adjustment functions in transaction SPDD (ACT_<rel> phase).

  A field was added to an SAP table. This field was also used in an index or view. In the ACT_<rel> phase, however, you decided to return to the standard definition of the table (using transaction SPDD) and this additional field was removed. The index or view definition is now incorrect since the relevant table field is missing. If the index definition is not corrected, and the ACT_<rel> phase was completed with ignore, there will be errors when the objects are created.

Procedure

1. Analyze the log PARCONV.ELG.
2. Remove the cause of the error.
6. Additional Information

- Technical problems on the database
  Read the documentation in the database system about how to correct the error. If necessary, extend the database.

- Logical errors in the object definition
  Correct the objects. To do this, you can use transaction SE11. In the above example, you could, for instance, remove the deleted field from the index or view definition or re-insert the deleted field into the table. Also check whether the objects that are not contained in the standard system and that are now incorrect can be deleted completely.

3. Repeat the PARCONV_UPG phase.

For more information on alternative procedures, see SAP Note 177680.

6.1.13 Correcting Errors in the XPRAS Phase

Use

If errors occur in the XPRAS_UPG phase during the execution of XPRAS reports, R3up stops and refers to the XPRASUPG.ELG log, which contains error messages with the following header:

```
~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~
XPRA ERRORS and RETURN CODE in <file name>
~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~
```

If this header is followed by lines other than the return code, then errors have occurred while the reports were being executed. In addition to the actual error lines, a separate line indicates the names of the reports that generated the preceding error messages.

You can display a detailed help text for each of these error messages in the SAP system. These texts usually contain all the information you need to correct the error.

Procedure

Finding Help Texts for Error Messages

1. Search the XPRASUPG.ELG log to find the file name specified in the header.

   The file name that appears in the header of XPRASUPG.ELG is important for finding the help text. The file name always has the following format:
   `<SAPR<ID>>.<SAPSID>`
   `<ID>` can be any string of six characters.
   The name of the relevant transport request can be derived from the two names. Replace the `R` with a `K` and delete the period and all characters that follow it. You now have `SAPK<ID>` as the name of the transport request.

2. Log on to the SAP system.

3. Call transaction SE09.
4. Choose Request/task → Display individually and enter the name of the transport request SAPK<ID>.

5. To display the individual transport logs, choose Goto → Transport logs.

6. To navigate to the log display for this step, double-click the line Exec after put.
   You can expand the log to view it in more detail. The error messages will generally be visible as of the second level.
   To display a help text, position the cursor on the error message and choose Long text.

Correcting Errors

1. Follow the instructions in the help text precisely. The help text helps you correct the error.

2. When you have corrected all the errors, repeat the upgrade phase with R3up.

3. If you need more information or if the report still results in errors when you repeat the XPRAS_UPG phase, read the documentation of the report in question. To access this information, log on to the SAP system. Call transaction SE38 and display the documentation for the report that is named in the error log. This documentation is always available in English and German.

4. If you choose ignore, R3up gives you two options for continuing the upgrade:
   - repair severe errors
   - ignore all errors
   Choose repair severe errors. R3up repeats the phase and ignores all error messages with the return code 8. The errors must be removed after the upgrade.
   You require a password for ignore all errors. R3up then continues with the next phase, without executing the following XPRAs. Before you can choose ignore, you must have approval from SAP Support.

Correcting Errors After the Upgrade

If possible, correct errors immediately. However, you can correct some errors that occur during the execution of X Pra reports after you have completed the upgrade. This option makes sense, for example, when special measures in the SAP application areas are necessary to correct the errors, and the corresponding specialists are not available right now. To do this, you must suppress the execution of the corresponding report before you repeat the upgrade phase. After the upgrade, correct the error and run the report manually using transaction SE38.

For technical instructions on skipping an X Pra, see SAP Note 122597.

⚠️ Only skip an X Pra report program if you are sure you can execute it later (for example, if an SAP Note tells you that this is allowed). If you cannot execute an X Pra later and still want to skip it, contact SAP.
### 6.1.14 Preparing the Restart of the Upgrade After a System Failure

**Use**

If the system fails (due to power failure, for example) R3up, tp, and R3trans can no longer perform certain cleanup actions. Before you restart the upgrade after a system failure, you must make sure that you meet the requirements for restarting the system successfully.

**Procedure**

1. Start the SAP system.
2. Log on to the SAP system as user DDIC and call transaction SM31 to delete all the entries from table TRBAT.
3. Call transaction SM37 to delete all the released background jobs related to the processing of a phase, with the exception of RDDIMPDP.
4. To change the status of all the current or active background jobs to canceled, run report RSBTCRPR, and then call transaction SM37 to delete these jobs.
5. Call transaction SM50 to cancel any background jobs that have already been restarted.
6. Move all the logs contained in the tmp subdirectory of the upgrade directory into the log subdirectory.
7. [Restart the upgrade](#page 141).

### 6.1.15 Resetting the Upgrade

**Use**

You need to take different measures to reset the upgrade (because of hardware problems, for example), depending on what stage the upgrade has reached. In addition to resetting the database, you might also have to reset the SAP kernel and the SAP profiles.

You need to distinguish between the following cases:

- **The MODPROF_TRANS phase has not yet been completed**, which means that the important database conversions have not yet started.
- **The MODPROF_TRANS phase has been completed**, which means that the database conversions have started.

![Warning]

Information for the database conversion is stored in the upgrade directory. This means that losing the upgrade directory has the same consequences as losing the database. It is important that the database state and the state of the upgrade directory are always consistent.

The actions you need to take are listed in the following depending on the selected upgrade strategy and the progress of the upgrade. Some of the actions are flagged with comments from 1) to 10). To perform these actions, see the end of this section under Detailed Description.
of the Individual Actions. For information on the progress of the upgrade, see log file R3up.log.

For additional information on resetting an upgrade, see SAP Note 417670. If you have any questions, contact SAP Support.

If you want to reset the upgrade after you have upgraded the operating system or database system, you might need to downgrade these software components. For downgrading options, see the vendor’s specifications. The safest method is to reload a full backup of the whole system, including the operating system.

Procedure

Before Reaching the MODPROF_TRANS Phase

Regardless of the upgrade strategy you choose, no irreversible database changes are made up to this phase.

Proceed as follows:

1. **Only if the database fails:** Import the database backup.
   - **Strategy resource-minimized**
     Use the backup you made before the EU_IMPORT1 phase.
   - **Strategy downtime-minimized**
     The system was in production operation up to the database failure, so make a point-in-time recovery up to the last database state.

2. Perform these follow-up actions:
   a. Stop R3up.
   b. If necessary, stop the shadow instance.
   c. **Strategy resource-minimized**
      Start the central instance.
   d. Execute report RSUPGRES.
      This report deletes all shadow tables, which enables you to restart the upgrade.
      For more information, see SAP Note 417670.
   e. If necessary, save the upgrade directory to another directory for troubleshooting.
   f. Delete the upgrade directory.

3. Restart the upgrade with PREPARE.

After Reaching the MODPROF_TRANS Phase

Upgrade Strategy Downtime-Minimized

1. Reset the database.
   Use the backup you made before the MODPROF_TRANS phase.

   You also need to do this if you lose the upgrade directory.
2. Reset the upgrade directory 4).
3. Reset the SAP profiles 1).
4. If the KX_SWITCH phase has already been completed, reset the SAP Kernel 2).
5. Restart the upgrade in the MODPROF_TRANS phase.

**Upgrade Strategy Resource-Minimized**

1. Reset the database.
   
   Use the backup you made before the EU_IMPORT1 phase.

   *You also need to do this if you lose the upgrade directory.*

2. If any of the following R3up phases have already been completed, perform the relevant action:

<table>
<thead>
<tr>
<th>Phase</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>EU_IMPORT1</td>
<td>Reset the SAP profiles 1)</td>
</tr>
<tr>
<td>KX_SWITCH</td>
<td>Reset the SAP kernel 2)</td>
</tr>
</tbody>
</table>

3. Perform the follow-up actions as described above in step 2 under "Procedure Before Reaching the MODPROF_TRANS Phase".

4. Restart the upgrade with PREPARE.

**Detailed Description of the Individual Actions**

*Reset the SAP profiles 1)*

After the MODPROF_TRANS phase (for upgrade strategy resource-minimized after the EU_IMPORT1 or REQSTOPPROD phase), the instance profile and the default profile of the SAP system are changed by R3up. If this phase has been completed, you must retrieve these two files from the sapnames subdirectory of the upgrade directory. The instance profile is saved in PROFX.BCK, the default profile in DEFPF.BCK.

*Reset the SAP kernel 2)*

The new kernel is active after the KX_SWITCH phase. You must reimport the old kernel when you make the recovery. You can recover the kernel directory from a backup created before the upgrade or from the SAP Kernel DVD of the source release. You must unpack the packages SAPEXE.SAR and SAPEXEDB.SAR from the DVD.

*Delete the upgrade directory 3)*

We recommend that you archive all the subdirectories before you delete the contents of the upgrade directory.

*You can exclude the data directory if you have space problems.*

*Reset the upgrade directory 4)*

You must recover the whole upgrade directory with all its subdirectories. You must have backed up the upgrade directory when you isolated the central instance [page 220] if you want to do this.
Stop the shadow instance 5)

Proceed as follows:

1. Switch to the subdirectory `exe` of the upgrade directory and execute `stopsap.exe` with the following syntax:
   
   ```
   stopsap.exe. name=<SAPSID> nr=<instance number>
   SAPDIAHOST=<HOST>
   
   <instance number>: Instance number of the shadow system
   ```

2. Stop the service of the shadow system.

   If the shadow system is in operation, the TCP/IP ports of the message server, gateway, and dispatcher may be occupied and cannot be used again. If you perform an upgrade again, you cannot use the previous instance number to start a shadow instance. You can solve this problem by rebooting the system, or by choosing a new instance number for the shadow system.

6.1.16 Correcting Problems when Processing ABAP Steps

Use

Some of the ABAP steps are performed in the SAP system. These are:

- ABAP Dictionary activation (A)
- Distribution of ABAP Dictionary objects (S)
- Table conversion (N)
- Matchcode activation (M)
- Import of application objects (D)
- Update of version management (U)
- Execution of XPRAs (R)

The TRBAT table forms the interface between the transport control program tp and the SAP system. To trigger an ABAP step, tp writes control information to this table.

The `JOB_RDDNEWPP` phase schedules the event-driven background job RDDIMPDP to process the entries in table TRBAT.

Procedure

1. Check that the SAP system was started correctly. Log on in client 000 as user DDIC.

2. Call transaction SM37 and check whether the background job RDDIMPDP has been scheduled.
   
   In the *or after event* field, enter an asterisk (*), so that event-driven jobs are also displayed.

3. Check when RDDIMPDP last ran and whether it ran without errors.

4. Check whether the control information in table TRBAT has been entered correctly.
The table must have one HEADER entry and should contain one entry for each transport request. While the ABAP Dictionary objects are being distributed (S) and the tables converted (N), table TRBAT may contain only one HEADER entry, since these steps are not carried out by transport request.

5. Call transactions SM37 and SM50 to check whether RDDIMPDP has already started the background job that processes the ABAP step.

For more information on the transport control program tp, and the communication between tp and the SAP system, see the online documentation for Basis or SAP Web AS of the source release under:

- **Release 3.x**
  
  *Help → R/3 Library → BC – Basis Components → System Administration → Transport Control → Transport Control Program tp*

- **Release 4.x**
  
  *Help → SAP Library → Basis Components → Change and Transport System → BC – Transport Tools → Transport Control Program tp*

- **Release 6.x**
  
  *Help → SAP Library → mySAP Technology Components → SAP Web Application Server → Change and Transport System → Transport Tools → Transport Control Program tp*

### 6.1.17 Correcting Problems when Starting the SAP System

**Use**

tp, the transport control program, automatically restarts the SAP system several times during the individual phases. If the startup attempt fails and the next step requires processing within the SAP system (such as a table conversion), then tp waits for this step to end without result.

**Procedure for Processes Not Ended**

Proceed as follows if the system cannot be started:

1. Check whether the system is running. Log on to the SAP system.
2. Use the Windows Task Manager to check if all if the SAP system processes were stopped when the system was stopped.

   The display must not contain the processes `disp+work` and `msg_server`.

   If these processes do exist, proceed as follows:

   a. Make sure that the processes do not belong to a second SAP system on this host.

   b. Use the Windows Task Manager to end the processes.

3. Attempt to start the SAP System manually.

   If you cannot start the system manually, this is probably caused by changes to the SAP profile made in the phases `MODPROF_TRANS, MODPROF_BAS` and `MODPROFF_UPG`. or
by SAP programs being switched in the **KX SWITCH** phase. In both cases, the increased demands made on computer resources may have caused the problems. If this is the case, try to run the SAP system with fewer dialog processes.

4. If the work processes fail, check the trace files in the directory \usr\sap\<SAPSID>\<INSTANCE>\work for any entries.

   In particular, monitor the files `stderrxxx` and `dev_w0`.

### 6.1.18 Correcting Problems when Copying SAP Programs

**Use**

In the **KX SWITCH** phase, the SAP programs in directory \usr\sap\<SAPSID>\sys\exe\run are switched. Do not start the SAP system and the SAP services during this period; otherwise `R3up` cannot overwrite the old files.

**Procedure**

1. Analyze the log of the copy process. It is located in the `log` subdirectory of the upgrade directory and is called `C<DATE>.<SAPSID>`.

2. Repeat the phase or copy the program manually from the directory `exe` subdirectory of the upgrade directory to the directory \usr\sap\<SAPSID>\sys\exe\run.

### 6.1.19 Providing SAP Support with Information

**Use**

If none of the measures described in Troubleshooting [page 196] solves your problem, contact SAP Support. To enable us to help you as quickly and efficiently as possible, follow the procedure given here.

**Procedure**

If you encounter problems that are specific to the upgrade, create an error message in the SAPNet – R/3 Frontend and assign it to the component BC-UPG. Answer the following questions and put these answers in your customer message:

1. For which SAP component do you want to perform the upgrade?
2. Which release are you upgrading from? Which release are you upgrading to?
3. Which operating system version are you using?
4. What was the original release of your SAP system?
5. In which `R3up` phase does the error occur?
   - This information is listed at the end of the `R3up.log` file located in the upgrade directory.
6. Did you have problems with the SAP system before upgrading?
If an online connection is set up to a defective SAP system, we can find the cause of the error more easily, and can therefore correct it more quickly.

If the program aborts due to an *Access violation* and Dr. Watson responds, then add the last pages of the log file written by Dr. Watson to your message. The log file is called `drwtsn32.log` and is located in your main Windows directory, for instance 

`C:\WINNT\drwtsn32.log`.

For tips on the correct configuration of Dr. Watson, see SAP Note 33772.

If you are certain that the problem is not an upgrade-specific one but a product-specific one, assign your error message to the appropriate product-specific component. The following table gives you information on the different components to which you can assign your message in SAPNet – R/3 Frontend.

<table>
<thead>
<tr>
<th>SAP Product</th>
<th>Component in SAPNet – R/3 Frontend</th>
</tr>
</thead>
<tbody>
<tr>
<td>Index Management Server</td>
<td>BC-SRV-TRX</td>
</tr>
<tr>
<td>OLTP R/3 System</td>
<td>BC-UPG</td>
</tr>
<tr>
<td>R/3 Standalone Gateway</td>
<td>BC-UPG</td>
</tr>
<tr>
<td>SAP Add-On</td>
<td>BC-UPG-ADDON</td>
</tr>
<tr>
<td>SAP Supply Chain Management</td>
<td>APO-BAS</td>
</tr>
<tr>
<td>SAP Business Connector</td>
<td>BC-MID-BUS</td>
</tr>
<tr>
<td>SAP Business Information Warehouse</td>
<td>BW-SYS</td>
</tr>
<tr>
<td>SAP Business-to-Business Procurement</td>
<td>BBP-SAD</td>
</tr>
<tr>
<td>SAP Customer Relationship Management</td>
<td></td>
</tr>
<tr>
<td>- Communication Station and Mobile Development Workstation</td>
<td>CRM-MW</td>
</tr>
<tr>
<td>- CRM Server</td>
<td>BC-MID-INT-SRV</td>
</tr>
<tr>
<td>- Internet Pricing and Configurator (IPC)</td>
<td>CRM-MT-IU-SPE</td>
</tr>
<tr>
<td>- Mobile Client Component</td>
<td>CRM-WBT-IU</td>
</tr>
<tr>
<td>- R/3</td>
<td>BC-UPG</td>
</tr>
<tr>
<td>SAP TREX Search Engine (SAP DrFuzzy Search Engine)</td>
<td>BC-SRV-TRX</td>
</tr>
<tr>
<td>SAP Frontend</td>
<td>BC-INS</td>
</tr>
<tr>
<td>SAP Internet Transaction Server</td>
<td>BC-FES-ITS</td>
</tr>
<tr>
<td>SAP Knowledge Management</td>
<td>KM-KW</td>
</tr>
<tr>
<td>SAP Enterprise Core Component</td>
<td>BC-UPG</td>
</tr>
<tr>
<td>SAP Strategic Enterprise Management</td>
<td>BC-UPG-ADDON</td>
</tr>
<tr>
<td>SAP Web Application Server ABAP</td>
<td>BC-UPG</td>
</tr>
<tr>
<td>SMART Installation</td>
<td>BC-UPG</td>
</tr>
</tbody>
</table>
6.2 Upgrade Administration

This part of the documentation contains additional information on the various administrative tasks that you need to perform before and during the SAP system upgrade.

- Determining Versions [page 217]
- Setting the Environment of the SAP Kernel [page 218]
- Creating Shares and Directories and Checking Authorizations [page 219]
- Changing the Virtual Memory/Paging File Size [page 219]
- Isolating the Central Instance [page 220]
- Extending Free Space in the Database [page 221]
- Changing the Database Recovery Mode [page 224]
- Using a Different Upgrade Directory [page 226]
- Releasing and Confirming Open Repairs and Requests [page 226]
- Sending a Message when User Action Is Required [page 228]
- Using the Phase List for the Upgrade [page 228]

6.2.1 Determining Versions

Procedure

Determining the Operating System Version

Choose Windows Explorer → Help → About Windows.

Determining the Database Version

DB2 UDB for UNIX and Windows

Open a DB2-CLP window and enter the following command:

```
db2level
```

For version 7.1, the value SQL07010 is displayed.

Informix

Execute the following operating system command:

```
onstat -V
```

MaxDB

Enter the following operating system command:

```
dbmcli -u <CONTROLUSER>,<CONTROLUSER PASSWORD> -d <DBNAME> show version
```
MS SQL Server

Execute the following command in the MS SQL Server Query Analyzer:

```sql
select @@version
```

The first line of the output displays the MS SQL server release number.

Oracle

Open the Oracle Server Manager. Enter the following SQL statement:

```sql
SELECT BANNER FROM V$VERSION;
```

The first line of the display contains the Oracle server release. The last character of the release indicates the patch level.

End of the database-specific explanations

Determining the SAP Release

To find out what SAP source release you have, choose `System → Status` in your SAP system. The release appears in the `SAP Release` field.

Determining the SAP Kernel Version

To determine the version of the kernel you are using and its patch number, proceed as follows:

1. From the SAP system menu, choose `Tools → Administration → Monitor → System Monitoring → Servers`.
2. Select a server and choose `Release info`.

Determining the Date of R3trans

Call `R3trans` without options.

The program displays the date and the version number.

Determining the Version of tp

Call `tp` with the following command:

```text
tp -V
```

The last line displays the highest patch level.

6.2.2 Setting the Environment of the SAP Kernel

The runtime environment of the SAP kernel consists of the following:

- system environment variables set when the system is started.
- environment variables listed in Registry under the key `HKEY_LOCAL_MACHINE → SOFTWARE → SAP → <SAPSID> → Environment`.

These environment variables correspond to the user environment of the user entered in the Registry under the key `HKEY_LOCAL_MACHINE → SOFTWARE → SAP → <SAPSID> → AdmUser`.

Each time the SAP System is started, the user-specific environment for this user is copied to the subkey `Environment`, so that manual changes in this subkey do not have any effects.
6.2.3 Creating Shares and Directories and Checking Authorizations

Use

You must check the authorizations on a shared directory, or create a share.

Procedure

Creating a share

1. Open the Windows Explorer and position the cursor on directory that you want to share.
2. Choose File → Properties → Sharing → Shared As.

Checking the permissions of a share

1. In the Windows Explorer, position the cursor on directory that you have released.
2. Choose File → Properties.
   In the Share Name field, you can see all shares that are set for this directory. Select your share name and choose Permissions.

Creating a directory

1. In the Windows Explorer, position the cursor on directory under which you want to create a subdirectory.
2. Choose File → New → Folder.
3. Replace the name New Folder of new subdirectory with the new directory name.

Checking the permissions for a directory

1. In the Windows Explorer, position the cursor on directory that you want to check for a permission.
2. Choose File → Properties.

Displaying attributes of an executable

1. In the Windows Explorer, position the cursor on file where you want to check or set the attributes.
2. Choose File → Properties.

6.2.4 Changing the Virtual Memory/Paging File Size


6.2.5 Isolating the Central Instance

Use

You need to isolate the central instance so that only the upgrade program can work with the system during downtime. This means that you can use the central instance exclusively for the upgrade. R3up asks you to isolate the central instance when downtime begins.

During downtime, all users must have logged off the system. You can use transaction SM02 to inform the users logged on to the system.

Procedure

1. Make sure that no job is scheduled in the NT Scheduler that affects the SAP system, such as starting and stopping the SAP system, backing up the database, or similar actions. This could impair the full control of R3up over the SAP system.

2. **Applies to Basis Source Release 3.1I only:** Delete scheduled jobs in transaction DB13

   As of SAP Basis Release 4.0B, transaction DB13 uses different internal job formats. Since transaction DB13 can no longer read the old job formats after the upgrade, you must delete all jobs scheduled for the future.

   Proceed as follows:
   
   
   b. Double-click a day header to see its job overview.
   
   c. Position the cursor on the job that you want to delete and choose **Delete**.
   
   d. Repeat steps b. and c. until you have deleted all jobs that have not yet been executed.

   As of Basis Release 4.0B, transaction DB13 uses different internal job formats. Since transaction DB13 can no longer read the old job formats after the upgrade, you must delete all jobs scheduled for the future.

3. No background job other than RDDIMPDP may be active during the upgrade.

   As of **Basis Source Release 4.5B**, these jobs are automatically descheduled by R3up.

   **For all other Basis source releases**, you must cancel the release of all background jobs except RDDIMPDP before the upgrade in all clients. To do this, proceed as follows for each client:

   a. Log on to the client as user **DDIC**.
   
   b. Call transaction SM37.
   
   c. Determine the jobs involved.

      Fill in the necessary information on the screen **Select background jobs** as described in the example below. In the **Start date** field, make sure that the from date is in the past. The To date must be far enough in the future to include all the background jobs that could become active during the upgrade.

   d. Choose **Execute**.

   e. Cancel the release by choosing **Job → Schedule Job → Cancel**.

   f. **Special feature in client 000**

      The background job RDDIMPDP must be scheduled in client 000. If it is not, schedule it by executing the report RDDNEWPP (transaction SE38).
The upgrade is not affected if RDDIMPDP is also scheduled in other clients.

4. Make sure that no change of operation mode is defined on the central instance during the upgrade. If this is the case in normal operation, call transaction SM63 to either choose a single operation mode for all time spans or delete all the assignments.

5. Clean up all outstanding updates as described in Evaluating the Results of PREPARE [page 126] when the message Update records still exist - Please process appears.

6. Shut down all application servers, if necessary (secondary SAP instances).

7. Make sure that you can recover the database to its current state.

8. If you have chosen the strategy downtime-minimized, back up the upgrade directory now.

   If a hardware problem occurs during downtime, you may need to reset the upgrade to the state it had when the SAP system was isolated. So that R3up has the correct control information, the upgrade directory must have the same state as at the beginning of the MODPROF_TRANS phase.

9. If the central instance and the database server are on the same host, you can lock the database against remote access. Contact the database administrator.

   ! Make sure that no transport requests are imported into the system during downtime. Otherwise you may lose data. For example, by manually importing requests for the automatic adjustment, you may lose all your modifications to the SAP standard.

6.2.6 Extending Free Space in the Database

Procedure

DB2 UDB for UNIX and Windows

Extend the listed tablespaces by at least the specified values.

Create the new tablespaces as prompted by PREPARE. This applies to the following tablespaces in a System Switch Upgrade:

<table>
<thead>
<tr>
<th>For a system with old layout</th>
<th>For a system with new layout</th>
</tr>
</thead>
<tbody>
<tr>
<td>PSAPES&lt;Rel&gt;D</td>
<td>&lt;SAPSID&gt;#ES&lt;Rel&gt;D</td>
</tr>
<tr>
<td>PSAPES&lt;Rel&gt;I</td>
<td>&lt;SAPSID&gt;#ES&lt;Rel&gt;I</td>
</tr>
<tr>
<td>PSAPEL&lt;Rel&gt;D</td>
<td>&lt;SAPSID&gt;#EL&lt;Rel&gt;D</td>
</tr>
<tr>
<td>PSAPEL&lt;Rel&gt;I</td>
<td>&lt;SAPSID&gt;#EL&lt;Rel&gt;I</td>
</tr>
</tbody>
</table>

where <Rel> stands for the current target release.

For performance reasons, you must consider the following restrictions when you create the new tablespaces (in the order they are listed):
Different containers of a tablespace must be located on different (physical) disks.

Corresponding index and data tablespaces must not be on the same disk, and must not be in the same sapdata directory.

PSAPES<Rel>D and PSAPEL<Rel>D or <SAPSID>#ES<Rel>D and <SAPSID>#EL<Rel>D should not be on the same disk.

To create or extend tablespaces, you can use the DB2 Admin Tools or a DB2 Command Line Processor Template generated by PREPARE (see the CHECKS.LOG file).

When you extend tablespaces, use the option of extending existing tablespace containers. This means that the database does not need to trigger a rebalancing process.

For more information, see the SAP online documentation on database administration for DB2 UDB for UNIX and Windows.

Informix

Extend the listed dbspaces by at least the specified values.

Create the new dbspaces as required by PREPARE. This applies to the following dbspaces in a System Switch Upgrade:

<table>
<thead>
<tr>
<th>For a system with old layout</th>
<th>For a system with new layout</th>
</tr>
</thead>
<tbody>
<tr>
<td>psapes&lt;rel&gt;</td>
<td>psap&lt;sapid&gt;es&lt;rel&gt;</td>
</tr>
<tr>
<td>psapel&lt;rel&gt;</td>
<td>psap&lt;sapid&gt;el&lt;rel&gt;</td>
</tr>
</tbody>
</table>

where <rel> stands for the current target release (lowercase).

When you create new dbspaces, make sure that they are not located on the same disk. This improves performance.

For information on extending and creating dbspaces, see the SAP online documentation on database administration for Informix.

The space check is made at the dbspace level. If you moved tables with delivery classes other than L to your own dbspaces, you should have roughly the same size free space available in these dbspaces as in the original dbspaces of the tables. A typical example is moving ATAB from the psappool dbspace.

MaxDB

To extend your database, create a new devspace. For a precise description, see SAP Note 34690.

MS SQL Server

If you are asked to extend the database, it may be due to the following reasons:

- The default option Automatically grow file is not active.
- There is not enough disk space on the drives where the SQL Server data files are located.
- The maximum size of the data files for the Automatically grow file option is restricted.

Extend the available disk space by at least the values determined by PREPARE.
If you use tablespaces where the AUTOEXTEND feature is turned on, the PREPARE or R3up free space check includes this in its calculation. However, you may still have to create the new tablespaces.

Extend the listed tablespaces by at least the specified values.

Create the new tablespaces as prompted by PREPARE. This applies to the following tablespaces in a System Switch Upgrade:

<table>
<thead>
<tr>
<th>For a system with old layout</th>
<th>For a system with new layout</th>
</tr>
</thead>
<tbody>
<tr>
<td>PSAPES&lt;Rel&gt;D</td>
<td>PSAP&lt;SAPSID&gt;&lt;Rel&gt;</td>
</tr>
<tr>
<td>PSAPES&lt;Rel&gt;I</td>
<td></td>
</tr>
<tr>
<td>PSAPEL&lt;Rel&gt;D</td>
<td></td>
</tr>
<tr>
<td>PSAPEL&lt;Rel&gt;I</td>
<td></td>
</tr>
</tbody>
</table>

where <Rel> stands for the current target release.

For performance reasons, you must take the following restrictions into consideration when creating the new tablespaces:

- index tablespaces and data tablespaces that belong together must not be on the same disk, and must not be in the same sapdata directory
- PSAPES<Rel>D and PSAPEL<Rel>D should not be on the same disk.

We recommend the following combination:

Disk 1: PSAPES<Rel>D and PSAPEL<Rel>I
Disk 2: PSAPEL<Rel>D and PSAPES<Rel>I

To extend and create tablespaces, use the BRSPACE program. For more information, see the SAP Online Documentation on the BRSPACE program. You can use a command line template for BRSPACE generated by PREPARE (see file CHECKS.LOG).

BRSPACE proposes other values for the extension than those specified in the list. Overwrite the values with the minimum values from PREPARE or R3up.

Avoid fragmenting the database too strongly.
Be generous when you extend existing tablespaces.
Choose a low degree of fragmentation when you create tablespaces.

For the tablespace PSAPES<Rel>D, create a data file with at least 2 GB, otherwise the import of the substitution set terminates.
If you have to create a tablespace in more than two fragments, add \((n - 2) \times 100\) MB to the total size of the tablespace, where \(n\) is the number of fragments.

End of the database-specific explanations
6.2.7 Changing the Database Recovery Mode

**Use**

If you use the upgrade strategies *downtime-minimized* and *resource-minimized*, you need to change the recovery mode of the database at the beginning and end of downtime.

**Procedure**

**DB2 UDB for UNIX and Windows**

When you set LOGRETAIN and USEREXIT to OFF, make sure that you can recover the current state of the database.

If the last full backup was a long time ago and the number of archives collected up to that point is large, we recommend that you make a full backup before you set the parameters to OFF.

**DB2 UDB EEE only:** If you configure your database with multiple partitions, make sure that any changes made to the database or database manager parameters apply to all partitions. For example, to activate the database parameter LOGRETAIN on all partitions, enter the following on partition 0 (catalog node):

```
su - db2<sapsid>
db2_all "db2 update db cfg for <sapsid> using LOGRETAIN ON"
```

**Informix**

When you deactivate the backup mode, make sure that you can recover the current state of the database.

If the last full backup was some time ago and a large amount of logical log files has been created since, SAP recommends that you make a full backup of the current database state before you deactivate the backup mode.

Deactivate the backup mode as follows:

1. Stop the database as user `<SAPSID>ADM` by with the following command:
   ```
onmode -yuk
   ```
2. Edit file `%INFORMIXDIR%/etc/%ONCONFIG%` and change parameter LTAPEDEV to NUL.
3. Start the database with the following command:
   ```
starts %INFORMIXSERVER%
   ```

**MS SQL Server**

During the upgrade, you have to set the recovery model for the upgrade strategies *downtime-minimized* and *resource-minimized* to *Simple* and then later back to *Full*.

To do this use the SQL Server Enterprise Manager.

1. Select your `<SAPSID>` database by clicking it.
2. Click right mouse key and choose *Properties*.
3. Choose *Options* and make necessary changes.
Oracle

Make sure that you can recover the current state of the database before you deactivate database archiving.

If the last full backup was a long time ago and the number of archives collected up to that point is large, SAP recommends that you make a full backup before you deactivate archiving.

Deactivate archiving with program `ARCHIVE_OFF.BAT`.
You can activate archiving again with program `ARCHIVE_ON.BAT`. The programs `ARCHIVE_OFF.BAT` and `ARCHIVE_ON.BAT` are in the directory `\usr\sap\put\exe`.

MaxDB

- **At the start of downtime:**
  R3up automatically deactivates archiving.

- **At the end of downtime:**
  Archiving can only be reactivated by making a full backup in operating mode `ADMIN` (same as operating mode `COLD` in SAP DB version 7.3). That is why the upgrade can be continued only after you have made a backup of the database, if archiving is deactivated.

Standalone Database Server (Oracle)

The following database commands are used together with mode ARCHIVELOG:

1. Check the mode ARCHIVELOG as user `ORA<SAPSID>`.
   Enter the following commands in SQLPLUS:
   ```
   SQL> connect / as sysdba
   SQL> archive log list;
   SQL> exit
   ```
   If `NOARCHIVELOG` is displayed, then mode ARCHIVELOG has been deactivated.

2. **Deactivate mode ARCHIVELOG**
   To do this, the database must be shut down. Enter the following commands in SQLPLUS:
   ```
   SQL> connect / as sysdba
   SQL> startup mount
   SQL> alter database noarchivelog;
   SQL> alter database open;
   SQL> exit
   ```

3. **Activate mode ARCHIVELOG**
   To do this, the database must be shut down. Enter the following commands in SQLPLUS:
   ```
   SQL> connect / as sysdba
   SQL> startup mount
   SQL> alter database archivelog;
   SQL> alter database open;
   svrmgr> exit
   ```

End of the database-specific explanations
6.2.8 Using a Different Upgrade Directory

**Use**
You can use an upgrade directory other than \usr\sap\put\ . This is useful if you have multiple SAP systems on a single host and you want to upgrade them all to a new release.

**Procedure**
1. In the instance profile of the SAP system, set the parameter DIR_PUT to the upgrade directory that you want to use:
   
   \begin{align*}
   \text{DIR\_PUT} &= <\text{upgrade directory}> \\
   \end{align*}

   The name of the directory must include the whole directory path. The name cannot be longer than 30 characters in total.

   - The parameter does not become effective until you restart the SAP system. Alternatively, as it is a dynamic parameter, you can use transaction RZ11 to set it without restarting the SAP system.

2. After you have changed the profile, restart the SAP system to activate the changes.
   
   When the system starts, R3up checks whether the value in the instance profile matches the specified upgrade directory.

6.2.9 Releasing and Confirming Open Repairs and Requests

**Use**
Before you start the upgrade, you must release and confirm all the open repairs and requests that conflict with the SAP delivery. PREPARE determines a list of these repairs and requests. If you ignore open repairs, you could lose modifications.

**Procedure**
Depending on your Basis or Web Application Server source release, proceed as follows:

**Release 3.x**
1. Log on to the SAP system as the owner of an open repair. You can find the user names of the owners in CHECKS.LOG.
2. Call transaction SE01.
3. Choose Find.

   - You can also release the repairs from the Workbench Organizer (transaction SE09).
4. Make sure that the field User name contains the correct name.
5. In the Type field, enter **REPA**. Do not change any other default values.

6. Choose **Execute**. A list of all the open repairs for this owner appears.

7. Select the repair that you want to release.

8. Choose **Repair → Release repair**.

9. If the repair is assigned to a superordinate transport request, this transport request must also be released.

   If you are cannot log on with a specific user ID, you can change the owner of the repair in transaction SE01 as follows:
   a. In the list of open repairs, position the cursor on the repair.
   b. Choose **Edit → Change owner**.
   To be able to change an owner in transaction SE01, you need project authorization for the Workbench Organizer (S_CTS_PROJEC).

**Release 4.x and higher**

1. Log on to the SAP system as the owner of the open repair. You can find the user names of the owners in **CHECKS.LOG**.

   If you cannot log on with a specific user ID, you can change the owner of the repair in transaction SE09 as follows:
   a. In the list of open repairs, position the cursor on the repair.
   b. Choose **Change owner**.
   To be able to change an owner in transaction SE09, you need project authorization for the Workbench Organizer (S_CTS_PROJEC).

2. Call transaction SE09.

3. Choose **Request/task → Find requests**…

4. For **Request type**, only select **Repair**.

5. For **Request status**, select everything except **Released**.

6. Choose **Execute**.

   A list of all open repairs for the selected user appears.

7. Position the cursor on the request that you want to release.

8. Choose **Release**.

9. **Applies to Source Release 4.6A only**: Check whether the repair has been confirmed. If it has not been confirmed, choose **Request/task → Confirm repair**.

10. Release the request to which the repair is assigned.
6.2.10 Sending a Message when User Action Is Required

Use

If a user entry is not made within 60 seconds during the upgrade, you can send a message to another computer.

Prerequisites

A message informing you that the upgrade has stopped can be sent from the upgrade host if:

- You are not permanently monitoring the upgrade during its runtime but still want to avoid long delays.
- Your workstation host can be reached from the upgrade host with the NETBIOS protocol.
- You have started the workstation service on the upgrade host.
- You have started the messenger service on your workstation host.

Procedure

Call R3up with the option messagehost=<host>. As <host>, specify the workstation host on which you want to be informed about the upgrade delay.

R3up sends a dialog box to the specified workstation host if no user entries are made for 60 seconds and R3up is waiting for an entry.

6.2.11 Using the Phase List for the Upgrade

Use

The phase list for the upgrade contains phases for PREPARE and for the upgrade itself.

The phase list consists of two HTML files.

- The phaselist.htm file contains a table with all the phases.
  
  The phases that are listed in the tables run in the specified sequence. The R3up tool does not stop at the end of one of these sections. It stops only for user actions, if there are errors, or if you manually stop the upgrade at a particular phase. The table contains the following columns:

  - Phase
    
    Table fields of phases that run while the shadow system is in operation are indicated by a gray background.

  - PREPARE / R3up Actions
    
    Gives a brief explanation of the tool actions. Constraints (if an action can run only on a particular database, for example) are printed in bold.

  - Duration
    
    Indicates the percentage of the total runtime of R3up required for this phase. The runtime depends on the following criteria:
- Amount of customer data
- Number of SAP components implemented
- Quantity and type of modifications and customer developments involved
- Number of clients
- Number of included packages

The duration of some of the phases depends on the gap between the source and target release of the SAP system. The smaller the gap, all the shorter the duration of the phase.

- **Log Files**
  Lists the log files that are generated by R3up for each phase.

- **User Actions**
  If there is no entry in this column, R3up does not require an operator at this point. Otherwise R3up prompts you to make the entries described.

Some phases have comments next to them in the various columns. These are as follows:

<table>
<thead>
<tr>
<th>Comment</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>(var)</td>
<td>The runtime of the phase depends on your data. The percentage duration of these phases can be very different in your upgrade.</td>
</tr>
<tr>
<td>(log)</td>
<td>Not all logs can be included in the Log Files column. For more information, see Upgrade Logs [page 143].</td>
</tr>
</tbody>
</table>

- The phase_toc.htm file contains a list of all the phases with links to the corresponding short description in the phaselist.htm file.

**Procedure**

The files for the phase list are in the htdoc subdirectory of the upgrade directory.

You can also create the phase lists yourself by using the htmlphl option to call R3up. The files are then saved in the current directory, or – if you are calling R3up from the Upgrade Assistant – in the tmp directory.
6.3 Upgrade Tools

The following tools are provided for the upgrade of the SAP System:

- PREPARE [page 230]
- R3up [page 232]
- Upgrade Assistant [page 233]
- Upgrade Monitor [page 236]

6.3.1 PREPARE

Use

Use the PREPARE program to prepare your SAP system for the upgrade. The PREPARE program:

- Can be executed while the system is running.
- Checks whether or not the requirements for the upgrade are met and gives you extra information when you are executing the optional modules.
- Imports a number of tools into your database.
- Copies data and programs required for the upgrade into the upgrade directory.

PREPARE performs the majority of the required checks automatically. However, you must also check the operating system, database and SAP system manually.

Integration

When you start the upgrade, R3up assumes that the mandatory PREPARE modules have been completed successfully. R3up then repeats a number of the checks (not all of them), since production operation of the SAP system could have created a new situation.

Prerequisites

You must meet a number of prerequisites before you run the PREPARE program, including the following:

- Determine a host for the upgrade preparations
- Create an upgrade directory
- Make sure that there is enough free space in the database
- For NT 4.0: Check the consistency of the host name
- Check the database-specific requirements
- Import the latest SPAM update

For more information about the prerequisites for PREPARE, see the sections about upgrade preparations in the product-specific and in the general part of this documentation.
**Features**

**PREPARE** executes all its actions in phases. These phases are combined into **PREPARE** modules. For a complete list of the modules and the phases which execute in these modules, see [Using the Phase List for the Upgrade](#page 228).

The **PREPARE** modules have the following features:

- They can be mandatory or optional.
- They may be dependent on a predecessor module that must be executed first.

  You must import the analysis tools before you can execute them.

- You must execute the **PREPARE** modules **up to and including** the **Installation** module once only. If you want to execute these modules once more, you must first reset **PREPARE**.

- You can execute all modules **after** the **Installation** module as often as you want.
- You can execute **PREPARE** modules individually.

The following graphic is an overview of all the **PREPARE** modules and the order in which you need to execute them.

![Diagram of PREPARE modules](#)

For more information about the contents and features of the **PREPARE** modules, see the online help for **PREPARE**. To call up the online help, choose *Help* when selecting a module.
Activities

- Start **PREPARE** as soon as possible before the upgrade so that you can perform the necessary preparations in time.

- After you start **PREPARE**, you may need to import software such as SAP Support Packages, languages, or add-ons (and add-on updates). For more information, see Importing Software After Starting **PREPARE** [page 106].

Result

**PREPARE** writes the results for the executed modules to the **CHECKS.LOG** file. This file is in the log subdirectory of the upgrade directory.

View this file and perform any measures required by the information it contains. You can execute certain **PREPARE** modules repeatedly to make sure that all requirements are met. If the **CHECKS.LOG** file already exists, it is overwritten each time you execute a module again. Its contents are saved in the **CHECKS.SAV** file.

6.3.2 R3up

Use

**R3up** controls the entire upgrade of the SAP system, from checking the requirements and importing the necessary programs, to restarting production operation of the system. **R3up** controls the upgrade sequentially in phases, where one phase must end successfully before the next one can begin. For a complete list of all phases, see Using the Phase List for the Upgrade [page 228].

When started, **R3up** repeats all the important checks made by **PREPARE**. During the checks, you can still use the SAP system in production operation. When downtime begins and how long it lasts depends on the **upgrade strategy** [page 71] you choose. The upgrade strategies are also differentiated by the disk space requirements, and when production operation of the system stops.

In the individual phases, **R3up** starts various tools, checks the results and creates a series of logs. These logs are stored in the log subdirectory of the upgrade directory. This subdirectory also contains the main log file **R3up.log**.

The **Upgrade Monitor** [page 236] lets you follow the progress of the upgrade, and helps you recognize processes that have exceeded their runtime.

Prerequisites

The mandatory **PREPARE** modules have run successfully.

Activities

- You start **R3up**.

- You can stop **R3up** [page 141] at the beginning of a specific phase or at the beginning of the next phase.

  For example, you need to do this if an SAP Note tells you to correct a program before you execute it.
You can continue the upgrade by restarting R3up [page 141]. You usually only have to restart the upgrade when errors have occurred or an upgrade phase has terminated. In this case, R3up stops and offers you several modes for restarting the upgrade. If you choose the default value repeat, R3up makes the necessary checks and then starts at the point in the phase where the program terminated.

### 6.3.3 Upgrade Assistant

#### Use

The Upgrade Assistant is the front end for the upgrade process. It provides one or more graphic user interfaces (GUIs) for controlling and monitoring the upgrade. The Upgrade Assistant simplifies the upgrade procedure.

#### Integration

The Upgrade Assistant is a distributed program consisting of a server component and several GUI components. Only one person can control the upgrade from the GUI components.

- **Server component**
  
  The server controls communications between the upgrade control program R3up and the GUIs of the Upgrade Assistant. It must be started on the host on which you want the upgrade process to run.

- **GUI components**
  
  The GUI components can be executed on any other hosts.

You can log on to the server as the observer or the administrator. The observer role only authorizes you to monitor an upgrade. An administrator is authorized to take actions affecting the progress of the upgrade, for example, an administrator can start or stop the upgrade and can enter any necessary commands. Only one GUI can assume the role of administrator. However, the GUI with this role can change in the course of the upgrade.

The graphic below illustrates the architecture of the Upgrade Assistant and the interaction between the Upgrade Assistant and the R3up upgrade control program.
Features

- You can control and monitor the progress of the upgrade from a number of different places.
- The front end and the upgrade process are divided into separate components so that the entire upgrade does not terminate if a connection fails. This provides optimal support for a remote upgrade.
- You have an alert mechanism that lets you start an external program.
- You can view all files and their contents in the upgrade directory.
- Provided you have access to the Internet, you can access the SAP Notes database in the SAP Service Marketplace from a GUI.
- The Upgrade Assistant Server and the Upgrade Assistant GUI can be connected using one or more SAProuters, but only if you used the Java Runtime Environment to start the Upgrade Assistant GUI. For more information, see SAP Note 133402.

The Upgrade Assistant is implemented in Java. A scroll mode is provided for the upgrade for platforms that do not support Java. We recommend that you use the Upgrade Assistant, since scroll mode does not provide the above features.
Using the Upgrade Assistant

Use
The Upgrade Assistant offers you a number of functions. You can change the passwords for the roles, change roles, use and monitor PREPARE, or look for SAP Notes.

Procedure

Changing Passwords
You can change the passwords for the two roles from the administrator GUI only. To do this, choose Administrator → Change passwords in the main menu.

Changing the Role
To change the role dynamically, choose File → Change role.

The following dialog box appears:

If, for example, you are in the role of the observer and enter the password for the administrator, you change to the administrator role. If an administrator already exists, the administrator role is removed from this user.

If you only want to change the User name or the Phone number, enter the password of the role you are in. In this case only the data you enter is updated.

File Service
You can use the File Service to view all files and their contents in the upgrade directory. This is, for example, helpful for a quick scan of the log files. To access the service, choose Services → Online Services → File Service.

Searching for Notes from the GUI
If you have an Internet connection, you can access SAP Notes in the SAP Service Marketplace from the GUI. In the main menu, choose Services → Online Services → SAP Notes.

More Information on the Upgrade Assistant
To display a description of the Upgrade Assistant with all its functions, choose Help → Introduction in the main menu.
6.3.4 Upgrade Monitor

Use

The Upgrade Monitor lets you monitor the upgrade, and helps you recognize any processes that have stopped.

Features

The monitor estimates the time when the upgrade will be completed, as well as other important stages (milestones).

These estimates are based on SAP reference times and the runtimes of upgrade phases that have already been completed. The output of the monitor is updated every 60 seconds. The more advanced the upgrade is, the more precise the estimates are. If possible, the runtime estimate also includes any runtime that is lengthened for systematic reasons, however this is subject to restrictions. Systematic fluctuations can also occur if the upgrade phases run more quickly than expected. This means that the end of the upgrade cannot be estimated precisely.

The way the data appears on the screen depends on whether you are upgrading the system with the Upgrade Assistant or in scroll mode.

Graphic Display in the Upgrade Assistant

The total runtime of the upgrade and the runtime of the next milestone appear as bar graphs. As long as the runtime has not been exceeded, the bar appears in green. If the runtime has been exceeded, the bars appear first in yellow and then in red.
An animated graphic displays the activity of the upgrade processes. If the graphic is not moving, one of the upgrade processes has stopped. This may be the Upgrade Monitor, the Upgrade Assistant or the R3up program.

The upgrade processes that are running appear under Current activities. The Monitor does not recognize any subprocesses of these processes, and therefore cannot display them. Note that the process bar is updated only every 60 seconds.

**Numerical Display in Scroll Mode**

No graphics are displayed in scroll mode, so the progress of the upgrade and the estimated runtime until the next milestone are shown in numerals.

The upgrade processes that are running appear under Current activities.

### Starting the Upgrade Monitor

#### Procedure

**Upgrade Assistant**

Start the Upgrade Monitor in the initial screen of the Upgrade Assistant by choosing Services → Upgrade Monitor.

**Scroll Mode**

1. Open another window at the operating system level.
2. Enter the following commands in the new window:

   ```
   cd \usr\sap\put\exe
   R3up.exe Monitor
   ```

### Understanding the Upgrade Monitor Display

**Use**

Either of the following situations in the Upgrade Monitor display indicates that you may have to intervene:

- One of the bars showing the progress of the upgrade is red.
- The graphic that shows the activity of the upgrade processes stops moving. This means that upgrade processes are hanging.

**Procedure**

**Red Progress Bar**

1. Check the database and CPU activity.
2. If you can still detect activity, then either the runtime has been exceeded significantly, or the upgrade is in an endless loop.
If this is the case, do not terminate the upgrade; instead, try and find out why the runtime is so long. If you are not sure how to proceed, contact SAP Support.

**Hanging Upgrade Processes**

1. First, restart the Upgrade Assistant GUI only.
2. If step one is not successful, restart the server of the Upgrade Assistant.
3. If the previous steps are not successful, restart `R3up`.

When `R3up` is restarted, the Monitor displays any processes that are still running. The restarted `R3up` must wait for these processes before the upgrade can continue with any other activities.